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Chapter 1. Overview of WebSphere Adapter for Email

With WebSphere® Adapter for Email, you can create integrated processes that can
exchange information using email, without special coding.

For example, you can use the adapter to send general broadcast e-mails to a group
of addresses or to send a notification email to a single address that an action has
taken place, such as a customer record update in a database. The adapter can also
forward information received in an email message to IBM® Business Process
Manager or WebSphere Enterprise Service Bus and use it to initiate a service (for
example, to initiate a customer record update).

Suppose a company uses email as its principal communication tool for most of its
business operations. A new product is coming out and the marketing team wants
to notify all of their IBM Business Partners before information is made available to
the public. You can use WebSphere Adapter for Email to send an email
broadcasting the new release date to a large group of email addresses. Or, imagine
that a customer sends an email to a company to notify it that their address has
changed. In this case, you can use the adapter to send the address change request
to an application that tracks addresses, and then returns an email to the customer
with notification that the address change request is complete.

The adapter is imported and configured in a module that is created in IBM
Integration Designer and deployed to IBM Business Process Manager or
WebSphere Enterprise Service Bus. After the configuration is completed, the
adapter acts like a service provider in part of a service-oriented architecture (SOA)
implementation, providing operations to send and receive emails. Client
applications interact with the module instead of directly with the mail server. This
configuration enables the authentication details (such as user name and password)
that you provide when you set up a module to be shielded from the client
applications and services outside of the module. The adapter exposes a service
interface that hides the mechanics of how the data or operations are obtained or
used.

The benefit of creating the module with the external service wizard in IBM
Integration Designer is that it becomes a reusable unit that can perform a specific
inbound or outbound service. Each module uses a consistent interface and
standard business objects, so that the applications consuming the service do not
have to understand the lower-level details of the mail server.

Hardware and software requirements

The hardware and software requirements for WebSphere Adapters are provided on
the IBM Support website.

To view hardware and software requirements for WebSphere Adapters, see
lhttp:/ /www.ibm.com /support/docview.wss?uid=swg27006249|

Additional information

The following links provide additional information you might need to configure
and deploy your adapter:
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http://www.ibm.com/support/docview.wss?uid=swg27006249

* The compatibility matrix for WebSphere Business Integration Adapters and
WebSphere Adapters identifies the supported versions of required software for
your adapter. To view this document, go to the WebSphere Adapters support
page: http://www.ibm.com/support/docview.wss?uid=swg27006249}

* Technotes for WebSphere Adapters provide workaround and additional
information that are not included in the product documentation. To view the
technotes for your adapter, go to the following Web page, select the name of
vour adapter from the Product category list, and click the search icon:

http:/ /www.ibm.com /support/ search.wss?tc:SSMKUK&rs:695&rank:8|
&dc=DB520+D800+D900+DA900+DA800+DB560&d tm|

Technical overview of WebSphere Adapter for Email

2

WebSphere Adapter for Email enables email connectivity between IBM Business
Process Manager or WebSphere Enterprise Service Bus and one or more mail
servers. The adapter itself is housed within an adapter module that you create
using the external service wizard in IBM Integration Designer. Each module
performs an outbound or inbound service, such as retrieving emails from a mail
server or sending emails to a group of recipients.

A module encapsulates the service in a reusable unit and consists of both a project
in IBM Integration Designer and a unit of deployment which is an enterprise
archive (EAR) file to IBM Business Process Manager or WebSphere Enterprise
Service Bus. The module is packaged and deployed to IBM Business Process
Manager or WebSphere Enterprise Service Bus as an enterprise archive (EAR) file.

In the simplest implementation, you can use the adapter to send emails to one or
more email addresses. This process is referred to as outbound communication
because the adapter is part of a module designed to send emails out to a mail
server. You can also use the adapter to poll a mail server for incoming emails, and
then send the information found in the email to a service. The service consumes
the information forwarded by the adapter to complete a task. This process is called
inbound communication.

In more complicated implementations, you use a number of individual modules
(designed for inbound and outbound communication) together to initiate an
automated flow of operation, and then send an email notification to an email
address to confirm that an action is completed. Similarly, you can create an
inbound module that listens for incoming email events on the mail server that
match certain criteria (for example, e-mails with a specific word in the subject
field) and forwards only those email events to the service.

The adapter sends and receives emails to or from different mail servers by using
the SMTP email protocol for all outbound communication and either the IMAP or
POP3 email protocol for inbound communication. Depending on what inbound
protocol your mail server supports, you can select between IMAP and POP3 when
you create your inbound module.

Outbound processing

WebSphere Adapter for Email supports outbound request processing. When the
adapter receives a request in the form of a business object from a service, it
processes the request and creates an email message. The adapter then sends the
email message to a mail server.

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide
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Outbound processing begins with the adapter receiving a request in the form of a
business object from a service. Business objects represent data that the adapter
needs to create an email and each one might include, among other things,
attachments, and email addresses for where the email is to be sent. When a request
is received by the adapter, the adapter takes the information stored in the business
object and creates an email. This email is then forwarded to the mail server for
distribution.

The following illustration shows how the adapter and module (which encapsulates
the service in a reusable unit) function together as part of an outbound service. A
module created for outbound processing receives the business object, the business
object is turned into an email by the adapter, and then the adapter sends the email
to the mail server for distribution.

IBM Business Process Manager

WMadule e .
IBM .
WebSphere Mail Server
Adapter q
E for
Email l

E-mails

Figure 1. Adapter as part of an outbound SOA implementation

Each outbound module contains components that form a service, including an
import. An import is a component, but without an implementation that is used to
identify the services outside the module, making them callable from within the
module. To communicate with references (for calling interfaces), imports require
enterprise information system (EIS) binding information, to specify how the data is
to be transported from the module. The assembly editor in IBM Integration
Designer sets up the import and the EIS binding.

The following illustration shows a more detailed view of the module in an
outbound implementation. The I and R symbols within the illustration represent
interfaces and references. Interfaces dictate to the users of a service, in this case the
import, how the component can be used. Interfaces are specification of the
operations performed by a component. The operations are createCustomer,
createAddress, and createEmail for outbound communication. References declare
the interface that your service component is going to call. Each component in your
module has one or more references. When you write your implementation for your
service component using the assembly editor in IBM Integration Designer, you call
a reference instead of directly calling the component. This implementation allows
you to reassemble components in the future because you have not built
dependencies into the code.
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Figure 2. Outbound communication showing the import

During outbound processing, the adapter itself does not create emails. Instead, it
converts the information received in a business object to a message that mail
servers supporting the RFC822 format can understand.

Note: This process is not visible to you. It is only mentioned because the term
"RFC822 format" appears in the reference section in regard to the email headers the
adapter supports.

When a mail server receives an email message from the adapter, the mail server
converts the message to an email and sends it to all email addresses listed in the
To, Cc, and Bcc fields. If the adapter cannot send the message successfully to the
server, it logs the following information:

* the MailSendFault fault for all non-connection related exceptions,

e for all other cases, the EmailOutboundCreateException exception with an
appropriate error message indicating the reason for the failure.

Outbound data transformation
During outbound communication, the adapter transforms business objects into
multipart MIME email messages.

While the adapter uses an adapter-specific data binding and data handlers to
accomplish it, the actual transformation is external to the adapter and performed
by IBM Business Process Manager or WebSphere Enterprise Service Bus. The data
bindings and data handlers that the adapter uses to compose an email from the
corresponding attributes in a business object are configured through the external
service wizard in IBM Integration Designer.

Data bindings

Data bindings are essentially maps that define how a business object is to be
formatted. Data bindings are responsible for reading the fields in a business object
and filling the corresponding fields in an email.

During outbound communication, the data binding takes the following fields from
a business object and populates the equivalent fields in an email with their values:

e Headers
e Mail content
¢ Attachment

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



For data that does not require transformation, the adapter conducts the
pass-through processing, where data such as attachments pass through the system
without being altered.

The adapter uses one of the three data bindings during outbound communication.
Each data binding corresponds to a business object structure or data type selected
in the external service wizard. The following table lists these data bindings and
describes their usage. A more detailed description of each data binding is provided
in the sections that follow the table.

Table 1. Outbound data bindings

Data binding Usage

[Email simple data binding] Used for the simple alert email data type

IIEmail wrapper data binding] Used for the generic email and the generic
email with business graph data types

I|Email fixed structure data binding] Used with the user-defined data type

[[Email data binding] Used only with version 6.0.2 business objects

for compatibility with earlier versions

Email simple data binding

The email simple data binding is the default data binding for the simple alert
email data type in the external service wizard. This data binding corresponds to
the simple alert email business object structure that is described in this
documentation.

Email wrapper data binding

The email wrapper data binding is the default data binding for both the Generic
email and Generic email with business graph data types in the external service
wizard. This data binding corresponds to the email business object structure.

Email fixed structure data binding

The email fixed structure data binding is the default data binding for the
user-defined data type in the external service wizard. This data binding
corresponds to a specific business object structure defined by a user. With this data
binding, the order of the attachments is significant. The attachments must be in the
same order as the attributes in the business object. This data binding retains the
order.

Email data binding

This data binding is used exclusively for compatibility with business objects
created in version 6.0.2 or earlier. This data binding supports the five-level
business object structure used in version 6.0.2 of the adapter.

Data handlers

In addition to the data bindings, data transformation requires the use of a data
handler. Data handlers are converters of data from one format to another. Data
handlers perform the conversions between a business object and a particular MIME
format. Data handlers are provided by IBM Business Process Manager or
WebSphere Enterprise Service Bus.

Chapter 1. Overview of WebSphere Adapter for Email 5
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For data that does not need to be transformed, such as some attachments, the
adapter can be configured to conduct what is called pass-through processing. In
pass-through processing, data passes directly from the business object to the email
without being altered.

Character encoding

To send globalized characters in email messages, you set encoding values for
headers, mail content, and attachment business objects. For all data types except
the simple alert email data type, you can set encoding values at two levels: in the
Encoding attribute of the business object or in the Encoding property of the data
binding in the data binding properties.

* For the simple alert email data type, you set the encoding value in the Encoding
attribute of the SimpleAlertEmail business object.

* For the generic email data type, you set the encoding value in the Encoding
property of the data binding (EmailWrapperDataBinding) or in the Encoding
property of the wrapper business object (email business object). The encoding
property in the data handler configuration must have the same value that is
specified in the data binding.

* For the user-defined data type, you set the encoding value in the Encoding
property of the wrapper business object (email business object) or in the
Encoding property of the data binding (EmailFixedStructureDatabinding). The
encoding property in the data handler configuration must have the same value
that is specified in the data binding.

During pass-through processing, the adapter uses the encoding value that is set in
the business object. When data transformation is required, the adapter uses the
value that is set in the individual data binding.

In both pass-through and non pass-through scenarios, the headers are encoded
with same encoding value such as the mailContent.

Inbound processing

WebSphere Adapter for Email supports inbound processing of email events.
Inbound event processing means that the adapter polls the mail server at specified
intervals for new emails that are ready for processing. When the adapter detects an
event that is ready to be processed, it converts the event data into a business object
and sends it to the consuming service.

During inbound processing, the adapter polls the mail server for new emails,
which are called events. When the adapter detects a new event, it reads the email
and creates a business object to represent the email content. The adapter then
forwards the business object to the export which is an exposed interface from a
service component architecture (SCA) module that offers a business service to the
outside world. Business objects carry the information the adapter takes from an
email. By converting emails to business objects and forwarding them to a service,
the services using your adapter module do not have to deal directly with the mail
server. It is the adapter that polls for events, changes them to a format the
consuming services can understand (business objects), and then forwards them to
the export for delivery to the services that consume them.

The following illustration shows at a high level how the adapter functions as part
of an inbound service in a service-oriented architecture (SOA) implementation. The
adapter polls the mail server for incoming events, converts them into business
objects, and then the adapter sends them to a consuming service.

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide
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Figure 3. Adapter as part of an inbound SOA implementation

Each inbound module contains components that form a service, including an
export. An export is a component, but without an implementation. Exports allow
components in a module to provide their services to external clients. Exports
require an EIS binding, which specifies the means of transporting the data from the
modules. The assembly editor in IBM Integration Designer sets up the export, lists
the supported bindings, and simplifies its creation. For inbound requests, business
objects are essentially the logical graphical representation of the content of an
incoming email, that appears as output from the export that represents the module
in the assembly diagram.

The following illustration shows a more detailed view of the module in an
inbound implementation. The I and R symbols within the illustration represent
interfaces and references. Interface is a specification of the operations performed by
a component. For inbound communication, it is limited to the Read operation. The
interface dictates to the users of a service component, in this case the export, how
the component can be used. A reference declares the interface that your service
component is going to call. Each component in your module has one or more
references. When you write the implementation for your service component using
the assembly editor in IBM Integration Designer, you call a reference instead of
directly calling the component. This implementation allows you to reassemble
components in the future because you have not built dependencies into the code.

IBM Business Process Manager

IBM Module Module
izl ( WebSphere
server Export
Adpater -, xp / Component

I E];:]);il [oF——el []

E-mails

Figure 4. Inbound communication showing the export
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Supported inbound protocols

The adapter supports two different inbound email protocols: POP3 and IMAP.
With each, the adapter polls the mail server at a specified interval for inbound
events (emails) and when an email is detected on the mail server, the adapter
converts it to a business object. The adapter considers any email in the specified
inbox folder on the mail server that is ready for processing an event.

Depending on your mail server, you might be able to choose the inbound email
protocol that the adapter can use. Differences between the protocols and a
description of how the adapter works with each protocol are noted in and
the sections that follow.

Table 2. Differences between the IMAP and POP3 protocols

IMAP POP3

Supports the existence of multiple mail Supports only one mailbox (named Inbox)
folders on a mailbox. per user.

Allows a copy of the email to remain on the |Supports a view-once-only feature on the
mail server after the client receives the server. The mail is deleted from the mail
email. server after the client receives a copy of it.

Inbound communications with IMAP

If you use the IMAP protocol for your inbound communication, the following
steps are performed:

1. The adapter polls the mail folders at regular intervals and logs any unread
emails as events in the event store. You can use the activation specification
PollFolders property to customize the list of folders that are searched by the
adapter.

Note: If you specify multiple mail server folders for the mail server account in
the PollFolders property, the adapter polls all mail server folders sequentially.

2. Search criteria determines which events are picked up from the mail server. The
adapter picks up all events that match the search criteria. If no search criteria is
specified, the adapter picks up all unread emails.

3. The adapter writes all polled events to the staging directory. After an event is
written to the staging directory, it is deleted from the mail server.

4. The adapter transforms each event into an email business object. The headers,
email body content, and mail attachments are recorded within the business
object.

5. The email business object is sent to the export.

6. After it has been processed, the adapter deletes processed emails from the
staging directory and archives them (if archiving is selected).

Note: If the archive file naming pattern activation specification property is
specified, the file names conform to the pattern.

Inbound communications with POP3
If you use the POP3 protocol for your inbound communication, the adapter

performs the following steps during inbound operations (from the mail server to
the service):

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



1. Polls the Inbox folder on the mail server for inbound events (new emails).
When it finds an email, it logs it as a new event in the event table.

Note: If you specify search criteria, all unread emails that fit the search criteria
are picked up by the adapter. If no search criteria are specified, the adapter
picks up all unread emails.

2. Writes new events to the staging directory as files and then deletes them from
the mail server.

3. Converts the email into a business object. Headers, email body content, and
mail attachments are recorded within the business object.

4. Sends the business object to the export.

5. Deletes all processed email from the staging directory and archives them if the
archiving property is configured.

Note: If the archive file naming pattern property is specified, the file names
conform to the pattern. If it is not specified, the name remains the same as it is
in the staging directory.

Inbound data transformation
During inbound communication, the adapter transforms multipart MIME email
messages into business objects.

Data bindings

While the adapter uses an adapter-specific data binding and data handlers for
inbound data transformation, this actual transformation is external to the adapter
and provided by IBM Business Process Manager or WebSphere Enterprise Service
Bus. The data bindings and data handlers that the adapter uses to read the
contents of an email and fill the corresponding attributes in a business object are
configured using the external service wizard in IBM Integration Designer.

To take fields from an email and populate a business object, the adapter needs a
data binding. Data bindings are maps that define how a business object is to be
formatted. Data bindings are responsible for reading the fields in an email and
populating the corresponding fields in a business object.

During inbound communication, the data binding takes the following fields from
an email and populates the parent email business object attributes with their
values:

* Headers

* Mail content

e Attachment

For data that does not require transformation, the adapter conducts a pass-through
processing, where data such as attachments pass through the system without being
altered.

To transform data in the form of emails coming into the adapter, the adapter uses
one of the three data bindings. The following table lists these data bindings and
their usage. A more detailed description of each data binding is provided in the
sections that follow the table.

Chapter 1. Overview of WebSphere Adapter for Email 9



Table 3. Inbound data bindings

Data binding Usage

[“Email wrapper data binding”| Default data binding

[“Email fixed structure data binding”| Used with the user-defined type business
objects

[“Email data binding”| Used with the version 6.0.2 business objects

Email wrapper data binding

The email wrapper data binding is the default data binding for both the Generic
email and Generic email with Business Graph data types in the external service
wizard. This data binding corresponds to the email business object structure.

Email fixed structure data binding

The email fixed structure data binding is the default data binding for the
user-defined data type in the external service wizard. This data binding
corresponds to a specific business object structure defined by a user. With this data
binding, the order of the attachments is significant. The attachments must be in the
same order as the attributes in the business object. This data binding retains the
order.

Email data binding

This data binding is used exclusively for compatibility with business objects
created in version 6.0.2 or earlier. This data binding supports the five-level
business object structure used in version 6.0.2 of the adapter.

Data handlers

In addition to the data bindings, data transformation requires the use of a data
handler. Data handlers change data from one format to another. Data handlers
perform the conversions between a particular MIME format and a business object.
Data handlers are provided by IBM Business Process Manager or WebSphere
Enterprise Service Bus.

For data that does not need to be transformed, such as some attachments, the
adapter can be configured to conduct a pass-through processing. During
pass-through processing, data passes directly from the email to the business object
without being altered.

Event store
The event store is a persistent cache where event records are saved until the
polling adapter can process them.

The adapter uses an event store to track the inbound events that come into the
system. When a new email is found in the polling folder, the adapter updates the
status of the corresponding event in the event store. For recovery purposes, the
adapter continually maintains the status of the event in the event store until the
event is delivered to IBM Business Process Manager or WebSphere Enterprise
Service Bus. If the adapter is abruptly terminated, the adapter uses the event store
to determine which events have and have not been processed.

10 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide




An event store is not required for the adapter to process inbound requests. The
adapter creates an event store:

¢ when the module is deployed to the runtime environment. It can happen if the
event persistence feature is configured in the external service wizard.

e if it detects that an event store does not exist for the inbound module in the
database.

Each event store created by the adapter is associated with a specific inbound
module. The adapter does not support multiple adapter modules pointing to the
same event store.

Business objects

A business object is a structure that consists of data, the action to be performed on
the data, and additional instructions, if any, for processing the data. The data can
represent anything from a customer record to an email attachment. The adapter
uses business objects to either obtain information from an email or to produce an
email.

How the adapter uses business objects

The adapter during the outbound processing receives a business object from a
service. It then creates an email from the details it finds in the business object and
sends the email message to the mail server for distribution. For inbound
processing, this process happens in reverse. The adapter takes information from an
email, converts it to a business object, and forwards it to a service.

How data is represented in business objects

Business objects are created using either the business object editor or external
service wizard in IBM Integration Designer. As shown in the following illustration,
a business object consists of a set of fields and a type of data, such as a string or
integer. The business object shown in the figure is a customer business object that
records name, address, and telephone number information for a customer record.
This example uses string values, but many other values are supported by the
business object editor.

% Customer
L

Mame  siring

Address string
Phone string

Figure 5. Customer business object

A field might, in turn, be another business object. For example, the following
illustration shows a customer business object that contains another business object.
Here, a company that sells pet-related items might want to keep a track of names
and species information of the pets that belongs to its customers. The Pet business
object stores the name and species information for one customer pet.
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[%lf] Customer = [C1Pet

Mame  string Mame siring
Address string Species string
Phone string

Pet Pet

Figure 6. Customer business object with child Pet business object

Each business object is associated with an operation. The operation in turn is
associated with the wrapper. The operation tells the adapter what to do with the
wrapper business objects. The following operations are examples of Create
operations used by the adapter to create emails during the outbound
communication:

¢ Create Customer
¢ Create Address

No matter what name you give an operation for your module, the adapter
performs the CreateEmail operation.

For inbound communications, Emit is the only supported operation. This operation
is used to take information from an email and convert it to business objects.

During adapter configuration, you can optionally choose to generate a business
graph. In version 6.0.2, each top-level business object is contained in a business
graph, which includes a verb that an application can use in version 6.0.2 to specify
additional information about the operation to be performed. In version 7.5.0.2 and
later releases, business graphs are optional; they are required only when you are
adding business objects to a module created with a version of IBM Integration
Designer earlier than version 7.5.0.2. If business graphs exist, they are processed,
but the verb is ignored.

How business objects are created

Business objects and their wrapper objects are created by the external service
wizard from XSD files either imported from another module or created with IBM
Integration Designer business object editor. For any business object structure except
the simple alert email structure, you must create or import the XSD files you want
the adapter to make into business objects before you run the external service
wizard. If transformation is needed, a business object that maps to the email body
or an attachment that needs transformation must exist. A generic email business
object is available for pass-through operations. Or, if only a simple alert email is
needed (no attachments), the adapter provides a simple alert email structure with
standard headers as another option.

You create business objects for your module with the external service wizard
launched from IBM Integration Designer. If you define XSD files using the business
object editor before starting the external service wizard, the adapter creates
business objects from these schemas.

Custom wrapper business objects

Custom wrapper business objects are user-defined wrapper business objects that
contain protocol-specific information and content. To use custom business objects,
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you must first create business object schema files (XSD files) by using the IBM
Integration Designer business object editor. You can then use the external service
wizard to generate business objects from the XSD files. A custom wrapper business
object can be created from an existing business object or from XSD files.

Custom wrapper business objects are useful if you have an existing map or
mediation that expects a business object to have a protocol-specific wrapper. The
custom wrapper business object does not allow child objects of anyType. Using
anyType objects restricts you from using maps and mediation wiring, because you
must write programs or code to fetch business objects from the anyType field. You
must write such code if child objects of anyType are allowed, because the business
object type being set on the anyType field is unknown.

WebSphere Application Server environment variables

WebSphere Application Server environment variables can be used in the external
service wizard to specify directory values. You can now change any string property
values in inbound and outbound configuration by only changing the environment
variables.

When you configure the adapter for inbound or outbound processing using the
external service wizard, you set values for various required local files and
directories. You can later change these values in the deployed application from the
IBM Business Process Manager or WebSphere Enterprise Service Bus Process
Administrative Console.

Starting with IBM Business Process Manager or WebSphere Enterprise Service Bus
Version 6.1.0, instead of hardcoding values for directories and files, you can declare
them as WebSphere Application Server environment variables and specify the
environment variable names when you run the external service wizard. When you
deploy your application, the environment variable name is replaced with the actual
value and used by the adapter. If you want to change the property value, you can
change the environment variable in the IBM Business Process Manager or
WebSphere Enterprise Service Bus Process Administrative Console.

WebSphere Application Server environment variables can be used for all string
property values (not Boolean or integer variables) that are set in inbound and
outbound configurations.

When you create a WebSphere Application Server environment variable, you
specify:
* The name of the environment variable, for example, ARCHIVE_FOLDER.

* The value that the symbolic name represents, for example: C:\email\
ArchiveFolder.

* The scope for the environment variable, which determines the level at which the
environment variable is visible in the Process Administrative Console. The scope
level can be server, node, or cell:

— Server scope limits visibility to the named server. The server scope is the most
specific scope for defining environment variables.

— Node scope limits visibility to all the servers on the named node. The Node is
the default scope level.

— Cell scope limits visibility to all servers on the named cell.
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The external service wizard

The external service wizard provides a blueprint to create services from existing
elements like business objects.

Use the external service wizard to configure your adapter before it is deployed to
IBM Business Process Manager or WebSphere Enterprise Service Bus. Using the
external service wizard, you can create business object schema files (XSD files),
build service descriptions, define connection properties for the mail server, and
generate business objects that contain everything the adapter needs to conduct
inbound and outbound communication.

You can use the external service wizard to generate business objects from the XSD
files. The external service wizard builds the service descriptors that are
adapter-specific artifacts used in import, export, and WSDL files. Also, you define
the connection properties by typing the name or IP address of the mail server and
the user ID and password needed to access it. The external service wizard then
generates the business objects through which WebSphere Adapter for Email
provides operations to send and receive emails.
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Chapter 2. Planning for adapter implementation

You need to consider various factors before setting up and using the WebSphere
Adapter for Email. For example, before you configure the adapter, consider
whether to set up the adapter in a clustered environment, in which the workload
of the server is distributed across multiple machines. Also, if you are migrating
from an earlier version of WebSphere Adapter for Email, perform any migration
tasks.

Before you begin

Before you begin to set up and use the adapter, you must possess a thorough
understanding of business integration concepts, the capabilities, and requirements
of the integration development tools and runtime environment that you are going
to use, and the mail server environment where you build and use the solution.

To configure and deploy WebSphere Adapter for Email you must understand and
be familiar with the following concepts, tools, and tasks:

¢ The business requirements of the solution you are building.
* The mail server's security and configuration needs.

* Business integration concepts and models, including the Service Component
Architecture (SCA) programming model.

* The capabilities and requirements of IBM Business Process Manager or
WebSphere Enterprise Service Bus. You must know how to configure and
administer the host server and how to use the Process Administrative Console to
set and modify property definitions, configure connection factories, and manage
events.

¢ The tools and capabilities provided by IBM Integration Designer. You must
know how to use these tools to create modules, wire and test components, and
complete other integration tasks.

Security

WebSphere Adapter for Email supports user name and password authentication
methods of Java " 2 as implemented in J2C. By supporting authentication, the
adapter provides protection for sensitive user data in log and trace files. Java 2 has
other security methods, such as Kerberos, which is not supported. The
authentication details are configured using the external service wizard. Secure
Sockets Layer (SSL) can be configured to protect the integrity of information being
passed between the mail server and the adapter and, for users who require it, the

adapter can be configured to run in support of the Federal Information Processing
Standard (FIPS) 140.

Antivirus software

If an antivirus program is running on your system (the system on which the
adapter is deployed or the one that hosts the mail server), the adapter might fail to
send outbound emails. It happens because some types of antivirus software have
auto protection turned on for Internet email protection. When auto protection is
turned on, the antivirus software might treat open connections to a mail server as
malicious attacks and block all emails using that connection. Because the adapter
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maintains the connections to the mail server in the pool, it does not close any of
the connections. It might result in the antivirus program blocking all email from
the adapter.

By default, the Select when antivirus or firewall software is running check box in
the connection properties window of the external service wizard is selected. This
means that the adapter will close the connection after each outbound request.

Support for protecting sensitive user data in log and trace

files

You can configure the adapter to prevent sensitive or confidential data, in the log
and trace files, from being viewed by users without authorization.

Log and trace files for the adapter can contain data from your mail server, which
might contain sensitive or confidential information. Sometimes these files might be
seen by individuals without authorization to view sensitive data. For example, a
support specialist must use the log and trace files to troubleshoot a problem.

To protect the data in such situations, the adapter lets you specify whether you
want to prevent confidential user data from displaying in the adapter log and trace
files. You can select this option in the external service wizard or change the
HideConfidentialTrace property. When this property is enabled, the adapter
replaces the sensitive data with XXX's.

See [“Managed connection factory properties” on page 179| for information about
this optional property.

The following types of information are considered potentially sensitive data and
are disguised:

e The contents of a business object
* The contents of the object key of the event record
¢ User name, Password, Environment, and Role

e The URL used to connect to the mail server

The following types of information are not considered user data and are not
hidden:

e The contents of the event record that are not part of the event record object key,
for example, the XID, event ID, business object name, and event status

* Business object schemas
* Transaction IDs

* Call sequences

Configuring Secure Socket Layers

Data that travels across a network can be intercepted by third parties. When this
data includes private information such as passwords or credit card numbers, steps
must be taken to make this data unintelligible to unauthorized users. Using Secure
Sockets Layer (SSL), you protect the integrity of information passed between the
mail server and the adapter.

Before you begin

To enable SSL, the following prerequisites must be satisfied:

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



The mail server must support secure IMAP, POP3, and SMTP communication

using SSL
The mail server must have its own private key and certificate
An email client must be installed

About this task

E-mails passing through the mail server are vulnerable to third-party interference
when SSL is not configured for use with the adapter. Using SSL prohibits data

from being modified either intentionally or unintentionally during transport and

protects data from being intercepted. It is effective because it uses several
cryptographic processes, such as public key cryptography for authentication with

the mail server and secret key cryptography and digital signatures for privacy and
data integrity. SSL allows the adapter to authenticate the identity of the mail server

and, when necessary, for the mail server to authenticate the identity of the mail

client.

Procedure

1. Set the email client truststore.
A truststore helps an email client decide what it can trust. When SSL is
configured, IBM Business Process Manager or WebSphere Enterprise Service
Bus sends its certificate to the email client for verification. The email client
verifies the certificate to ascertain that it is communicating with the intended
mail server. To enable this verification process, the certificate of the mail server
must be present in the client's truststore. Use the following steps to set up the
email client truststore.

a.

In IBM Integration Designer, right-click the server and click Run Process
Administrative Console.

b. Expand Security.
C. Select SSL certificate and key management.
d. Under Related items, select Key stores and certificates.
e. Select NodeDefaultTrustStore.
SSL certificate and key management WIE

551 certificate and key management > Key stores and certificates

Definas KeyStore types, including cryptography, RACF(R), CMS, Java(TM),
znd zll TrustStore types. %

Preferences

Mew| Delete | Exchange signers... |

El=IEEE

Select| Name 2 Path >

D NodeDefaultkeyStore £{CONFIG_ROOT }/cells/IBM-
68AZ8ACEBA51Nodel1Cell/ nodes/IBM-
66A28ACEB651Noda0l/key.pl2

Fl NodeDefsultTrustStore ${CONFIG_ROOT} cells/IEM-
56A2Z8ACESS1Nodan1Cell/nodes/IEM-
S66A28ACES51Nodeali/trust.pi2

|:| Nodel TPAKeys S{CONFIG_ROOTH calls/IEM-

66AZ8ACEBAI1Noded1Cell/ nodes/IBM-

Figure 7. Selecting NodeDefaultTrustStore

f. Under Additional properties, select Signer certificates.

g.

Click Add.
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h. In the Alias field, type the certificate name.

SSL certificate and key management NE

S5L certificate and key management > Key stores and certificates >
NodeDefaultTrustStore > Signer certificates > Add signer certificate

Adds a signer certificate to 2 key store.

Configuration

General Properties

* Alias

* File name

Data type %
| Basef4-encoded ASCII data [V]

App|y| ﬂ Reset| Cancel |

Figure 8. Adding signer certificate properties for the mail server certificate

i. In the File name field, type the full path of the mail server certificate.
j. Click OK.
2. Configure SSL properties for the adapter.
a. In the external service wizard, set enableSSL to True. By default,
enableSSL is set to False.

b. When using SSL for inbound communication, set the port number to 993 if
you are using the IMAP email protocol and 995 if you are using the POP3
email protocol. For outbound communication using the SMTP email
protocol, set the port number to 465.

Configuring the module for federal information processing
standard 140

The Federal Information Processing Standard 140 (FIPS) is a United States
government standard for cryptographic features like encryption, decryption,
hashing (message digests), Secure Sockets Layer, Transport Layer Security, Internet
Protocol security, Secure Shell, signatures, key exchange, and key or certificate
generation used in software products and modules. For users working with the
United States government who must conform to the FIPS standard, the adapter can
be configured to run in FIPS mode.

About this task

Configuring the module to run in FIPS mode restricts the adapter to working with
modules whose cryptographic features comply with FIPS approved methods and
providers. From an adapter perspective, running in FIPS mode restricts the adapter
to using the Transport Layer Security (TLS) security protocol based on Secure
Sockets Layer (SSL).

Restriction: WebSphere Adapter for Email cannot connect to Microsoft Exchange
Server 2003 when FIPS (SSL 3.1 and TLS 1.0) is configured for inbound
communication. The adapter generates exceptions during startup. Currently there
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are no known workaround to configure WebSphere Adapter for Email for use with
Microsoft Exchange Server 2003 in the FIPS mode. Version 7.5.0.3 of the adapter
was tested with SurgeMail 3.8 for FIPS.

To run the adapter in FIPS mode, you must instruct the adapter to use the IBM
Java Secure Socket Extension (IBMJSSE2) provider package. The IBMJSSE2 provider
is the preregistered Java Secure Socket Extension provider in the java.security file
in IBM SDK, version 5.0. IBMJSSE2 uses FIPS-approved packages.

When in FIPS 140-2 mode, IBM WebSphere Adapter for Email uses the FIPS 140-2
approved cryptographic provider(s); IBMJCEFIPS (certificate 376) and IBMJSSEFIPS
(certificate 409). The certificates are listed in the NIST website at

lhttp:/ / csrc.nist.gov /groups/STM /cmvp /documents /140-1/1401val2011.htm|

Complete the following steps to run the adapter in FIPS mode.

Procedure
1. In the IBMJSSE2 provider, set the com.ibm.jsse2]JSSEFIPS property to True.

2. Set the following security properties so the IBMJSSE2 provider can handle all
JSSE requests.

a. Set the ssl.SocketFactory.provider property to
com.ibm.jsse2SSLSocketFactoryImpl.

b. Set the ssl.ServerSocketFactory.provider property to
com.ibm.jsse2SSLServerSocketFactoryImpl.

3. In the java.security properties file, add the IBMJCEFIPS provider
com.ibm.crypto.fips.provider.IBMICEFIPS to the provider list above the
IBMJCE provider. Follow the security.provider.n=providername format where n
denotes the order of the provider. The provider with a value of 1 is considered
before the provider with a value of 2. Do not remove the IBMJCE provider.

4. From the IBM Business Process Manager or WebSphere Enterprise Service Bus
administrative console, set the system properties which are listed under the
Java virtual machine (JVM) properties. Follow the -Dpropertyname=propertyvalue
format.

5. Set security properties in the java.security file (in the IBM Business Process
Manager or WebSphere Enterprise Service Bus Java virtual machine/lib/security
directory).

Required folders for inbound processing

Several folders are required for activities such as archiving and storage before you
run the adapter for inbound processing.

Required folders for inbound communication

Before running the adapter, you must create one or more poll folders on your mail
server and a staging folder where the adapter saves all polled emails as files. These
folders are required and neither type are created by the adapter. Also, to use the
archiving functionality of the adapter to store successfully processed and failed
email events you must create an archive folder and a failed event folder.

The adapter requires that there be a folder on the local drive that holds emails
marked in progress in the event store. This folder is called the staging directory in
the external service wizard. Because the adapter does not create a staging directory,
you must create it before you start the external service wizard.

Chapter 2. Planning for adapter implementation 19


http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/1401val2011.htm

Required folders for archiving

You can configure the adapter to save, or archive copies, of both successful and
failed emails by using the ArchiveFolder property. To use this property, you must
create both of the following folders before you run the adapter.

* Archive folder — A file system folder where the adapter archives successful
emails.

¢ Failed event folder — A file system folder where the adapter archives failed
emails.

When the ArchiveFolder property is specified, all successfully processed mail is
moved into the archive folder from the staging folder. If you leave this property
blank all successfully processed mail is deleted from the staging folder.

If the FailedEventsFolder property is specified, all unsuccessfully processed mail is
moved into the failed events folder from the staging folder. If you leave this
property blank, all failed mail is deleted from the staging folder.

For more information about either of these folder properties, see the section on
activation specification properties in the reference section of this documentation.

Using WebSphere Application Server environment variables

Instead of specifying the folder names when you run the external service wizard,
you can use WebSphere Application Server environment variables. Refer more
information about environment variables at:|“WebSphere Application Server|
fenvironment variables” on page 13|

User authentication

20

The adapter supports several methods for supplying the user name and password
that are needed to connect to the mail server. By understanding the features and
limitations of each method, you can pick a method that provides the appropriate
level of security and convenience for your application.

To integrate an adapter into your application, you must provide the user name and
password for the adapter to use at run time on IBM Business Process Manager or
WebSphere Enterprise Service Bus to connect to mail server to process outbound
requests and inbound events.

At run time, the adapter needs to provide the user name and password to connect
to the mail server. To connect without user intervention, the adapter must access a
saved copy of the user information. In a server environment, there are several
methods for saving user information. You can configure the adapter to get your
user information, through any of the following methods:

* Adapter properties
* Data source
* J2C authentication alias

Saving the user name and password in adapter properties is a direct way to
provide this information at run time. You provide this user name and password
when you use the external service wizard to configure your module. Although
directly specifying the user name and password seems the most straightforward
method, it has important limitations. Adapter properties are not encrypted; the
password is stored as clear text in fields that are accessible to others on the server.
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Also, when the password changes, you must update the password in all instances
of the adapter that access that mail server. This includes the adapters embedded in
application EAR files and adapters that are separately installed on the server.

Using a data source allows you to use a connection already established for another
application. For example, if multiple applications access the same database with
the same user name and password, the applications can be deployed using the
same data source. The user name and password can be known only to the first
person who deploys an application to that data source or who defines a data
source separately.

Using a J2C authentication data entry, or authentication alias, created with the Java
Authentication and Authorization Service (JAAS) feature of Java EE security is a
robust, secure way to deploy applications. An administrator creates the
authentication alias that is used by one or more applications that need to access a
system. The user name and password must be known only to that administrator,
who can change the password in a single place, when a change is required.

Deployment options

There are two ways to deploy the adapter. You can either embed it as part of the
deployed application, or you can deploy it as a stand-alone RAR file. The
requirements of your environment affect the type of deployment option you
choose.

The following are the deployment options:

* With module for use by single application: With the adapter files embedded in
the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the adapter
files in a module, you must install them as a stand-alone adapter on each
application server where you want to run the module. Use a stand-alone adapter
when multiple modules can use the same version of the adapter and you want
to administer the adapter in a central location. A stand-alone adapter can also
reduce the resources required by running a single adapter instance for multiple
modules.

An embedded adapter is bundled within an enterprise archive (EAR) file and is
available only to the application with which it is packaged and deployed.
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IBM Business Process Manager or Enterprise information
WebSphere Enterprise Service Bus system
Application
Module Module Embedded SIS
Adapter < » function
Module

<«

E-mails

A stand-alone adapter is represented by a stand-alone resource adapter archive
(RAR) file, and when deployed, it is available to all deployed applications in the
server instance.

IBM Business Process Manager or Enterprise information
WebSphere Enterprise Service Bus system
Application A
Module Module
Module Stand-alone Business
Adapter function
Application B % b %
Module Module

Module

E-mails

While creating the project for your application using IBM Integration Designer, you
can choose how to package the adapter [either bundled with the (EAR) file or as a
stand-alone (RAR) file]. Your choice affects how the adapter is used in the run time
environment and how the properties for the adapter are displayed on the
administrative console.

Choosing either to embed an adapter with your application or to deploy the
adapter as a stand-alone module depends on how you want to administer the
adapter. If you want a single copy of the adapter and do not care about disruption
to multiple applications when you upgrade the adapter, then you would be more
likely to deploy the adapter as a stand-alone module.
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If you plan to run multiple versions, and if you care more about potential
disruption when you upgrade the adapter, you would be more likely to embed the
adapter with the application. Embedding the adapter with the application allows
you to associate an adapter version with an application version and administer it
as a single module.

Considerations for embedding an adapter in the application

Consider the following items if you plan to embed the adapter with your
application:
* An embedded adapter has class loader isolation.

A class loader affects the packaging of applications and the behavior of
packaged applications deployed on run time environments. Class loader isolation
means that the adapter cannot load classes from another application or module.
Class loader isolation prevents two similarly named classes in different
applications from interfering with each other.

* Each application in which the adapter is embedded must be administered
separately.

Considerations for using a stand-alone adapter

Consider the following items if you plan to use a stand-alone adapter:
* Stand-alone adapters have no class loader isolation.

Because stand-alone adapters have no class loader isolation, only one version of
any defined Java artifact is run and the version and sequence of that artifact is
undetermined. For example, when you use a stand-alone adapter there is only
one resource adapter version, one adapter foundation class (AFC) version, or one
third-party JAR version. All adapters deployed as stand-alone adapters share a
single AFC version, and all instances of a defined adapter share the code
version. All adapter instances using a given third-party library must share that
library.

* If you update any of these shared artifacts, all applications using the artifacts are
affected.

For instance, if you have an adapter that is working with server version X, and
you update the version of the client application to version Y, your original
application might stop working.

* Adapter Foundation Classes (AFC) is compatible with previous versions, but the
latest AFC version must be in every RAR file that is deployed in a stand-alone
manner.

If more than one copy of any JAR file is in the class path in a stand-alone
adapter, the one that is used is random; therefore, they all must be the latest
version.

Considerations while deploying adapters with different versions

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation.jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during run time, the adapter returns the
ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for Email version 7.5.0.3, the following error message is
displayed "The version of CWYBS_AdapterFoundation jar is not compatible with
IBM WebSphere Adapter for Email" as IBM WebSphere Adapter for Email loads
file:/C:/IBM/WebSphere /ProcServer?7 / profiles / ProcSrv01/installedConnectors /
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CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with version 7.0.0.3.
However, the base level of this jar required is version 7.5.0.3. To overcome this
conflict, you must migrate all adapters to the same version level.

There are occasions when you work with embedded adapters that do not need a
client-server communication, stand-alone adapters that need a server connection, or
a hybrid mix of adapter connections.

The following scenarios cover the different behaviors of AFC version conflict
detection, when you are deploying two or more adapters and at least one of the
adapter version is 7.5 or higher.

Deploying a stand-alone Adapter

1. Install WebSphere Adapter for Flat Files version 7.0.1.0 through the IBM
Business Process Manager administrative console.

2. Install WebSphere Adapter for SAP Software version 7.5.0.0 through the
administrative console.

3. Create ActivationSpec for an ALE pass-through inbound operation.

4. Create an application in IBM Integration Designer for a stand-alone ALE
pass-through inbound operation.

5. Install and start the application through the administrative console.
6. Verify the error.

Note: An error message is generated in the log/trace area of IBM Business Process
Manager, to indicate an AFC version conflict.

Deploying an embedded Adapter
1. Import a build of WebSphere Adapter for FTP version 7.0.1.0, using a RAR file.
2. Create a FTP Inbound EMD operation.

3. Import a build of WebSphere Adapter for Oracle E-Business Suite version
7.5.0.0, using a RAR file.

4. Create an Oracle inbound EMD operation, in the same module where you have
created the FIP Inbound EMD operation.

5. Deploy the module to IBM Business Process Manager.
6. Check the trace.

At step 5, the deployment fails. At step 6, you get an internal error message due to
the AFC version conflict.

Note: To avoid a name conflict between the business object generated by the two
adapters, generate the artifacts into different folders.

Deploying a combination of stand-alone and embedded Adapters

1. Install WebSphere Adapter for JDBC version 7.0.1.0 through theIBM Business
Process Manager administrative console.

2. Create an ActivationSpec for a JDBC inbound operation.

3. Create an application in IBM Integration Designer for a JDBC inbound
operation, for the stand-alone Adapter deployment.

4. Deploy the JDBC inbound application and trigger your inbound events.

5. Create an application in IBM Integration Designer for a WebSphere Adapter for
SAP Software version 7.5.0.0 inbound embedded Adapter deployment.
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6. Deploy an SAP inbound application, and trigger your inbound events.

Note: You can resolve the AFC version conflict by using different class loaders for
the stand-alone and embedded deployments. With this approach, the migration
process handles different CWYBS_AdapterFoundation.jar files and do not conflict
with each other. You can start both JDBC and SAP inbound applications
successfully, and process Inbound events without exception.

For further assistance, visit |http:/ /www.ibm.com/ support/ |
[docview.wss?uid=swg27006249]

WebSphere Adapters in clustered environments

You can improve adapter performance and availability by deploying a module on
a clustered server environment. Clusters are groups of servers that are managed
together to balance workloads and to provide high availability and scalability.

The module you deployed is replicated across all servers in a cluster, regardless of
whether you deploy the module using a stand-alone or an embedded adapter. The
following IBM products support WebSphere Adapters in a clustered environment:

* IBM Business Process Manager or WebSphere Enterprise Service Bus
¢ WebSphere Application Server Network Deployment
* WebSphere Extended Deployment

To deploy and configure WebSphere Adapter for Email in a clustered environment,
see: ["Deploying the module in a clustered environment” on page 121] When you
set up a server cluster, you create a Deployment Manager profile. The HAManager,
a subcomponent of the Deployment Manager, notifies the Java Platform, Enterprise
Edition (JEE) Connector Architecture (JCA) container to activate an adapter
instance. For information about creating clustered environments, see the following
link: Ihttp: / /publib.boulder.ibm.com/infocenter/dmndhelp /v7r5mx /| |
findex.jsp?topic=/com.ibm.wbpm.imuc.z.doc/topics/tins_zos_create_cluster.html

Using WebSphere Extended Deployment, you can optionally enhance the
performance of adapter instances in your clustered environment. WebSphere
Extended Deployment extends the WebSphere Application Server Network
Deployment capabilities by using a dynamic Workload Manager instance instead of
a static Workload Manager. The dynamic Workload Manager instance can optimize
the performance of adapter instances in the cluster by dynamically balancing the
load of the requests. It means that application server instances can be automatically
stopped and started based on the load variations, allowing systems with different
capacities and configurations to handle load variations evenly. For information
about the benefits of WebSphere Extended Deployment, see |ﬁtt p:// |
[publib.boulder.ibm.com/infocenter/wxdinfo/v6rim1/index jsp

In clustered environments, adapter instances can handle both inbound and
outbound processes.

Restriction: During inbound communication WebSphere Adapter for Email is not
able to switch polling between a IBM Business Process Manager or WebSphere
Enterprise Service Bus cluster backup node and the cluster's primary node when
each node is installed on a different operating system. For example, if the adapter
starts polling on a primary Windows node, it cannot switch to a backup UNIX
node because it cannot process the Windows path used for the directory storing in
progress events.

Chapter 2. Planning for adapter implementation 25


http://www.ibm.com/support/docview.wss?uid=swg27006249
http://www.ibm.com/support/docview.wss?uid=swg27006249
http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5mx/index.jsp?topic=/com.ibm.wbpm.imuc.z.doc/topics/tins_zos_create_cluster.html
http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5mx/index.jsp?topic=/com.ibm.wbpm.imuc.z.doc/topics/tins_zos_create_cluster.html
http://publib.boulder.ibm.com/infocenter/wxdinfo/v6r1m1/index.jsp
http://publib.boulder.ibm.com/infocenter/wxdinfo/v6r1m1/index.jsp

High availability for inbound processes

Inbound processes are based on events triggered as a result of updates to data in
the mail server. WebSphere Adapter for Email is configured to detect updates by
polling an event table. The adapter then publishes the event to its endpoint.

Important: In a clustered environment, the event directory must be on a shared
file system and not local to any of the cluster machines.

When you deploy a module to a cluster, the Java Platform, Enterprise Edition (JEE)
Connector Architecture (JCA) container checks the enableHASupport resource
adapter property. If the value for the enableHASupport property is true, which is
the default setting, all of the adapter instances are registered with the HAManager
with a policy 1 of N. This policy means that only one of the adapter instances
starts polling for events. Although other adapter instances in the cluster are
started, they remain dormant with respect to the active event until the active
adapter instance finishes processing the event. If the server on which the polling
thread was started shuts down for some reason, an adapter instance that is
running on one of the backup servers is activated.

Note: In the active-passive configuration mode of the adapters, the endpoint
application of the passive adapter instance also listens to the events/messages even
if the enableHASupport property is set to True. This is because the
alwaysactivateAT1MDBs property in the JMS activation specification is set to True.
To stop the endpoint application of the passive adapter instance from listening to
the events, you must set the alwaysactivateATIMDBs property value to False. For
more information, see [“Disabling end point applications of the passive adapter” on|

Important: Do not change the setting of the enableHASupport property.

High availability for outbound processes

In clustered environments, multiple adapter instances are available to perform
outbound process requests. So, if your environment has multiple applications that
interact with WebSphere Adapter for Email for outbound requests, then you might
improve performance by deploying the module to a clustered environment. In a
clustered environment, multiple outbound requests can be processed
simultaneously, so that they are not attempting to process the same record.

If multiple outbound requests are attempting to process the same record, such as a
Customer address, the workload management capability in WebSphere Application
Server Network Deployment distributes the requests among the available adapter
instances in the sequence they were received. As a result, these types of outbound
requests in a clustered environment are processed in the same manner as in a
single server environment: one adapter instance processes only one outbound
request at a time. For more information about workload management, see the
following link: |http:/ /publib.boulder.ibm.com/infocenter /wasinfo /v8r0/ |
lindex.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/trun_wlm.htmll

Migrating to version 7.5.0.3 of WebSphere Adapter for Email

By migrating to version 7.5.0.3 of WebSphere Adapter for Email, you automatically
upgrade from the previous version of the adapter. Additionally, you can migrate
your applications that embed an earlier version of the adapter, so that the
applications can use features and capabilities present in version 7.5.0.3.

26 IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide


http://publib.boulder.ibm.com/infocenter/wasinfo/v8r0/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/trun_wlm.html
http://publib.boulder.ibm.com/infocenter/wasinfo/v8r0/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/trun_wlm.html

Migration considerations

WebSphere Adapter for Email version 7.5.0.3 may have some features and updates
that might affect your existing adapter applications. Before migrating applications
that use WebSphere Adapter for Email, you must consider some factors that might
affect your existing applications.

Compatibility with earlier versions

WebSphere Adapter for Email version 7.5.0.3 is fully compatible with the custom
business objects (XSD files) and data bindings that are created using the adapter
version 6.1.x, version 6.2.x, version 7.0.x, version 7.5.0, and version 7.5.0.2 and
enables the existing business objects and data bindings to work well in the latest
version of the adapter.

Because version 7.5.0.3 of WebSphere Adapter for Email is fully compatible with
version 6.1.x, version 6.2.x, version 7.0.x, version 7.5.0, and version 7.5.0.2, any of
your applications that used previous versions of WebSphere Adapter for Email run
unchanged when you upgrade to version 7.5.0.3. However, if you want your
applications to use features and functionality present in version 7.5.0.3 of the
adapter, perform the migration of the artifacts as well as the upgrade of the
adapter.

The migration wizard replaces (upgrades) version 6.1.x, version 6.2.x, version 7.0.x,
version 7.5.0, or version 7.5.0.2 of the adapter with version 7.5.0.3 and enables
version 7.5.0.3 features and functionality for use with your applications.

Note: The migration wizard does not create components or modify existing
components, such as mappers and mediators to work with version 7.5.0.3 of the
adapters. If any of your applications embed an adapter that is version 7.5.0.2 or
earlier and you are upgrading to version 7.5.0.3, and you want your applications to
take advantage of the features and functions in version 7.5.0.3, you might need to
change those applications.

If the artifacts within a module have inconsistent versions, the entire module is
marked as unavailable for migration and cannot be selected. Version
inconsistencies are recorded in the workspace log, as they indicate that a project
might be corrupted.

The adapter migration wizard in IBM Integration Designer Version 7.5.1 only
supports the migration of adapters from version 6.1.x, version 6.2.x, version 7.0.x,
version 7.5.0, and version 7.5.0.2 to version 7.5.0.3. It does not support the adapter
migration from lower versions to any of the versions before version 7.5.0.3.

Deciding whether to upgrade or to upgrade and migrate

The default processing of the migration wizard is to perform an upgrade of the
adapter and to migrate the application artifacts so that the applications can use
features and functions in version 7.5.0.3 of the adapter. When you choose to
upgrade the adapter by selecting a project, the wizard automatically selects the
associated artifacts for migration.

If you decide that you want to upgrade the adapter from version 6.1.x, version

6.2.x, version 7.0.x, version 7.5.0, or version 7.5.0.2 to version 7.5.0.3, but you do
not want to migrate the adapter artifacts, you can do so by clearing the adapter
artifacts from the appropriate area of the migration wizard.
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Running the migration wizard without selecting any adapter artifacts installs and
upgrades your adapter. As the artifacts are not migrated, your applications cannot
take advantage of the features and capabilities that exist in version 7.5.0.3 of the
adapter.

Migrating multiple adapters referred within a project

When a module contains one or more connector projects, each of which references
to different adapters (for example, a module project that contains connector
projects referring to JDBC and SAP adapters), the migration wizard identifies the
artifacts belonging to each adapter and migrates these artifacts without disrupting
the artifacts of other adapters.

When you select the module project and launch the migration wizard:

¢ The Source connector field lists the connector projects with the selected module
project.

¢ The Dependent artifact projects area lists only the selected module project.

If you select the connector project and launch the migration wizard:
* The Source connector field lists only the selected connector project.

* The Dependent artifact projects area lists all projects which reference the
selected connector project, including the module project.

Run the migration wizard in a test environment

Because adapter migration might require you to change those applications that use
version 7.5.0.3 of WebSphere Adapter for Email, you must always perform the
migration in a development environment first and test your applications before
deploying the application to a production environment.

The migration wizard is fully integrated with the development environment.
Fault processing when migrating to version 7.0

Fault processing in version 7.0 depends upon the type of fault configuration done
in the previous version. If the user manually configures business faults in version
6.2 then the faults are automatically configured in version 7.5.0.3. In case no fault is
configured in version 6.2, then the user needs to manually configure the faults
after migrating to version 7.5.0.3, as per the steps described in the following
section.

Performing the migration

You can migrate a project or EAR file to version 7.5.0.3 using the adapter migration
wizard. When the tool is finished, the migration is complete and you can work in
the project or deploy the module.

Before you begin

Review the information in Migration considerations.
About this task

To perform the migration in IBM Integration Designer, complete the following
steps.
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Note: After migration is complete, the module is no longer compatible with
previous versions of the IBM Business Process Manager or WebSphere Enterprise
Service Bus runtimes or IBM Integration Designer.

The following steps describe how to run the adapter migration wizard from the
connector project menu while in the Java EE perspective in IBM Integration
Designer.

Procedure

1. Import the PI (project interchange) file for an existing project into the
workspace.

Note: Ensure that you do not modify the contents of the RAR or copy the
adapter JAR file outside the connector project.

2. When projects are created in an earlier version of IBM Integration Designer, the
Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see |http:/ /publib.boulder.ibm.com/infocenter/dmndhelp /|
[v7r5m1/topic/com.ibm.wbpm.wid.imuc.doc/topics / tmigsrcart. html]

3. Change to the Java EE perspective.
4. Right-click the module and select Migrate connector project. For example, the
adapter RAR module.

You can also launch the adapter migration wizard in the following ways:

* Right-click the project in the Java EE perspective and select Migrate adapter

artifacts.

* From the Problems view, right-click a migration-specific message and select

Quick Fix to correct the problem.
5. In the Select Projects window, perform the following steps:

a. The Source connector field displays the name of the connector project that
you are migrating. If you are migrating a module project, this field lists all
the connector projects in the module project. Select the source project from
the list. For more information, see [“Migrating multiple adapters referred)|
[within a project” on page 28

b. The Target connector field displays the name of the connector to which you
are migrating. If you are working with more than one adapter version, this
list displays the names of all the compatible connectors. Select the connector
you want to migrate.

c. The Target version field displays the version corresponding to the target
connector that you selected in the previous step.

d. The Dependent artifacts project area lists the adapter artifacts that are
migrated. If you are migrating a module project, this area lists only the
selected module project. If you are migrating a connector project within the
module project, this area lists all projects which reference the selected
connector project, including the module project. By default, all the
dependent artifact projects are selected. If you do not select a dependent
artifact project, that project is not migrated. You can migrate any project that
you have not selected at a later time. Previously migrated projects, projects
with a current version, and projects that contain errors are unavailable for
migration and are not selected. For more information, see [“Upgrading but]
[not migrating a project” on page 30/

e. Click Next. A warning window is displayed with the message, “Properties
that are not supported in this version of the target adapter will be removed
during the migration”.
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f. Click OK.

6. In the Review Changes window, review the migration changes that occur in
each of the artifacts that you are migrating. To view the details, expand each
node by clicking the + sign.

7. To complete the migration:
* Click Finish.

e If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

Before running the migration process, the wizard performs a backup of all
projects affected by the migration. The projects are backed up to a temporary
folder within the workspace. If the migration fails for any reason, or if you
decide to cancel the migration before it completes, the wizard deletes the
modified projects and replaces them with the projects stored in the temporary
folder.

Upon completing the migration successfully, all backed up projects are deleted.

8. If you are migrating an EAR file, optionally create a new EAR file with the
migrated adapter and artifacts, and deploy it to IBM Business Process Manager
or WebSphere Enterprise Service Bus. For more information about exporting
and deploying an EAR file, see the topics devoted to it in this documentation.

Results

The project or EAR file is migrated to version 7.5.0.3. You do not need to run the
external service wizard after exiting the adapter migration wizard.

Upgrading but not migrating a project
You can upgrade the adapter from an earlier version, to version 7.5.0.3 while
choosing not to migrate the adapter project artifacts.

About this task

Running the migration wizard without selecting any adapter artifacts installs and
upgrades your adapter. As the artifacts are not migrated, your applications cannot
take advantage of the features and capabilities that exist in version 7.5.0.3 of the
adapter.

Procedure
1. Import the PI (project interchange) file into the workspace.

2. When projects are created in an earlier version of IBM Integration Designer, the
Workspace Migration wizard starts automatically and selects the projects to
migrate. Follow the wizard and complete the workspace migration. For more
information, see Ihttp: / /publib.boulder.ibm.com/infocenter /dmndhelp/ |
[v7r5m1/topic/com.ibm.wbpm.wid.imuc.doc/ topics /tmigsrcart.html]

3. In the Java EE perspective, right-click the project name and click Migrate
connector project. The Adapter Migration wizard is displayed.

4. In the Select Projects window, clear the dependent artifact projects, and click
Next. A warning window is displayed with the message, “The properties that
are not supported in the version of the target adapter will be removed during
the migration.”
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5. Click OK.

6. In the Review Changes window, review the migration changes that occur
during updating the project. To view the details, expand each node by clicking
the + sign.

7. To complete the migration:
* Click Finish.

e If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To
update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.

Results

The project can now be used with WebSphere Adapter for Email, version 7.5.0.3.

Migrating WebSphere Business Integration applications

You need to migrate the WebSphere Business Integration applications so that they
become compatible with Version 7.5.0.3 of your adapter.

About this task

Migrating WebSphere Business Integration applications for use with Version 7.5.0.3
of your WebSphere adapter is a multistep process. First, the artifacts from
WebSphere InterChange Server are migrated and converted. A project is then
created for the artifacts in IBM Integration Designer. In the remaining steps, the
adapter-specific artifacts are migrated and converted into the JCA-compliant
format supported by Version 7.5.0.3 of the adapter.

Example

The following diagram shows the wizards that you use to migrate WebSphere
Business Integration solutions from WebSphere InterChange Server, so that these
applications can be used with Version 7.5.0.3 of your adapter.

Migrating WebSphere Business Integration solutions

WebSphere InterChange Server

IBM Integration Designer Installation directory

The imported jar file

1 WebSphere becomes a project in

Interchange . .
Server migration !rBhM Ir:’teg{atlos_g)eflgner . Imports/converts
wizard ?‘a "ap er artifacts are WebSphere InterChange Jar file
b A L artifacts
JCA-compliant at this point
2 i . Run the External
Enterprise service | gervice wizard to
wizard import the connector
project

3 | Adapter migration | Run the Adapter
wizard migration wizard to

convert WBI adapter
artifacts into JCA-compliant
artifacts for use within

IBM Business Process
Manager
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Migrating applications from WebSphere InterChange Server

To use Version 7.5.0.3 of WebSphere Adapter for Email with applications from
WebSphere InterChange Server, you need to migrate the application artifacts and
convert them so that they can be deployed and run on IBM Business Process
Manager or WebSphere Enterprise Service Bus. Understanding this task at a high
level helps you perform the steps that are needed to accomplish the task.

The following figure illustrates the flow of the migration task. The steps that
follow the figure describe this task at a high level only. See the topics following
this roadmap for the details on how to perform each of these steps.

Start

}

1. Run the WebSphere InterChange
Server migration wizard

'

2. Verify the result of running
the WebSphere InterChange
Server migrafion wizard

'

3. Consider the implications of using
your WebSphere adapter

4

4. Run the adapter migration wizard

Jr
End
Success

Figure 9. Roadmap for migrating applications from WebSphere InterChange Server

Migrating applications from WebSphere InterChange Server

This task consists of the following steps:
1. Run the WebSphere InterChange Server migration wizard.

The WebSphere InterChange Server migration wizard moves the application
artifacts into IBM Integration Designer. The migrated adapter artifacts are not
fully JCA-compliant at the completion of this task.

2. Verify that the WebSphere InterChange Server migration is successful.

Review all messages from the Migration results window and take action if
required.

3. Consider the implications of using Version 7.5.0.3 of WebSphere Adapter for
Email.

In addition to considerations for migrating WebSphere InterChange Server
applications, you need to consider how Version 7.5.0.3 of WebSphere Adapter
for Email works with the migrated applications. Some of the adapter operations
supported by WebSphere InterChange Server applications might be supported
and implemented differently with Version 7.5.0.3 of the adapter.

4. Run the adapter migration wizard.

Run the adapter migration wizard to update adapter-specific artifacts such as
the schemas and service definition files (.import, .export, and .wsdl files) for
use with Version 7.5.0.3 of the adapter.
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Migration considerations for WebSphere Business Integration
adapters

By migrating to WebSphere Adapter for Email Version 7.5.0.3, you have an adapter
that is compliant with the Java Platform, Enterprise Edition (JEE) Connector
Architecture (JCA) and designed specifically for service-oriented architecture.

Application artifacts

Before running the adapter migration wizard, use the WebSphere InterChange
Server migration wizard to generate the application artifacts for the WebSphere
Business Integration adapter, including the business objects, maps, and
collaborations. Then you can run the adapter migration wizard to update the
adapter-specific artifacts such as the schemas and service definition files (.import,
.export, and .wsdl) so that they are suitably converted into a format that is
compliant with JCA.

Run the migration wizard in a test environment first

Because migrating from a WebSphere Business Integration adapter to WebSphere
Adapter for Email might require changes to the applications that use Version
7.5.0.3 of WebSphere Adapter for Email, always perform the migration in a
development environment first and test your applications before deploying the
application to a production environment.

Migrating application artifacts from WebSphere InterChange
Server

To migrate the application artifacts into IBM Integration Designer, run the
WebSphere InterChange Server migration wizard. The wizard imports and converts
most of the artifacts into a format that is compatible with IBM Business Process
Manager or WebSphere Enterprise Service Bus.

Before you begin

Launch the WebSphere InterChange Server migration wizard from within IBM
Integration Designer to migrate the application artifacts from WebSphere
InterChange Server format into artifacts that are compatible with IBM Business
Process Manager or WebSphere Enterprise Service Bus.

For information about how to prepare to migrate artifacts from WebSphere
InterChange Server and for detailed instructions on performing the migration and
verifying that the migration was successful, see [http://publib.boulder.ibm.com/|
infocenter/dmndhelp /v7r5m1/index.jsp?topic=/com.ibm.wbpm.wid.imuc.doc/|
topics/twics.htmll

About this task

Running WebSphere InterChange Server migration wizard might not fully convert
adapter-specific artifacts (such as service descriptors, service definitions, and
business objects) into IBM Business Process Manager or WebSphere Enterprise
Service Bus compatible artifacts. To complete the migration of adapter-specific
artifacts, run the adapter migration wizard after you have successfully run the
WebSphere InterChange Server migration wizard.
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Note: While you run the WebSphere InterChange Server migration wizard, ensure
that you set each connector in the repository to the same adapter version.

Results

The project and application artifacts are migrated and converted into IBM Business
Process Manager compatible artifacts.

What to do next

Run the adapter migration wizard to migrate the adapter-specific artifacts.

Migrating adapter-specific artifacts

After a project is created for the artifacts in IBM Integration Designer, you can
migrate the project using the adapter migration wizard. The adapter migration
wizard updates adapter-specific artifacts such as the schemas and service definition
files (.import, .export, and .wsdl) for use with version 7.5.0.3 of the adapter. When
you finish running the adapter migration wizard, the migration is complete and
you can work in the project or deploy the module.

Before you begin

Before running the adapter migration wizard, do the following steps:

+ Review the information in [“Migration considerations” on page 27.|

* Run the WebSphere InterChange Server migration wizard to migrate the project
and convert data objects for use with IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

After migration is complete, the module will work only with Version 7.5.0.3 of
your adapter.

To perform the migration in IBM Integration Designer, complete the following
steps.

Procedure
1. Import the PI (project interchange) file for an existing project into the
workspace.

2. When projects are created in an earlier version of IBM Integration Designer,
the Workspace Migration wizard starts automatically and selects the projects
to migrate. Follow the wizard and complete the workspace migration. For
more information, see |http://publib.boulder.ibm.com/infocenter/ dmndhelp/ |
[v7r5m1/topic/com.ibm.wbpm.wid.imuc.doc/topics/tmigsrcart.html|

3. Change to the Java EE perspective.
4. Right-click the connector project and select Migrate connector project.

You can also launch the adapter migration wizard by using the right-click
option and selecting the module project in the Java EE perspective and
selecting Migrate adapter artifacts.

Note:

If the adapter type (for example, CICS/IMS adapter) is not supported by the
migration wizard, the Migrate connector project and Migrate adapter
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artifacts menus are not available for selection. If the adapter project is of the
latest version and the module projects referencing this adapter project are also
of the latest version, these menus are disabled.

When you launch the migration wizard from the connector project while in
the Java EE perspective, by default all the dependent artifact projects are
selected. If you do not select a dependent artifact project, that project is not
migrated.

5. In the Select Projects window, perform the following steps:

a. The Source connector field displays the name of the connector project that
you are migrating. Select the source project from the list.

b. The Target connector field displays the name of the connector to which
you are migrating. If you are working with more than one adapter version,
this list displays the names of all the compatible connectors. Select the
connector to which you want to migrate.

c. The Target version field displays the version corresponding to the target
connector you selected in the previous step.

d. The Dependent artifacts project area lists the adapter artifacts that are
migrated.

e. Review the tasks and warnings presented on the welcome page, and click
Next. A warning window is displayed with the message, “The properties
that are not supported in the version of the target adapter are removed
during the migration.”

f. Click OK.
6. In the Review Changes window, review the migration changes that occur in

each of the artifacts that you are migrating. To view the details, expand each
node by clicking the + sign.
7. To complete the migration:
* Click Finish.
¢ If the files that need to be updated during migration are in read-only mode,
you will be unable to click on the Finish button. To view these files, click
Next. The Update Read-only files window displays the read-only files. To

update these files and continue with the migration, click Finish. To exit the
wizard without migrating the adapter, click Cancel.
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Before performing the migration process, the wizard backs up all projects
affected by the migration. The projects are backed up to a temporary folder
within the workspace. If the migration fails for any reason, or if you decide to
cancel the migration before it completes, the wizard deletes the modified
projects and replaces them with the projects stored in the temporary folder.

Select Project > Clean, to refresh and rebuild the workspace for the changes to
take effect.

Note: The inProgressFolder property in WebSphere Adapter for Email does
not have an equivalent property in WebSphere Business Integration Adapter
for e-Mail. You must specify the value for the inProgressFolder property
manually after running the migration wizard.

On successful migration, all backed up projects are deleted. Remove the Sync
inbound flow manually as this flow is not used by the adapter. From the
migrated project, select the Input_Sync inbound flow, right-click, and select
Delete.
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10. If you are migrating an EAR file, create a new EAR file with the migrated
adapter and artifacts, and deploy it to IBM Business Process Manager or
WebSphere Enterprise Service Bus. For information about exporting and

loying an EAR file, see [“Deploying the module for production” on page|

Results

The project is migrated to Version 7.5.0.3. You do not need to run the external
service wizard after exiting the adapter migration wizard.

Changes to the import, export, and WSDL files after migration

When the WebSphere InterChange Server migration wizard moves the application
artifacts into IBM Integration Designer, changes made are reflected in the service
definition files: the import, export, and WSDL files.

The migrated adapter artifacts are not fully JCA-compliant at the completion of
this task. You can complete the migration of the adapter-specific artifacts (such as
service descriptors, service definitions, and business objects) to a JCA compatible
format by running the adapter migration wizard.

Changes to the import file

During migration, the affected module artifacts are migrated to an import file. The
existing JMS Binding property is changed to the EIS Binding property in the
import file. The other property details added in the import file include information
about the data binding configuration, changes to the connection information in the
Managed Connection Factory properties, and several new method bindings.

Changes to the export file
During migration, the affected module artifacts are migrated to an export file. The
existing JMS Binding property is changed to the EIS Binding property in the export

file. The other property details added in the export file include information about
the data binding configuration, changes to the connection information in the
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Activation Specification properties, and several new method bindings.
Changes to the WSDL file after migration

During migration, the affected module artifacts are migrated to corresponding
WSDL files that include EMail specific service description WSDL artifacts. The
service description files become JCA compatible. The WSDL files have an input
and output type for each operation. Both the inbound and outbound operations
work on their specific input types to produce corresponding output types after the
operations are performed.

Note:

* When you migrate multiple top level inbound business objects in the project,
only the first top-level business object inbound feature works correctly. For the
other top level inbound business object to work correctly, you must manually
modify the "emit + [verb name] + after image + [business object name]" method
in the Input_Processing.java and Input_Async_Processing.java class to call the
correct destination services.

e The WebSphere Business Integration Adapter for e-Mail properties that are either
not valid or not supported by WebSphere Adapter for Email are removed from
the migrated artifacts.
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Chapter 3. Samples and tutorials

To help you use WebSphere Adapters, samples and tutorials are available from the
Business Process Management Samples and Tutorials website.

You can access the samples and tutorials in either of the following ways:

* From the welcome page of IBM Integration Designer, click Go to Samples and
Tutorials. In the Samples and Tutorials pane, under More samples, click
Retrieve. Browse the displayed categories to make your selection.

* From the Business Process Management Samples and Tutorials website:
[http:/ /bpmwikilogin.blueworkslive.com /accounts/login /|
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Chapter 4. Configuring the module for deployment

To configure the adapter so that it can be deployed on IBM Business Process
Manager or WebSphere Enterprise Service Bus, use IBM Integration Designer to
create a module, which is exported as an EAR file when you deploy the adapter.
You then specify the business objects you want to build and the system on which
you want to build them.

Roadmap for configuring the module

Before you can use WebSphere Adapter for Email in a runtime environment, you
must configure the module. Understanding this task at a high level helps you
perform the steps that are needed to accomplish the task.

You configure the module for WebSphere Adapter for Email by using IBM
Integration Designer. The following figure illustrates the flow of the configuration
task, and the steps that follow the figure describe this task at a high level only. For
details about how to perform each of these steps, see the topics following this
roadmap.
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Figure 10. Roadmap for configuring the module

Configuring the module
This task consists of the following steps.

Note: These steps assume that you are using user-defined business objects that
require data transformation. If you are using generic business objects, which do not
require data transformation, some of the following steps are ignored. For example,
you do not need to select a data binding and a data handler.

1. Create an authentication alias to access the mail server. Perform this step using
the Process Administrative Console.

2. Create a module in IBM Integration Designer.

Note: You create business objects in the module.
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3. Define the business objects to be used by the project.

4. Create a project, which is used to organize the files associated with the adapter
by using the external service wizard in IBM Integration Designer.

5.

Build business services by running the external service wizard from IBM
Integration Designer, then perform the following steps:

a.

Specify the following deployment and runtime properties:
* Connection properties

* Security properties

* Deployment options

¢ Function selector - Inbound only

Select a data type and name the operation associated with this data type.
For each operation, specify the following information:

¢ The operation kind, for example, Create, Append, Exists.
* Specify whether the operation is pass-through or user defined.

Select the data binding. Each data type has an equivalent data binding used
to read the fields in a business object and fill the corresponding fields in a
file.

Select the data handler that is going to perform the conversions between a
business object and a native format.

Specify interaction specification property values and generate artifacts. The
output from running the external service wizard is saved to a business
integration module, which contains the business object or objects, and the
import or export file.

Configuring the mail server to work with the adapter

Before working with the adapter, you must install and configure a mail server
according to its user manual. The information about how to connect to the mail
server (such as user names, passwords, and port) is required by the external
service wizard in IBM Integration Designer when you create your adapter module.

Creating an authentication alias

An authentication alias is a feature that encrypts the passwords used by the
adapter to access the mail server. You can gain a greater level of security by using
an authentication alias to configure the adapter, instead of typing the user ID and
password directly.

Before you begin

To create an authentication alias, you must have access to the IBM Business Process
Manager or WebSphere Enterprise Service Bus Process Administrative Console.

Note: Using the authentication alias is the default choice in the external service
wizard.

The following procedure shows you how to gain access to the Process
Administrative Console through IBM Integration Designer. If you are using the

Process Administrative Console directly (without going through IBM Integration
Designer), log in to the Process Administrative Console and skip to step

/l
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About this task

Using an authentication alias eliminates the need to store the password in clear
text in an adapter configuration property, where it might be visible to others.

To create an authentication alias, use the following procedure.

Procedure
1. Start the Process Administrative Console.

To start the Process Administrative Console through IBM Integration Designer,
perform the following steps:

a. In the Business Integration perspective of IBM Integration Designer, click
the Servers tab.

b. If the server does not show a status of Started, right-click the name of the
server (for example, WebSphere Process Server) and click Start.

c. Right-click the name of the server and select Administration > Run Process
Administrative Console.

d. Log on to the Process Administrative Console. If your Process
Administrative Console requires a user ID and password, type the ID and
password and click Log in. If the user ID and password are not required,
click Log in.

2. In the Process Administrative Console, click Security > Secure administration,
applications, and infrastructure.

3. Under Authentication, click Java Authentication and Authorization Service >
J2C authentication data.

4. Create an authentication alias:
a. In the list of J2C authentication aliases that is displayed, click New.

b. In the Configuration tab, type the name of the authentication alias in the
Alias field.

c. Type the user ID and password that are required to establish a connection
to the mail server.

Optionally type a description of the alias.
Click OK.
The newly created alias is displayed.

The full name of the alias contains the node name and the authentication
alias name you specified. For example, if you create an alias on the node
widNode with the name ProductionServerAlias, then the full name is
widNode/ProductionServerAlias. This full name is the one you use in
subsequent configuration windows.

f. Click Save.
Results

You created an authentication alias, which you can use when you configure the
adapter properties.
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Creating the module

A module encapsulates the service in a reusable unit and consists of both a project
in IBM Integration Designer and a unit of deployment to IBM Business Process
Manager or WebSphere Enterprise Service Bus. The module is packaged and
deployed to IBM Business Process Manager or WebSphere Enterprise Service Bus
as an enterprise archive (EAR) file.

Procedure
1. If IBM Integration Designer is not currently running, start it now.

a. Click Start > Programs > IBM > IBM Integration Designer > IBM
Integration Designer version, where version is the version of the IBM
Integration Designer.

b. If you are prompted to specify a workspace, either accept the default value
or select another workspace.

The workspace is a directory where IBM Integration Designer stores your
project.

c. Optional: When the IBM Integration Designer window is displayed, click
Go to the Business Integration perspective.

2. Right-click in the Business Integration section of the IBM Integration Designer

window.
E- Business Integration &3 =B
| A
# e sed s~
<all resources> -

Click to add a business integration project. ..

Switch to Process Center perspective

I = -t=oraton Solution
& Module

Show In Alt+shift+w » .@ Mediation Madule
0 Library
‘\Tﬁ Component Test Project
T'E. Paste Cirl+y EL Business Monitoring Project

[ Project...

Exg Import... [ other...

£ Export...

& | Refresh

Figure 11. Business Integration section of the window

3. In the New Module window, type a name for the module in the Module Name
field. For example, to configure a module for outbound processing, type
Outbound as the module name. Click Finish.

Results

A new module is listed in the Business Integration window.
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What to do next

Define business objects for the module.

Defining WebSphere Application Server environment variables

Use the Process Administrative Console of IBM Business Process Manager or
WebSphere Enterprise Service Bus to define WebSphere Application Server
environment variables.

About this task

To define a WebSphere Application Server environment variable, use the following
procedure:

Procedure
1. Start the Process Administrative Console.
2. Select Environment > WebSphere Variables.

3. Select the scope for the environment variable. The scope specifies the level at
which the resource definition is visible on the Process Administrative Console
panel. The possible values are server, node, and cell. In the following figure, the
scope is defined at the cell level as Cel11=Dmgr1Cell.

; [ [T S
Integrated Solutions Console Welcome Help | Logout -N | ﬂ |:::
View: IAII tasks |=] Wehsphere \ =3 Close page|a

Welcome WebSphere Variables

Guided Activities WebSphere Variables
Servers Use this page to define substitution variables. Variables specify a leve
defined values, such as file system root directories. Variables have a
node, cluster, or cell. Values =t one scope level can differ from values
has conflicting scope values, the more granular scope value overrides
Therefare, server variables override node variables, which override clu
Install Mew Appli: variables.

SCA modules

Bl applications

Enterprise &pplic

B Scope: Cell=DmgricCell

Resources
Scope specifies the level at which the resource definition is visible

Security information on what scope is and how it works, see the scope seb
El Environment ICEI|=DmngCEII B4 |

Virtual Hasts ;
Preferances
Update global we =

configuration :
Maximum rows

webSphere Varial |2D ]
Shared Libraries

Replication domai [T Retain filter critaria.

LRI Groups

Maming = Apply Reset

Integration Applicati
Mew| | Delets

Users and Groups I ‘t‘ ""?
1 I— o D! | EIB

Figure 12. Setting the scope for the environment variable

System administratic

4. Click New and provide a name and a value for the environment variable. The
name is the symbolic name that represents a physical path. The value is the
absolute path that the variable represents. In this example, the name is
ARCHIVE_FOLDER and the value is C:/email/ArchiveFolder. You can use the
Description field, which is optional, to describe the purpose of the variable.
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Figure 13. Providing a name and a value for the environment variable

5. Click OK to save the changes.

Results

An environment variable called ARCHIVE_FOLDER is defined, with the value
C:/email/ ArchiveFolder and a scope of Cell=Dmgr1Cell. You can use it in the
external service wizard whenever you specify the event directory.
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Figure 14. The new environment variable ARCHIVE_FOLDER displayed in the WebSphere
Variables window

What to do next

Define business objects for the module.

Defining business objects

Create business objects or import predefined business objects that is to be used by
the module. WebSphere Adapter for Email uses business objects to either obtain
information from an email or to produce an email.

About this task

You use the business object editor to create new business objects or import
predefined business objects.

Note: These steps must only be used for payload business objects (such as
Customer and Order) and not for top-level email business objects (wrappers).
Wrapper business objects are created by the external service wizard.

Procedure
* To create new business objects, complete these steps.

1. Expand the new module in the Business Integration section of the IBM
Integration Designer window.

2. Right-click the Data Types folder and select New > Business Object.
3. In the Business Object window, type a name in the Name field.
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. Click Finish. The new business object is added to the Data Types folder.

Click the Add a field to a business object icon and add the necessary fields
to the business object.

6. Click the Save icon.

7. Repeat the previous steps for each business object that you want to create.

o

* To import predefined business objects, complete these steps.

1. Expand the new module located inside of the Business Integration section of
the IBM Integration Designer window.

Right-click the Data Types folder and select Import.

In the Select window, expand General and click File System.
Click Next.

Browse to the directory with the XSD file and click OK.
Select one or more business object XSD files and click Finish.

IS o < A

Results

The new business objects are defined.
What to do next

Create a project, which is used to organize the files associated with the adapter.

Creating a simple service with the adapter pattern wizard

Adapter patterns provide a quick and easy way of creating a simple service with
an adapter.

Before you begin

To use the WebSphere Adapter for Email pattern wizard, you must create a module
for the service.

About this task

The following adapter pattern is available for WebSphere Adapter for Email:
Table 4. Adapter pattern

Adapter pattern Description

Simple outbound email |The "create an outbound Email service to send mail" pattern

pattern creates a service that sends simple email messages using a mail
server.

In this example, create an outbound service that creates simple alert emails and
send them to a mail server for distribution.

Complete the following steps to create this service with the adapter pattern wizard.

Procedure

1. Right-click the module within the Business Integration section of the IBM
Integration Designer window and select New > External Service. The Select the
Service Type or Registry window opens.

Chapter 4. Configuring the module for deployment 49



2. Select Simple: Create an outbound e-mail service to send mail and click Next.

4= New External Service

Select the Service Type or Registry

Select the type of service to create or registry to browse,

Filter: | type filter text |

Available types:
=@ Adapters *~
BE] simple: Create an outbound e-mail service to send mail
[]] Enterprise Content Management
B8 TMS b
Description:

The Email pattern creates 3 service that sends simple messages using an e-mail server.

@

Figure 15. Select the Service Type or Registry window

3. In the E-mail service name window, change the name to something meaningful
such as EmailOutboundInterface and click Next.
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Figure 16. E-mail service name window

4. In the E-mail Server window, specify both the E-mail server host name and the
Port fields. For example, connecting to local host on port 25. Click Next.

5. In the E-mail server security credential window, select either No security,
Using an existing JAAS alias or Using user name and password and click
Next.
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Figure 17. E-mail server security credential window

Results

The outbound service is created, which includes the following artifacts:

Table 5. Artifacts for the outbound service

Artifact Name Description

Import EmailOutboundInterface The import exposes the
module internally, in this
case, to the mail server.

Interface EmailOutboundInterface This interface contains the
operation that can be started.

Operation createEmail createEmail is the only
operation in the interface.

Starting the external service wizard

To begin the process of creating and deploying a module, you start the external
service wizard in IBM Integration Designer. The wizard creates a project that is
used to organize the files associated with the module.

Before you begin

Make sure that you gather the information to establish a connection to the mail
server. For example, you need the name or IP address of the mail server and the
user ID and password to access it.
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About this task

Start the external service wizard to create a project for the adapter in IBM
Integration Designer. If you have an existing project, you can select it instead of
having the wizard create one.

To start the external service wizard and create a project, use the following
procedure.

Procedure

1. To start the external service wizard, go to the Business Integration perspective
of IBM Integration Designer, and then click File > New > External Service.

2. In the External service window, expand Adapters and select Email, which is
the type of adapter you want to create. Then click Next.

3. In the Select an Adapter window, select the adapter name to create a project, or
select an existing project to reuse it.

* To create a project, perform the following steps:

a. Select IBM WebSphere Adapter for Email (IBM : version), where version
is the version of the adapter you want to use and click Next.
b. In the Adapter Import window, provide details about the project you
want to create.
1) In the Connector project field, optionally specify a different name for
the project.
2) In the Target runtime field, select the server (for example, IBM
Business Process Manager).
3) Click Next.
* To select an existing project, select the project folder under IBM WebSphere

Adapter for Email (IBM : version), where version is the version of the
adapter you want to use and click Next.

Results

For a new project, the project is created and is listed in the Business Integration
perspective. The wizard creates the adapter artifacts in the specified project.

Configuring the module for outbound processing

To configure a module to use the adapter for outbound processing, use the external
service wizard in IBM Integration Designer to build business services, specify data
transformation processing, and generate the business object definitions and related
artifacts.

Configuring the module using the simple email data type

To configure a module for outbound processing using the simple email data type,
use the external service wizard in IBM Integration Designer to build business
services and generate business object definitions and related artifacts.

Setting deployment and runtime properties for simple email data
type

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
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the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

Before you begin

To perform this task, you must create a module. The module name is displayed in
the Project Explorer view of IBM Integration Designer.

About this task

To set connection properties, follow this procedure. For more information, see
[“Managed connection factory properties” on page 179)

Procedure

1. In the Select the Processing Direction window, select Outbound and click Next.
The Specify the Security and Configuration Properties window is displayed.

& New External Service

Select the Processing Direction 9_
Select the direction of adapter processing at run time., I;

) Inbound

Inbound processing passes data from the adapter to vour service export,

=

(%) Qutbound

QCutbound processing passes data from your service import to the adapter.

»

@ <Back_J[_text> ]

Figure 18. Choosing inbound or outbound in the external service wizard

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
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embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

3. Under the E-mail system connection information, type the Host name. The
properties in this window correspond to the managed connection factor
properties. For detailed information about these properties, see

[connection factory properties” on page 179

#= New External Service

Specify the Security and Configuration Properties —
s
Deploy connector project: with module for use by single application v | 3
Connection properties
E-mail system connection information
Host name: | localhost |
Port number: | 25 |
Protocol: smtp
Select when antivirus or firewall software is running
Service properties
How do you want to specify the security credentials?
(") Using an existing JAAS slias (recommended)
{#) Using security properties from the managed connection factory
The properties will be stored as plain text; no encryption is used.
User name: | username |
Password: | R |
() Other ]
Data format options: Spedfy a data format for each operation w
b/
<
@) ’ < Back ” Mext = l

Figure 19. Security and configuration properties window

4. Type the Port number. The default value for the SMTP protocol is 25. If your
SMTP mail server is listening on a different port number, change this value.

Chapter 4. Configuring the module for deployment 55



56

5. Clear the Select when antivirus or firewall software is running check box if
you do not want the adapter to close the managed connection after each
outbound request. If an antivirus program or firewall is running on your
system (the machine on which the adapter is deployed or the one that hosts the
mail server) and this check box is cleared, the adapter might fail to send
outbound emails. Leaving this check box selected is recommended.

6. Optional: Click Advanced and expand the Additional properties, Logging and
tracing , or Bidi properties sections as needed.
* Additional properties
a. Select Enable transport security (SSL) check box to specify if secure

socket layers are enabled for outbound communication. For more
information, see |"Secure connection (SSL) (enableSSL)” on page 185.|

b. In the Alternate e-mail ID in case of delivery failure field, specify an
alternate email address to receive undeliverable mail notifications. This
email address can be a different email address than the one you specified
in the From email address. For more details about this property, see
[“Alternate email ID in case of delivery failure” on page 183)

c. In the Maximum retries in case of system connection failure field, type
the number of times the adapter tries the connection before reporting a
polling error. For more information, see [“Maximum retries on connection|
[failure (connectionRetryLimit)” on page 183)

d. In the Connection retry interval (in milliseconds) field, specify the time
interval between the attempts to reconnect to the mail server if the
connection fails. For more information, see [‘Retry interval if connection|
[fails (in milliseconds) entities” on page 182.

* Logging and tracing
a. If you have multiple instances of the adapter, expand Logging and
tracing and enter a value in the Adapter ID field that is unique for this
instance. For more information about this property, see [Resource adapter]
[properties” on page 186

b. If you want to mask certain information so that the information is not
displayed in the logs or traces, select Disguise user data as "XXX" in log
and trace files. For more information, see |[“Disguise user data as "XXX" in|
llog and trace files (HideConfidentialTrace) ” on page 182

* Bidi properties
a. Select the Bidi transformation check box to specify bidirectional format.
For more information about setting the Bidi properties, refer to the
[“Globalization” on page 212| section.

7. In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

e To use a ]J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the managed connection specification,
click Using security properties from the managed connection factory and
enter the following information:

— In the User name field, type the user name for the mail server.

— In the Password field, type the password for the mail server.
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Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. During outbound communication, you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the emails.

* To administer the user name and password from another mechanism, click
Other.

8. Optional: Select the Change logging properties for wizard check box, if you
want to define the level of logging for this module.

9. For Data format, select Specify a data binding for each operation. Although
the default value is Use a data binding configuration for all operations, select
Specify a data binding for each operation, because the adapter has a different
data binding for each supported business object. These data bindings have
different properties, and are configured differently.

Important: Do not click Next in this window until you complete the steps to
create a data binding or browse for an existing one.

What to do next

Select the data type and operation name.

Selecting a data type and operation name

Use the external service wizard to select a data type and name the operation
associated with this data type. For outbound communication, the external service
wizard gives you the choice of four different data types: simple email, generic
email, generic email with business graph, and user-defined type. Each data type
corresponds to a business object structure.

Before you begin

You must have specified the connection properties for the adapter to connect to the
mail server before you can specify the operation and data type for the module.

About this task

To select a data type and name the operation associated with it, follow this
procedure.

Procedure
1. In the Add, Edit, or Remove Operations window, click Add to create an
operation.

2. In the Specify the I/O Properties window, select the simple e-mail from The
data type for the input operation list and click Next. For more information
about data types and the types of emails they create, see the
[structures section| in this documentation.

Note: You can select the Enable response on delivery check box to configure
the outbound response from the mail server.

3. In the Specify the I/O Properties window, type an Operation name.
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& Add Operation

Specify the 1/ 0 Properties

Operation name: = | sendSimpleAlertEmail |

Specify the Operation Input

Data format options: |Use suggested data format ‘EmailSimpleDataBinding' |W |

Specify the Operation Qutput

Data format options: |Use suggested data format EmailSimpleDataBinding' |+ |

® ext Firiish ] [ Cancel

Figure 20. Naming the operation

Type a meaningful name for the operation, for example, sendSimpleAlertEmail.
For more information about the types of operations the adapter can perform,
see the topic on Supported Operations in this documentation.

Note: Names cannot contain spaces.

4. The external service wizard defaults to the correct data binding,
EmailSimpleDataBinding.

5. C(Click Finish.
Results

A data type is defined for the module and the operation associated with this data
type is named.

What to do next

Specify interaction specification properties and generate artifacts for the module.

Setting interaction specification properties and generating the
service

Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level
business object.

Before you begin

To set interaction specification properties and generate artifacts for your module,
you must have specified the data type and operation name.
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About this task

Interaction specification properties do not take precedence over request business
object attributes, except for the user name and password properties. User name
and password values specified in the interaction specification properties take
precedence over values set in the managed connection factory properties. To set
interaction specification properties and generate artifacts, follow this procedure.
For more information, see |”Interaction specification properties” on page 188.|

Procedure
1. Optional: To set interaction specification properties, complete these steps:
a. Click Advanced.

#= New External Service

Add, Edit, or Remove Operations r—M
The adapter will use these operations to access native functions. fﬁg

Qperations:
sendSimplealertEmail ({http: /i ibm.comxmins jprod fwebsphere fi2ca femail fsimplealer temail }Sim| | Add. ..

Remove

4

IE%

Operation Properties
InteractionSpec Properties for ‘sendSimpleAlertEmail’

Additional properties

From:

Reply to:

To:

Cc:

E-mail subject:

User name:

Password:

|
|
|
|
Bee: |
|
|
|
|

Encoding: [Select. " ]

@ (o oo

Figure 21. Setting interaction specification properties

b. Type values for any fields you want to set as defaults.
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c. Optional: In the EnvelopeForm field, type an email address to receive
undeliverable mail notifications on a different email address than the Form

email address. For more details about this property, see
kpecification properties” on page 188

d. Click Next.

2. In the Specify the Name and Location window, select the Module from the list.
For example, Outbound for outbound processing.

3. Optional: Name the Folder to store the artifacts.

4. Type a Name for the interface. This name displays in the IBM Integration
Designer assembly diagram.

5. Optional: Type a Description.

6. Click Finish. The interface is displayed in IBM Integration Designer assembly
diagram.

9& Outbound - Assembly Diagram 23 (2] Customer
4 oFPalette

[:3 'I'E'\ 'El" %, &)

(= Favorites @ @ QutboundInterface E

= Components

U’,Ji., Untyped Component

42 Human Task

Uﬂ Java

T, Mediation Flow

ﬁ" Process

Es Rule Group

S state Machine

(B Impart
%] Export

References

Figure 22. Interface in IBM Integration Designer

The business object you created is also displayed in a different tab.
Results
IBM Integration Designer generates the artifacts and an import. The outbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.

Configuring the module using the generic email data type

To configure a module for outbound processing using the generic email data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.
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Setting deployment and runtime properties for generic email data
type

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.

Before you begin

To perform this task, you must create a module. The module name appears in the
Project Explorer view of IBM Integration Designer.

About this task

To set connection properties, follow this procedure. For more information, see
[“Managed connection factory properties” on page 179)

Procedure

1. In the Select the Processing Direction window, select Outbound and click Next.
The Specify the Security and Configuration Properties window is displayed.

& New External Service

Select the Processing Direction 97
Select the direction of adapter processing at run time., ;

) Inbound

Inbound processing passes data from the adapter to vour service export,

=

(*) Outbound

Qutbound processing passes data from your service impart to the adapter,

>

@ <BakJ_next> ]

Figure 23. Choosing inbound or outbound in the external service wizard
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2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

¢ On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

3. Under the E-mail system connection information, type the Host name. The
properties in this window correspond to the managed connection factor
properties. For detailed information about these properties, see

[connection factory properties” on page 179
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#= New External Service

Specify the Security and Configuration Properties —
s
Deploy connector project: with module for use by single application v | 3
Connection properties
E-mail system connection information
Host name: | localhost |
Port number: | 25 |
Protocol: smtp
Select when antivirus or firewall software is running
Service properties
How do you want to specify the security credentials?
(") Using an existing JAAS slias (recommended)
{#) Using security properties from the managed connection factory
The properties will be stored as plain text; no encryption is used.
User name: | username |
Password: | ”””””””” |
() Other ]
Data format options: Spedfy a data format for each operation w
b/
<
@) ’ < Back ” Mext = l

Figure 24. Security and configuration properties window

4

5.

. Type the Port number. The default value for the SMTP protocol is 25. If your
SMTP mail server is listening on a different port number, change this value.

Clear the Select when antivirus or firewall software is running check box if
you do not want the adapter to close the managed connection after each
outbound request. If an antivirus program or firewall is running on your
system (the machine on which the adapter is deployed or the one that hosts the
mail server) and this check box is cleared, the adapter might fail to send
outbound emails. Leaving this check box selected is recommended.

Optional: Click Advanced and expand the Additional properties, Logging and
tracing , or Bidi properties sections as needed.
* Additional configuration
a. Select Enable transport security (SSL) check box to specify if secure
socket layers are enabled for outbound communication. For more
information, see I"Secure connection (SSL) (enableSSL)” on page 185.|

b. In the Alternate e-mail ID in case of delivery failure field, specify an
alternate email address to receive undeliverable mail notifications. This
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email address can be a different email address than the one you specified
in the From email address. For more details about this property, see
[“Alternate email ID in case of delivery failure” on page 183)

c. In the Maximum retries in case of system connection failure field, type
the number of times the adapter tries the connection before reporting a
polling error. For more information, see |”Maximum retries on connection|
[failure (connectionRetryLimit)” on page 183]

d. In the Connection retry interval (in milliseconds) field, specify the time
interval between the attempts to reconnect to the mail server if the
connection fails. For more information, see [‘Retry interval if connection|
lfails (in milliseconds) entities” on page 182,

* Logging and tracing
a. If you have multiple instances of the adapter, expand Logging and
tracing and enter a value in the Adapter ID field that is unique for this
instance. For more information about this property, see [Resource adapter]
[properties” on page 186

b. If you want to mask certain information so that the information is not
displayed in the logs or traces, select Disguise user data as "XXX" in log
and trace files. For more information, see|“Disguise user data as "XXX" in|
llog and trace files (HideConfidentialTrace) ” on page 182)

* Bidi properties
a. Select the Bidi transformation check box to specify bidirectional format.

For more information about setting the Bidi properties, refer to the
[“Globalization” on page 212| section.

7. In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

* To use a J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the managed connection specification,
click Using security properties from the managed connection factory enter
the following information:

— In the User name field, type the user name for the mail server.

— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. During outbound communication, you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the emails.

* To administer the user name and password from another mechanism, click
Other.

8. Optional: Select the Change logging properties for wizard check box, if you
want to define the level of logging for this module.

9. For Data format, select Specify a data binding for each operation. Although
the default value is Use a data binding configuration for all operations, select
Specify a data binding for each operation, because the adapter has a different
data binding for each supported business object. These data bindings have
different properties, and are configured differently.

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



Important: Do not click Next in this window until you complete the steps to
create a data binding or browse for an existing one.

What to do next

Select the data type and operation name.

Selecting a data type and operation name

Use the external service wizard to select a data type and name the operation
associated with this data type. For outbound communication, the external service
wizard gives you the choice of four different data types: simple email, generic
email, generic email with business graph, and user-defined type. Each data type
corresponds to a business object structure.

Before you begin

You must specify the connection properties for the adapter to connect to the mail
server. You have chosen to specify a data binding for each operation.

About this task

To select a data type and name the operation associated with it, follow this
procedure.

Procedure
1. In the Add, Edit, or Remove Operations window, click Add to create an
operation.

2. In the Specify the I/O Properties window, select a data type from The data
type for the input operation list. The Generic e-mail business object and
Generic e-mail business object with business graph are the available generic
email data types. Click Next. For more information about data types and the
types of emails they create, see the [business object structures section| in this
documentation.

Note: You can select the Enable response on delivery check box to configure
the outbound response from the mail server.

3. In the Specify the I/O Properties window, type an Operation name.
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# Add Operation

Specify the 1/ 0 Properties

Operation name: = | sendEmailBG |

Specify the Operation Input
Data format: = Mot defined

Specify the Operation Output
Data format: = Mot defined

Figure 25. Naming the operation

Type a meaningful name for the operation. To use this module to create and
send e-mails constructed using information supplied in customer business
objects, name it something like sendEmailBG. For more information about the
types of operations the adapter can perform, see the topic on Supported
Operations in this documentation.

Note: Names cannot contain spaces.
Results

A data type is defined for the module and the operation associated with this data
type is named.

What to do next

Browse for or create a data binding for the module.

Configuring the data binding

Data bindings read the fields in a business object and fill the corresponding fields
in an email. In the external service wizard, you add a data binding to your module
and configure it to correspond with your data type. This way, the adapter knows
how to populate the fields in an email with information it receives in the business
object.

Before you begin

You must enter service configuration properties for the connection to the mail
server. You have defined the data type for the module and named the operation
associated with this data type. You have chosen to specify a data binding for each
operation.
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About this task

To browse for or create a data binding for the module, follow this procedure.

Note: You can configure the data bindings before running the external service
wizard using IBM Integration Designer. To configure the data bindings, select New
> Configure Binding Resource in IBM Integration Designer and complete the data
binding windows described in this documentation.

Procedure

1. In the Specify the I/O Properties window, click Select next to the Data format
field.

2. In the Select a Data Format Transformation window, select the Use existing
data format transformation from the list option. From the list, select
EmailWrapperDataBinding. To configure a custom data binding, select the
Select your custom data format transformation from the workspace option.
Click Next.

& Data Binding Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To uze your own custom data L
transformation, select the second radio button to add your custom transformation, —

() Use existing data format transformation from the list

@ EmailWWrapperDataBinding

[15haw the deprecated data format transformations

Description:

This Data Binding handles the transformations that are required for the Email adapter

@

[ MNext = H Finish H Cancel

Figure 26. Selecting the data binding

3. In Specify the Data Transformation Properties window, click Next.
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Note: This window is used for configuring the data handlers.

4. In Configure a New Data Transformation window, provide the data binding
configuration details.

a. In the Configure a New Data Transformation window, the Module defaults
to the module name you typed earlier in the wizard. To use a different
module that you want to create a data binding for, select New to create a
module.

& Data Binding Configuration

Configure a New Data Transformation

Create a data transformation configuration. |

Module or library:

Mamespace: http: {{EmailMadule femail Default
Folder: email
Mame: DataBindingConfiguration

Description:

@j Finish ] [ Cancel

Figure 27. Naming the data binding configuration

b. If you want to select a new folder for the artifact, click Browse and select a
new folder location. If you do not browse for a new folder location, the
artifacts are created in the root directory for the module.

c. Type a Name for the data binding configuration and click Finish.
Results
A data binding is configured for use with the module.
What to do next

Specify data binding properties.

Configuring business object properties and data handlers

When you intend to use a data type that contains business objects, you must
specify properties for those business objects. Completing this step does not add
child business objects to the email parent object. Rather, it tells the adapter how to
process particular types of business objects. Data handlers perform the conversions
between a business object and a particular MIME format.
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Before you begin

You must create a data binding before specifying business object properties and
data handlers for the module. Also, you must predefine business objects using IBM
Integration Designer Business Object Editor. If you stop the wizard here to create
business objects, you must start the wizard steps from the beginning and your
work is not saved.

Note: Data handlers can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data handler
windows described in this documentation.

About this task
To specify business object properties and data handlers, follow this procedure.

Note: For operations that do not require data transformation (pass-through
operations), you do not need to fill out this window. Click Finish and complete the
data binding configuration wizard.

Procedure

1. In Specify the Data Transformation Properties window, click Add to add
business object types to the data binding description.

2. In the Add/Edit properties window, ensure that DataHandler is selected in
the Binding type field.

3. In the Business object type field, click Browse for existing business objects or
New to create a business object. These business objects must be imported to
IBM Integration Designer before you start the external service wizard.
Selecting business objects here does not physically add child business objects.
Adding business objects at this stage in the wizard tells the adapter that you
are going to use certain business object types with your module. It enables the
adapter to know what data binding to apply to any child business objects it
processes.
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& Add/Edit

Add/ Edit properties
ﬂ Data handler configuration: cannot be empty.

Binding type: | Datatandler v|

Busnessobject type: = | Whiaddress {nttp://Gener| [Browse. .. | [rew... |
Mime type: = | |

Encoding: [uTFa | select... |

Data handler configuration: = Mot defined

@

Figure 28. Adding or editing business object data binding properties

Note: The encoding specified for configuring the XML data handler for mime
type (text/xml) must have the same value that is specified for Encoding in the
EmailWrapperDataBinding properties.

4. If you selected Browse for the Business object type field, select a data type
from the Data Type Selection window and click OK.

5. If you selected New for the Business object type field, complete the following

steps.
&= New Business Object \._\@|E|
Create a Business Object ™
Business objects are containers for application data that represent business functions or elements, such as 3
customer or an invoice,

Moduie o library: | Outbound v|[ Bowse.. | [ new.. |
Namespace: [http:ffCutbound | [l Defauit

Folder: \ | Browse.. |

Name: | customer |

Inherit from: ‘<none> |[ Browse... ] [ New... ] [Clear]

Business objects, by default, are created as global complex types. However, some integration scenarios might
require a global element, Mare...

[l create the business object as an element

@ < Bad [ MNext > H Finish ] [ Cancel

Figure 29. Specifying business object properties for the module
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a. Select the Module from the list. If the correct module is not shown,
Browse for it or click New to create a module.

b. Optional: Type a Folder name or Browse for the folder on your local drive
where business object schema files (XSD files) generated by the external
service wizard are stored.

c. Type a Name for the business object.

d. If you do not want to populate the business object with fields from one or
more existing business objects, click Finish.

e. If you want to populate the business object with fields from one or more
existing business objects, click Next.

4= New Business Object

Derived Business Object

Available business objects:

Populate the new business object with fields frorr%e or more existing business objects.

Fields to indude:

[ Clemail

[l [ClHeader

.| [ElMailattachment

O [l unstructuredContent
L] ) Whiaddress

| C]‘u‘}hiphone

|

ww.ibm. com fxn
{fowars.ibm.comfxn
i ibm. com fxn|
ibm. com,fxn
aw.ibm, com/xn
v.ibm. com fxn,

|

Mame Type

ext [ Finish ‘] [ Cancel

Figure 30. Deriving business object fields from an existing business object

f. Select the correct business object and click Finish. The Business object type
in the Add/Edit properties window is populated.

6. In the Add/Edit properties window, select a Mime type such as text/xml or
text/html for your business object. The mime type corresponds to the data
handler that is used by the adapter to perform data transformation from one
format to another. This step enables the adapter to decide which format it
must convert the content to when it encounters the business object.

7. In the Encoding field, click Select if you want to choose a different encoding

value.

8. In the Data handler configuration field, click Select. Complete the following
steps to create and configure a data handler.

a. In the Select a Data Format Transformation window, click Use existing
data format transformation from the list option. Select XML data handler
from the list and click Next.
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& Data Handler Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To use your own custom data L
transformation, select the second radio button to add your custom transformation, i

() Use existing data format transformation from the list

[ pelimited

[ Fived width

@ Handled by WTX

%. Handled by WTX Invoker
2 1s0n

= 0N

[]5haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

0n inbound, parses XML data into & business object. On outbound, serializes business object to XML data

\

Figure 31. Selecting the data handler configuration type

Note: The Select your custom data format transformation from the
workspace option is available for advanced users who want to use a
custom data handler. A custom data handler placed in the class path,
shows when this option is selected.

9. In the Specify the Data Transformation Properties window, select the
Encoding value, and click Next. This value indicates the type of character
encoding the adapter uses during data transformation. For more information

about the encoding property, see|“Email business object properties” on page]
-162.

10. In the Configure a New Data Transformation window, select the Module from
the list. If the correct module is not appearing, click New to create a new one.

a. Optional: Type a Folder name to specify a folder for the artifacts.

b. Leave the default data handler Name or type a new one and click Next.
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& Data Handler Configuration

Configure a New Data Transformation

Create a data transformation configuration.

Moduleorlibrary:lOuﬂ:nund VH Browse. .. ] [ Mew. .. ]
Namespace: [ttp: /Outbound | [F]Defauit

Folder: | || sromse... |

Mame: | DataHandlerConfiguration |

Description:

® ext Finish

] [ Cancel

Figure 32. Creating a data handler

c. Click Finish.

11. In the Add/Edit Properties window, click Finish.
12. Optional: If you want to add another business object type to the module, click

Add in the Specify the Data Transformation Properties window. Repeat the

steps in this topic to specify business object properties and a data handler for

each business object.

Results

Business object properties and their data handlers are created.

What to do next

Set interaction specification properties and generate artifacts for your module.

Setting interaction specification properties and generating the

service

Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level

business object.
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Before you begin

To set interaction specification properties and generate artifacts for your module,
you must configure data bindings and selected business objects.

About this task

Interaction specification properties do not take precedence over request business
object attributes, except for the user name and password properties. User name
and password values specified in the interaction specification properties take more
precedence over values set in the managed connection factory properties. To set
interaction specification properties and generate artifacts, follow this procedure.
For more information, see [“Interaction specification properties” on page 188

Procedure
1. Optional: To set interaction specification properties complete these steps:
a. Click Advanced.
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& New External Service

Add, Edit, or Remove Operations )

The adapter will use these aperations to access native functions.

Operations:

3 sendEmailBG (http: /S, ibm, com fxmins fprod fwebsphere f2ca/email femailbg  EmaiBG) @ http:; dd

Edit...

iy *

Remawve

45

|»

Operation Properties
InteractionSpec Properties for 'sendEmailBG'

Additional properties

From:

Reply to:

To:

&=

E-mail subject:

User name:

Password:

|
|
|
|
Ber: |
|
|
|
|

Encoding: [Select. . ]

@ « Back ][ Mext =

Figure 33. Setting interaction specification properties

b. Type values for any fields you want to set as defaults.
c. Click Next.

2. In the Specify the Name and Location window, select the Module from the list.
For example, EmailModule for outbound processing.
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#= New External Service

Specify the Name and Location

ol
Specify the name and location of the new service and its interface.
Properties for Service
Module: | Lser w |
Use the default namespace
Folder: | | [Bro'a'-.'se... ]

Mame: >=U| OutboundInterface |

[]save business objects to a library

Description: |

® axt > Finish H Cancel

Figure 34. Naming the artifact

3. Optional: Name the Folder that is used to store the artifacts.

4. Type a Name for the interface. This name appears in the IBM Integration
Designer assembly diagram.

5. Optional: Type a Description.

6. Click Finish. The interface is displayed in IBM Integration Designer assembly
diagram.
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Figure 35. Interface in IBM Integration Designer

The business object you created is also displayed in a different tab.

Results

IBM Integration Designer generates the artifacts and an import. The outbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.

Configuring the module using the user-defined data type

To configure a module for outbound processing using the user-defined data type,
use the external service wizard in IBM Integration Designer to build business
services, specify data transformation processing, and generate business object
definitions and related artifacts.

About this task

You can create a custom data type and specify the required mail content and
attachment business object information for the data type. To do this configuration,
you need to create an inbound module with the user-defined data type using the
EmailFixedStructureDataBinding data binding.

Setting deployment and runtime properties for user-defined data
type

To select and configure your module for outbound or inbound communication
with the mail server, you specify the configuration properties using the external
service wizard in IBM Integration Designer. Then, configure the managed
connection factory properties. Managed connection factory properties are stored in
the business object and contain the information the adapter needs to make the
connection between the outbound module and the mail server.
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Before you begin

To perform this task, you must create a module. The module name is displayed in
the Project Explorer view of IBM Integration Designer.

About this task

To set connection properties, follow this procedure. For more information, see
[“Managed connection factory properties” on page 179)

Procedure

1. In the Select the Processing Direction window, select Outbound and click Next.
The Specify the Security and Configuration Properties window is displayed.

&~ New External Service

Select the Processing Direction 9—
Select the direction of adapter processing at run time., ;
) Inbound

Inbound processing passes data from the adapter to your service export.

=

{*) Outbound
Qutbound processing passes data from your service impart to the adapter,

>

@ <Bak_text> ]

Figure 36. Selecting inbound or outbound in the external service wizard

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.
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* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.

3. Under the E-mail system connection information, type the Host name. The
properties on this window correspond to the managed connection factor
properties. For detailed information about these properties, see

[connection factory properties” on page 179/

#= New External Service

Specify the Security and Configuration Properties —
s
Deploy connector project: with module for use by single application v | 3
Connection properties
E-mail system connection information
Host name: | localhost |
Port number: | 25 |
Protocol: smtp
Select when antivirus or firewall software is running
Service properties
How do you want to specify the security credentials?
(") Using an existing JAAS slias (recommended)
{#) Using security properties from the managed connection factory
The properties will be stored as plain text; no encryption is used.
User name: | username |
Password: | R |
() Other ]
Data format options: Spedfy a data format for each operation w
b/
<
@) ’ < Back ” Mext = l

Figure 37. Security and configuration properties window

4. Type the Port number. The default value for the SMTP protocol is 25. If your
SMTP mail server is listening on a different port number, change this value.

5. Clear the Select when antivirus or firewall software is running check box if
you do not want the adapter to close the managed connection after each
outbound request. If an antivirus program or firewall is running on your
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system (the machine on which the adapter is deployed or the one that hosts the
mail server) and this check box is cleared, the adapter might fail to send
outbound emails. Leaving this check box selected is recommended.

6. Optional: Click Advanced and expand the Additional properties, Logging and
tracing , or Bidi properties sections as needed.
* Additional configuration

a. Select Enable transport security (SSL) check box to specify if secure
socket layers are enabled for outbound communication. For more
information, see [“Secure connection (SSL) (enableSSL)” on page 185|

b. In the Alternate e-mail ID in case of delivery failure field, specify an
alternate email address to receive undeliverable mail notifications. This
email address can be a different email address than the one you specified
in the From email address. For more details about this property, see
[“Alternate email ID in case of delivery failure” on page 183

c. In the Maximum retries in case of system connection failure field, type
the number of times the adapter tries the connection before reporting a
polling error. For more information, see [“Maximum retries on connection|
[failure (connectionRetryLimit)” on page 183

d. In the Connection retry interval (in milliseconds) field, specify the time
interval between the attempts to reconnect to the mail server if the
connection fails. For more information, see [‘Retry interval if connection|
[fails (in milliseconds) entities” on page 182.

* Logging and tracing
a. If you have multiple instances of the adapter, expand Logging and
tracing and enter a value in the Adapter ID field that is unique for this
instance. For more information about this property, see [Resource adapter]
[properties” on page 186

b. If you want to mask certain information so that the information is not
displayed in the logs or traces, select Disguise user data as "XXX" in log
and trace files. For more information, see[“Disguise user data as "XXX" in|
[log and trace files (HideConfidentialTrace) ” on page 182

* Bidi properties
a. Select the Bidi transformation check box to specify bidirectional format.
For more information about setting the Bidi properties, see
[“Globalization” on page 212

7. In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

* To use a J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the managed connection specification,
click Using security properties from the managed connection factory enter
the following information:

— In the User name field, type the user name for the mail server.
— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If

you are using an authentication alias, a user name and password are not
necessary. Also, for outbound communication you do not need to enter a

IBM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide



user name and password because a mail server uses an anonymous user
name and password to send the emails.

* To administer the user name and password from another mechanism, click
Other.

8. Optional: Select the Change logging properties for wizard check box, if you
want to define the level of logging for this module.

9. For Data format, select Specify a data binding for each operation. Although
the default value is Use a data binding configuration for all operations, select
Specify a data binding for each operation, because the adapter has a different
data binding for each supported business object. These data bindings have
different properties, and are configured differently.

Important: Do not click Next in this window until you complete the steps to
create a data binding or browse for an existing one.

What to do next

Select the data type and operation name.

Selecting a data type and operation name

Use the external service wizard to select a data type and name the operation
associated with this data type. For outbound communication, the external service
wizard gives you the choice of four different data types: simple email, generic
email, generic email with business graph, and user-defined type. Each data type
corresponds to a business object structure. Use the user-defined data type if you
want to configure your own business object wrapper instead of using the generic
email business object.

Before you begin

You must specify the connection properties for the adapter to connect to the mail
server. You have chosen to specify a data binding for each operation.

About this task

To select the user-defined data type, name the operation associated with it, create a
wrapper business object, and specify child business objects, follow this procedure.

Procedure
1. In the Add, Edit, or Remove Operations window, click Add to create an
operation.

2. In the Specify the 1/O Properties window, select the User defined email
business object from The data type for the input operation list and click Next.
For more information about data types and the types of emails they create, see
the business object structures section| in this documentation.

Note: You can select the Enable response on delivery check box to configure
the outbound response from the mail server.

3. In the Specify the I/O Properties window, type an Operation name.
4. Click New for the Input type.
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& Add Operation

Specify the 1/ 0 Properties

Operation name: = | send |

Specify the Operation Input

Input type: = | | [Bro'.\'se... ] [Ne‘.\'... l

Data format: = Mot defined

Specify the Operation Output

| |
Data format: = Mot defined

@

Figure 38. Selecting the input type

5. In Specify the Location window, provide the module name and the name of the
folder where the wrapper business object (the input type) is to be generated.
Click Next.

6. In Specify the Properties window, provide the wrapper Business object name.
a. Optional: Select the Generate a business graph for the business object

check box.

b. Specify the properties for the email type. Click Add to add child business
objects to the table.

You can generate the wrapper business object and specify the child business
objects that are used inside the wrapper business object and specify which
parts of the email you want to use (such as mailContent or attachment1).
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% New Business Object From External Data

Specify the Properties Q\ :

Business object name: = | WhiAddress\Wrapper |

Business object namespace: | ht'q:-:,f',-'";-.";-.";-.'.il:-m.com,-"xrnlns,f'prc-d,-'";-.'ebsphe|

[JGenerate a business graph for the business object
Properties for e-mail type:

E-mail part Business abject type Default attz| | Add...

@ ext I Finish H Cancel ]

Figure 39. Specify the properties for the new business object

In the Add/Edit Properties window, select either the mailContent or the
Attachmentl as the email part. If you select the attachmentl part of the email,
then you can also specify the default attachment name that is used with this
business object.

Note: You can have a wrapper business object without having a mailContent
business object, for example, if you are not sending any content in the email or
if the email polled by the adapter does not have any content.

7. When you finish adding child business objects to the table, click Finish. For
each business object you add, a row is created in the table. The following figure
shows the generated wrapper business object.
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Ci WhisddressWirapper 23 \

vBusiness object £ T & =

(") ‘whiaddressiwrapper & [C) Header

— =[] Whiaddress
& To string [
[€] From string = (2] Whiphone [€] Addressid integer
[Elcc string m' [e] Addriine1 string
[€lBcC string [8] Phonenumber string [] Addrins2 string
[€] Reply-To string [€] Phonetype  string [€] Customerdity skring
[€] subject string L >
[€] Enceding string .~
[e] Date shring
[€] HeaderList Header [ ]
[€] mailContent ‘Whiaddress
[€] attachment1 ‘whiphone

[€] attachmentiMame string

Figure 40. The generated wrapper business object

8. In the Specify the Properties window, click Finish.
Results

A data type is defined for the module and the operation associated with this data
type is named. A wrapper business object is created, and the child business objects
that are used inside the wrapper business object are specified.

What to do next

Generate the data binding configuration for the module.

Configuring the data binding

Data bindings read the fields in a business object and fill the corresponding fields
in an email. In the external service wizard, you add a data binding to your module
and configure it to correspond with your data type. This way, the adapter knows
how to populate the fields in an email with information it receives in the business
object.

Before you begin

You must enter service configuration properties for the connection to the mail
server. You have defined the data type for the module and named the operation
associated with this data type. You have chosen to specify a data binding for each
operation.

About this task

To browse for or create a data binding for the module, follow this procedure.

Note: The user-defined data type can only be used in a data transformation (non
pass-through) mode. You cannot use the unstructured content business object.
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Note: Data bindings can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data binding
windows described in this documentation.

Procedure

1. In the Specify the I/O Properties window, click Select next to the Data format
field.

2. In the Select a Data Format Transformation window, select the Use existing
data format transformation from the list option. From the list, select
EmailFixedStructuredDataBinding. To configure a custom data binding, select
the Select your custom data format transformation from the workspace
option. A custom data binding, placed in the class path, shows when this
option is selected. Click Next.

# Data Binding Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To uze your own custom data L
transformation, select the second radio button to add your custom transformation, —ml

() Use existing data format transformation from the list

& EmailFivedStructuredDataBinding

%- EmailSimpleDataBinding

@ EmailwrapperDataBinding

[15haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

This Data Binding handles the transformations that are required for the Email adapter

:

Figure 41. Selecting the data binding

Note: When you configure the EmailFixedStructuredDataBinding, you create a
custom data type with the required mail content and the attachment business
objects.

3. In Specify the Data Transformation Properties window, click Next.
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Note: This window is used for configuring the data handlers.

4. In Configure a New Data Transformation window, provide the data binding
configuration details.
a. In the Configure a New Data Transformation window, the Module defaults

to the module name you typed earlier in the wizard. If you do not want to
create a data binding for this module, select New to create a module.

& Data Binding Configuration

Configure a New Data Transformation

Create a dats transformation configuration. |

Module or library:

Mamespace: http: fEmailMadule femail Default
Folder: email
Mame: DataBindingConfiguration

Description:

@j Finish ] [ Cancel

Figure 42. Naming the data binding configuration

b. If you want to select a new folder for the artifact, click Browse and select a
new folder location. If you do not browse for a new folder location, the
artifacts are created in the root directory for the module.

c. Type a Name for the data binding configuration and click Finish.
Results
A data binding is configured for use with the module.
What to do next

Configure business object properties and data handlers.

Configuring business object properties and data handlers

When you intend to use a data type that contains business objects, you must
specify properties for those business objects. Completing this step does not add
child business objects to the email parent object. Rather, it tells the adapter how to
process particular types of business objects. Data handlers perform the conversions
between a business object and a particular MIME format.
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Before you begin

You must create a data binding before specifying business object properties and
data handlers for the module. Also, you must predefine business objects using IBM
Integration Designer Business Object Editor. If you stop the wizard here to create
business objects, you must start the wizard steps from the beginning and your
work is not saved.

Note: Data handlers can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data handler
windows described in this documentation.

About this task

To specify business object properties and data handlers, follow this procedure.

Procedure

1. In Specify the Data Transformation Properties window, select a row and click
Edit.

Note: For the user-defined type, the following warning message displays if you
click Add in this window. The User cannot add new row to the table. Adapter
has parsed your Input type and filled the table. This warning appears because
the adapter determines which business objects the data binding must know
about and pre-filled the table. To provide values for the rest of the properties,
select individual rows and click Edit.

Important: If you are repeating these steps to configure a child data binding
for the user-defined data type, you cannot select between data handler and
data binding when you click Edit. The binding type option (to select between
data binding and data handler) does not function correctly for the
EmailFixedStructuredDataBinding. To configure a child data binding for
EmailFixedStructuredDataBinding, click the Binding type field and select
DataBinding.

2. In the Add/Edit properties window, ensure that DataHandler is selected in the
Binding type field.

3. In the Business object type field, click Browse for existing business objects or
New to create a business object. Selecting business objects here does not
physically add child business objects. Adding business objects at this stage in
the wizard tells the adapter that you are going to use certain business object
types with your module. It enables the adapter to know what data binding to
apply to any child business objects it processes.

a. If you selected Browse for the Business object type field, select a data type
from the Data type selection window and click OK.

b. If you selected New for the Business object type field, complete the
following steps.
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& New Business Object E\@|E|

Create a Business Object =]
Business objects are containers for application data that represent business functions or elements, such as a
customer or an invaice,
Module ar library: ’Outhound w | [ Browse... ] [ MNew... ]
MNamespace: lhttp:_."_fr,)uihnund | Default
Folder: ‘ | [ Browse... J
Mame: ‘ Customer |
Inherit from: [ <nong> l [ Browse... ] [ MNew... ] [Clear ]

Business objects, by default, are created as alobal complex types. However, some integration scenarios might
require a global element, Mare...

[ create the business ohject as an element

@ . Back [ MNext = ]l‘ Finish ][ Cancel J

Figure 43. Specifying business object properties for the module

c. Select the Module. If the correct module is not shown, Browse for it or click
New to create a module.

d. Optional: Type a Folder name or Browse for the folder on your local drive
where business object schema files (XSD files) generated by the external
service wizard are stored.

e. Type a Name for the business object.

f. If you do not want to populate the business object with fields from one or
more existing business objects, click Finish.

g. If you want to populate the business object with fields from one or more
existing business objects, click Next.
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4= New Business Object

Derived Business Object

Populate the new business object with fields frorr%we or more existing business objects.
Available business objects: Fields to include:

1 [ZJ Email http: /fveww.ibm.comfxn| | Mame Type

[l [Cl Header wwe.ibm. comfxn
| [CIMailattachment w.ibm.comfxn
L] [Zl UnstructuredContent w.ibm.com,fxn
[ £ wbiaddress s b, com fxn
4| [ Whiphone http: ffweww.ibm. comxn

3
|

@ ext [ Finish .H Cancel

Figure 44. Deriving business object fields from an existing business object

h. Select the correct business object and click Finish. The Business object type
in the Add/Edit properties window is populated.

4. In the Add/Edit properties window, select a Mime type such as text/xml or
text/html for your business object. The mime type corresponds to the data
handler that is used by the adapter to perform data transformation from one
format to another. This step enables the adapter to decide which format it must
convert the content to when it encounters the business object.

# Add/Edit =3
Add/ Edit properties
ﬂ Data handler configuration: cannot be empty.

Binding type: |Datariandler v
| |
Business ohject type: = | {http:/fCustomer}address | | Brouse... | [New... |
Mime type: = | v
Encoding: [uTF8 | [ select... |

Data handler configuration:= Mot defined

Q

Figure 45. Adding or editing business object data binding properties
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Note: The encoding specified for configuring the XML data handler for Mime
type (text/xml) must have the same value that is specified for Encoding in the
EmailFixedStructuredDataBinding properties.

5. In the Encoding field, click Select if you want to choose a different encoding
value.

6. In the Data handler configuration field, click Select. Complete the following
steps to create and configure a data handler.

a. From the Use existing data format transformation from the list option,
select the XML data handler. Click Next.
The Select your custom data format transformation from the workspace

& Data Handler Configuration |Z|@”z|

Select a Data Format Transformation

Select a data format transformation entry from the list. To use your own custom data L
transformation, select the second radio button to add your custom transformation, i

() Use existing data format transformation from the list

[ pelimited

[ Fived width

@ Handled by WTX

%. Handled by WTX Invoker
2 1s0n

= 0N

[]5haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

0n inbound, parses XML data into & business object. On outbound, serializes business object to XML data

\

Figure 46. Selecting the data handler configuration type

option is available for advanced users who want to use a custom data
handler. A custom data handler, placed in the class path, shows when this
option is selected.

b. In the Specify the Data Transformation Properties window, select an
Encoding value. Click Next.

Note: This value indicates the type of character encoding the adapter uses
during data transformation. For more information about the encoding
property, see ['Email business object properties” on page 162,
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c. In the Configure a New Data Transformation window, select the module. If
the correct module is not appearing, click New to create a new one.

Optional: Type a Folder name to specify a folder for the artifacts.
Leave the default data handler Name or type a new one.

& Data Handler Configuration

Configure a New Data Transformation

Create a data transformation configuration. | LJ

Moduleorlibrary:lOuﬂ:nund VH Browse. .. ] [ Mew. .. ]
Namespace: [ttp: /Outbound | [F]Defauit

Folder: | || sromse... |

Mame: | DataHandlerConfiguration |

Description:

® ext Finish ] [ Cancel

Figure 47. Creating a data handler

f. Click Finish.
7. In the Add/Edit properties window, click Finish.

Results
Business object properties and their data handlers are created.
What to do next

Set interaction specification properties and generate artifacts for your module.
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Setting interaction specification properties and generating the
service

Interaction properties are optional. If you choose to set them, the values you
specify are displayed in the import file. The import file is generated when the
adapter creates artifacts for the module and contains the operation for the top-level
business object.

Before you begin

To set interaction specification properties and generate artifacts for your module,
you must configure data bindings and selected business objects.

About this task

Interaction specification properties do not take precedence over request business
object attributes, except for the user name and password properties. User name
and password values specified in the interaction specification properties take more
precedence over values set in the managed connection factory properties. To set
interaction specification properties and generate artifacts, follow this procedure.
For more information, see [“Interaction specification properties” on page 188

Procedure
1. Optional: To set interaction specification properties complete these steps:
a. Click Advanced.
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4= New External Service

Add, Edit, or Remove Operations

The adapter will use theze operations to access native functions. )ﬁs

Operations:
- g8 send (fhttp: ffwww.ibm. comxmins fprodfwebsphere i 2ca femail fixedstructureemailUserCustom| | Add. ..

<_ i}

%

Operation Properties

InteractionSpec Properties for 'send’

|+ Additional properties

Fraom:

Reply to:

To:

Cez

E-mail subject:

User name:

Password:

|
|
|
|
Bee: |
|
|
|
|

Encoding: ’ Select... l

@ ’ < Back ][ Mext = Finish

Figure 48. Setting interaction specification properties

b. Type values for any fields you want to set as defaults.
c. Click Next.
2. In the Specify the Name and Location window, select the Module.
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#= New External Service

Specify the Name and Location

ol
Specify the name and location of the new service and its interface.
Properties for Service
Module: | Lser w |
Use the default namespace
Folder: | | [Bro'a'-.'se... ]

Mame: >=U| OutboundInterface |

[]save business objects to a library

Description: |

® axt > Finish H Cancel

Figure 49. Naming the artifact

3. Optional: Name the Folder to store the artifacts.

4. Type a Name for the interface. This name displays in the IBM Integration
Designer assembly diagram.

5. Optional: Type a Description.

6. Click Finish. The interface is displayed in IBM Integration Designer assembly
diagram.
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Figure 50. Interface in IBM Integration Designer
The business object you created is also displayed in a different tab.
Results

IBM Integration Designer generates the artifacts and an import. The outbound
artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.

Configuring the module for inbound processing

To configure a module to use the adapter for inbound processing, use the external
service wizard in IBM Integration Designer to build business services, specify data
transformation processing, and generate business object definitions and related
artifacts.

Setting deployment and runtime properties for inbound

processing
Using the external service wizard in IBM Integration Designer, select whether the
module is used for outbound or inbound communication with the mail server.
Then configure the connection properties. The connection properties are stored in
the business object and contain the information that the adapter needs to make the
connection between the inbound module and service.

Before you begin

Before you can set the connection properties in this section, you must create your
module in IBM Integration Designer. It is displayed in the Business Integration
pane below the adapter project. Also, you must create a staging directory on your
local system for storing emails that is polled by the adapter but which are yet to be
turned into business objects.
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About this task

To set connection properties, follow this procedure. For more information, see
[“Activation specification properties” on page 195

Procedure

1. In the Select the Processing Direction window, select Inbound and click Next.
The Specify the Security and Configuration Properties window opens.

& New External Service |._|@|g|
Select the Processing Direction 9—

Select the direction of adapter processing at run time. ;
() Inbound

Inbound processing passes data from the adapter to your service export.

=

(") Outbound

Cutbound processing passes data from vour service impart to the adapter.

>

@j ’ < Back ” Mext = l

Figure 51. Choosing inbound or outbound in the external service wizard

2. In the Deploy connector project field, specify whether to include the adapter
files in the module. Select one of the following values:

* With module for use by single application: With the adapter files embedded
in the module, you can deploy the module to any application server. Use an
embedded adapter when you have a single module using the adapter or if
multiple modules need to run different versions of the adapter. Using an
embedded adapter enables you to upgrade the adapter in a single module
without the risk of destabilizing other modules by changing their adapter
version.

* On server for use by multiple applications: If you do not include the
adapter files in a module, you must install them as a stand-alone adapter on
each application server where you want to run the module. Use a
stand-alone adapter when multiple modules can use the same version of the
adapter and you want to administer the adapter in a central location. A
stand-alone adapter can also reduce the resources required by running a
single adapter instance for multiple modules.
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d= New External Service

Specify the Security and Configuration Properties —
s
Deploy connector project: with module for use by single application v | 1
Connection properties
Staging directory: = | C:\5taging | [Browse... l
E-mail system connection information
Host name: | loczlhost |
Port number: | 110 |
Protocol: | pop3 w |
Service properties
How do you want to specify the security credentials?
) Using an existing JAAS alias (recommended)
() Using security properties from the activation specification
The properties will be stored as plain text; no encryption is used.
Uzer name: | Ugername |
Password: | R |
) other
b,
<
@) ’ < Back ][ Mext = l ’ Finish ] [ Cancel

Figure 52. Specifying inbound connection properties

3. Browse for the Staging Directory you created on your local system. If you have
not created a staging directory, create one and then restart the external service
wizard.

4. Define the Connection properties for your module. For more details about
these properties, see I"Activation specification properties” on page 195.|

a. Under the E-mail system connection information, type the Host name.
b. Type the Port number.

c. Optional: Select the email Protocol. For more information about the POP3
and IMAP email protocols, see|“Supported inbound protocols” on page 8

5. Click Advanced and specify values as needed. These include activation
specification properties designed to alter the default behavior of the adapter
during inbound communication. For more information about any of the
Advanced properties for event polling, event delivery, event persistence,

archiving, or setting search criteria, see [“Activation specification properties” on|
‘ae 195.
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Event delivery configuration

Event polling configuration

Event persistence configuration

Additional properties

Bidi properties

Logging and tracing

Figure 53. Advanced properties

* Event delivery configuration

a.

C.

In the Type of delivery field, select the delivery method. The methods
are described in [“Delivery type (DeliveryType)” on page 199.|

If you want to ensure that events are delivered only once and to only one
export, select the Ensure assured-once event delivery check box. This
option might reduce performance but does not result in duplicate or
missing event delivery. For more information, see [“Ensure once-only|
levent delivery (AssuredOnceDelivery)” on page 200,

In the Retry limit for failed events field, specify the number of times to
try to deliver an event after a delivery failure. For more information, see
[“Retry limit for failed events (FailedEventRetryLimit)” on page 201

* Event polling configuration

In the Interval between polling periods (milliseconds) field, type the
time in milliseconds, that the adapter waits between polling periods. For
more information about the property, see [“Interval between polling|
[periods (PollPeriod)” on page 202.|

In the Maximum events in polling period field, type the number of
events to deliver in each polling period. For more information about the
property, see [“Maximum events in polling period (PollQuantity)” on page|
H 05

To specify the time interval between attempts to connect to the mail server
if a connection fails, set Time between retries in case of system
connection failure (in milliseconds) to a value in milliseconds. For more
information, see|“Time between retries in case of system connection failure|
[RetryInterval)” on page 208

To specify the number of connection exceptions during the inbound
operation, set Maximum number of retries in case of system connection
failure to a value greater than or equal to 0. For more information, see
“Maximum number of retries in case of system connection failure|
(RetryLimit)” on page 205)

If you want the adapter to stop if polling errors occur, select the Stop the
adapter when an error is encountered while polling check box. If you do
not select this option, the adapter logs an exception but continues to run.
For more information, see [‘Stop the adapter when an error is encounteredl
fwhile polling (StopPollingOnError)” on page 208]

Select the Retry EIS connection on startup check box, if you want the
adapter to try a failed connection when starting. For more information, see
“Retry EIS connection on startup (RetryConnectionOnStartup)” on page|

207
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— Select the calendar based scheduling option to create calendar based
polling for inbound activities. You can schedule your business activities,
when you create a new calendar in IBM Integration Designer. The option
of working with the calendar based scheduling feature is only possible
with IBM Integration Designer as the tooling environment. The following
figure helps you to schedule a calendar polling option.

Palling based on business calendar:

Figure 54. Polling based on business calendar

You can either select a blank calendar or create a new calendar for a
module or library.

Note: When you select a blank calendar, you will not be able to set
predefined time intervals. You have to define your time intervals. When
you create a calendar using a predefined template, you can define time
intervals for each template.

- To select an existing calendar for a module or library, click Browse. In
the Select a Business Calendar window, you can search for existing
calendar files (xcal) in the IBM Integration Designer workspace.

a. In the Filter by name field, type the calendar name or name pattern.
The calenders matching the pattern are displayed in the Matching
business calendars area.

b. Select a calendar and click OK to return to the external service
wizard.

- To create a new calendar entry for a module or library, click New. The
Create a business calendar window is displayed.

a. In the Module or library field, click Browse to select an existing
calendar module or click New to create a module for the new
calendar.

b. In the Folder field, click Browse to select an existing folder or create
a new folder for the calendar.

c. In the Name field, enter a name for the new calendar.
* To create a non template calendar, click Finish. Or

* To generate the calendar based on a predefined template, click
Next. In the Use a template window, select the Create a calendar
using one of the templates check box and click Finish.

The new business calendar is created and available in the Business
Integration view. Once you complete the wizard, you can view or
modify the calendar schedules in the Business Integration view
using the Business Calendar Editor. You can modify the intervals
and exceptions, or add new entries for these elements. For more
details about working with business calendars, see

Note: You must deploy the Business Calendar module to the same IBM
Business Process Manager or WebSphere Enterprise Service Bus instance,
along with the inbound application. If you do not map these two
connections to the same server instance, the inbound application using the
business calendar will by default, poll as there is no calendar configured.

* Event persistence configuration
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a. Select Auto create event table check box if you want the adapter to
create the Event Persistence table. For more information, see

levent table property (EP_CreateTable)” on page 198

b. In the Event recovery table name field, specify the name of the table that
the adapter uses for event persistence. For more information, see f’EvenEl
[recovery table name property (EP_TableName)” on page 201)

c. In the Event recovery data source (JNDI) name field, specify the JNDI
name of the data source that event persistence uses to connect to the
JDBC database. For more information, see [“Event recovery data sourcel
[JNDI) name property (EP_DataSource_JNDIName)” on page 200

d. In the User name used to connect to event data source field, specify the
user name that the event persistence uses to connect to the database from
the data source. For more information, see [“User name used to connect to
levent data source property (EP_UserName)” on page 209.]

e. In the Password used to connect to event data source field, specify the
password that the event persistence uses to connect to the database from
the data source. For more information, see [“Password used to connect to
levent data source property (EP_Password)” on page 206

f. In the Database schema name field, specify the schema name of the
database that the event persistence uses. For more information, see
[“Database schema name (EP_SchemaName)” on page 198.|

* Additional configuration

a. Select the Enable transport security (SSL) check box if you want to
enable Secure Sockets Layer (SSL). For more information, see |”Enabla

”

[transport security (SecureConnectionProperty)” on page 199.)

b. Select the Emit individual business objects from a multipart e-mail
check box, to specify if the adapter creates individual business objects for
each part of a multipart email. For more information, see |”Emiﬂ
individual business objects from a multipart email (EmitIndividualBOs)”|

on page 199.|

c. In the Match all search criteria field, specify the search criteria to filter
which events are polled from the mail server. The events that meet the
ANDed conditions are polled. For more information, see
[search criteria (MatchAllCriteria)” on page 202

d. In the Match some search criteria field, specify the search criteria to filter
which events are polled from the mail server. The events that meet the
ORed conditions are polled. For more information, see |”Match some|
lsearch criteria (MatchSomeCriteria)” on page 203

e. In the Archive file naming pattern field, you can specify a
comma-delimited pattern of header names which are used to name
archived files stored in the archive folder. For more information, see
|”Archive file naming pattern (ArchiveFile)” on page 197.|

* Bidi properties
a. Select the Bidi transformation check box to specify bidirectional format.
For more information about setting the Bidi properties, see
[“Globalization” on page 212

* Logging and tracing
a. If you have multiple instances of the adapter, enter a value in the

Adapter ID that is unique for this instance. For more information, see
|“Adapter ID (AdapterID)” on page 187
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b. You can select the Disguise user data as 'XXX' in log and trace files
check box to prevent sensitive user data from being written to log and
trace files.

6. In Service properties, specify how you want the adapter to connect to the mail
server by selecting any one of these authentication methods.

* To use a J2C authentication alias, click Using an existing JAAS alias
(recommended) and type the name of the alias in the J2C Authentication
data entry field. You can either specify an existing authentication alias or
create one at any time before deploying the module. The name is
case-sensitive and includes the node name.

* To use the security properties from the activation specification, click Using
security properties from the activation specification enter the following
information:

— In the User name field, type the user name for the mail server.
— In the Password field, type the password for the mail server.

Note: The security properties are not encrypted and stored as plain text. If
you are using an authentication alias, a user name and password are not
necessary. Also, for outbound communication you do not need to enter a
user name and password because a mail server uses an anonymous user
name and password to send the emails.

* To administer the user name and password from another mechanism, click
Other.

7. To use an existing function selector configuration, use the default value
(EmailFunctionSelector). To configure a custom function selector, click Select.
Clicking Select allows you to select a pre-configured function selector. You can
configure a function selector if you want to implement a custom function
selector. This configuration is an advanced concept. By default, the email
function selector is used, which does not require any configuration.

8. Optional: Select the Change logging properties for wizard check box if you
want to define the level of logging for this module.

What to do next

Browse for or create a data binding for the module.

Selecting a data type and operation name

Use the external service wizard to select a data type and name the operation
associated with this data type. For inbound communication, the external service
wizard gives you the choice of three different data types: generic email, generic
email with business graph, and user-defined type. Each data type corresponds to a
business object structure.

Before you begin

You must have specified the connection properties for the adapter to connect to the
mail server, data bindings, and data handlers before you can specify the operation
and data type for the module.

About this task

To select a data type and name the operation associated with it, follow this
procedure.

Chapter 4. Configuring the module for deployment 101



102

Procedure
1. In the Add, Edit, or Remove Operations window, click Add.
2. In the Specify the I/O Properties window, type an Operation name.

4 Add Operation |Z'E]

Specify the 1/ 0 Properties
@

Operation name: = | emitEmail |

Specify the Operation Input

Data format: = DataBindingConfiguration

':':’:' Finish ] [ Cancel

Figure 55. Naming the operation

Type a meaningful name for the operation. If this module is going to be used to
convert a simple email business object, name it something like SendEmail. Or, if
it is going to be used to create a parent email business object with a customer
child business object, name it something like SendCustomerEmail. For more
information about the types of operations the adapter can perform, see
|”Supp0rted operations” on page 161.|

Note: Names cannot contain spaces.

3. The external service wizard defaults to the correct data binding for the data
type you selected in the Operation window. If you want to use a different data
binding, click Browse for a data binding or create a new one using the
instructions in the sections "Configuring the data binding" and "Configuring
business object properties and data handlers."

4. In the Specify the 1/O Properties window, click Finish.
5. In the Add, Edit, or Remove Operations window, click Next.

Results

A data type is defined for the module and the operation associated with this data
type is named.

What to do next

Generate artifacts for the module.
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Configuring the data binding

Data bindings read the fields in a business object and fill the corresponding fields
in an email. In the external service wizard, you add a data binding to your module
and configure it to correspond with your data type. This way, the adapter knows
how to populate the fields in an email with information it receives in the business
object.

Before you begin

You must have entered service configuration properties for the connection to the
mail server.

About this task
To add and configure a data binding for the module, follow this procedure.

Note: You can configure data bindings before running the external service wizard
by using IBM Integration Designer. To do this configuration, select New >
Configure Binding Resource in IBM Integration Designer and complete the data
binding windows described in this documentation.

Procedure

1. In the Specify the Security and Configuration Properties window, select a value
for the Data format options from the list. You can choose to use the data
binding configuration for all operations or you can choose to specify a data
binding for each operation. If you use the data binding configuration for all
operations, then the data binding configured here is used as the default data
binding configuration for all the operations. If you choose to specify a data
binding for each operation, then you must configure a data binding for each
operation. In these steps, the Use a data format configuration for all
operations option is selected.

Important: If associate your inbound module with a particular user-defined
business object type, the steps for defining your data binding in this section
dictates which events the adapter processes at run time. At run time, inbound
events that are symmetric to the custom data type are processed by the adapter.
Those events that are not symmetric to the custom data type are not processed.
For these events, the adapter throws an exception and logs an error message.

2. In the Data format field, click Select.

3. In the Select a Data Format Transformation window, select the Use existing
data format transformation from the list option to use one of the data
bindings included with IBM Integration Designer. Click Next. The Select your
custom data format transformation from the workspace option is available for
advanced users who want to use a custom data binding. A custom data
binding, once placed in the class path, shows when this option is selected.
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# Data Binding Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To uze your own custom data L_J
transformation, select the second radio button to add your custom transformation, l_J

() Use existing data format transformation from the list

& EmailFivedStructuredDataBinding

%- EmailSimpleDataBinding

@ EmailwrapperDataBinding

[15haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

This Data Binding handles the transformations that are required for the Email adapter

®

Figure 56. Selecting a data binding

The following data types are matched with the following data bindings.

Table 6. Data types and their data binding equivalents

Data type

Data binding

Generic email

Email Wrapper Data Binding

Generic email with business graph

Email Wrapper Data Binding

User-defined email business object

EmailFixedStructureDataBinding

4. In Specify the Data Transformation Properties window, click Next.

Note: This window is used for configuring the data handlers.

5. In Configure a New Data Transformation window, provide the data binding

configuration details.

a. In the New Data Binding Configuration window, the Module defaults to
the module name you typed earlier in the wizard. To create a data binding
for a different module, select New to create a module.
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4 Data Binding Configuration |Z|E“z|

Configure a New Data Transformation

Create a data transformation configuration. L__,
Module or library: |In|:u:und b | l Browse. .. ] [ New... l
Mamespace: |I1ttp:_-"_-"Inb0und | Default

Folder: | | ’ Browse.., ]

Mame: | DataBindingConfiguration |

Description:

@j ext Finish ] [ Cancel

Figure 57. Naming the data binding configuration

b. If you want to select a new folder for the artifact, click Browse and select a
new folder location. If you do not browse for a new folder location, the
artifacts are created in the root directory for the module.

c. Type a Name for the data binding configuration and click Finish.

The data binding class name populates in the Specify the Security and
Configuration Properties window.

Results
A data binding is configured for use with the module.

What to do next

Specify data binding properties.

Configuring business object properties and data handlers

When you select a data type that contains business objects, you must specify
properties for those business objects. However, this step does not add child
business object to the email parent object. Rather, they tell the adapter how to
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process particular types of business objects. Data handlers perform the conversions
between a business object and a particular MIME format.

Before you begin

You must have created a data binding before specifying business object properties
and data handlers for the module. Also, you must have predefined business objects
using IBM Integration Designer Business Object Editor. If you stop the wizard here
to create business objects, you must start the wizard steps from the beginning.

Note: Data handlers can be configured before running the external service wizard
using IBM Integration Designer. To do this configuration, select New > Configure
Binding Resource in IBM Integration Designer and complete the data handler
windows described in this documentation.

About this task

You must define business object properties and data handlers if you have selected
the generic email, email with business graph, or user-defined type as the data type.
The simple alert email data type does not have properties that need to be
configured. To specify business object properties and data handlers, follow this
procedure.

Procedure

1. If you chose the email with business object or email with business graph data
types, click Add to add the business object types to the data binding
description in the Add/Edit properties window.

Note: For the user-defined type, the following warning message is displayed if
you click Add in this window. The User cannot add new row to the table.
Adapter has parsed your Input type and filled the table. This warning
appears because the adapter has determined which business objects the data
binding must know about and pre-filled the table. To provide values for the
rest of the properties, select individual rows and click Edit.

Important: If you are repeating these steps to configure a child data binding
for the user-defined data type, note that you cannot select between data
handler and data binding when you click Edit. The binding type option (to
select between data binding and data handler) does not function correctly for
the EmailFixedStructuredDataBinding data binding. To configure a child data
binding for EmailFixedStructuredDataBinding, click the Binding type field and
select DataBinding.

2. In the Add/Edit properties window, ensure that DataHandler is selected in the
Binding type field.

3. In the Business object type field, click Browse for existing business objects or
New to create a business object. Selecting business objects here does not
physically add child business objects. Adding business objects at this stage in
the wizard tells the adapter that you are going to use certain business object
types with your module. It enables the adapter to know what data binding to
apply to any child business objects it processes.

a. If you selected Browse for the Business object type field, select a data type
from the Data Type Selection window and click OK.

b. If you selected New for the Business object type field, complete the
following steps.
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#= New Business Object

Create a Business Object
Business objects are containers for application data that represent business functions or elements, such as a "
customer or an invaice,
Maodule ar library: ‘Inhound vl [ Browse... ] [ New... ]
MNamespace: ‘ http://Inbound | Default
Folder: ‘ | [ Browse... J
Mame: ‘ Customer |
Inherit from: l <nong> I [ Browse... ] [ New... ] [Clear]

Business objects, by default, are created as alobal complex types. However, some intearation scenarios might
require a global element, Mare...

[l create the business ohject as an element

@ < Back [ MNext = ] l Finish ] [ Cancel

Figure 58. Specifying business object properties for the module

c. Select the Module. If the correct module is not shown, Browse for it or click
New to create a module.

d. Optional: Type a Folder name or Browse for the folder on your local drive
where business object schema files (XSD files) generated by the external
service wizard are stored.

e. Type a Name for the business object.

f. If you do not want to populate the business object with fields from one or
more existing business objects, click Finish.

g. If you want to populate the business object with fields from one or more
existing business objects, click Next.
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4= New Business Object

Derived Business Object

Populate the new business object with fields frorr%ﬂe or more existing business objects.
Available business objects: Fields to include:

4] 2 Email http: ffweww.ibm.comfxn| | Mame Type

| [ClHeader http: f{fwww.ibm, comfxn

| [C)Mailattachment http:/ wv.ibm, comfxn,

L} [Zl UnstructuredContent http: fjwww.ibm. comfxn

[ £ vibiaddress fyttm v, ibm, com fxn

4] [ Whiphone http: ffwww.ibm. comfxn

S
|

@ ext L Finish .][ Cancel

Figure 59. Deriving business object fields from an existing business object

h. Select the correct business object and click Finish. The Business object type
in the Add/Edit properties window is populated.

4. In the Add/Edit properties window, select a Mime type such as text/xml for
your business object. The mime type corresponds to the data handler that is
used by the adapter to perform data transformation from one format to
another. This step enables the adapter to decide which format it has to convert
the content to when it encounters the business object.

# Add/Edit M=

Add/ Edit properties
ﬂ Data handler configuration: cannot be empty.

Binding type: | Datatandler v|

Busnessobject type: = | Whiaddress {nttp://Gener| [Browse. .. | [rew... |
Mime type: = | |

Encoding: [uTFa | select... |

Data handler configuration: = Mot defined

@

Figure 60. Adding or editing business object data binding properties
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5. In the Encoding field, click Select if you want to choose a different encoding
value.

6. In the Data handler configuration field, click Select. Complete the following
steps to create and configure a data handler.

a. From the Use existing data format transformation from the list option,
select the XML data handler. Click Next.

& Data Handler Configuration

Select a Data Format Transformation

Select a data format transformation entry from the list. To use your own custom data L
transformation, select the second radio button to add your custom transformation, i

() Use existing data format transformation from the list

[ pelimited

[ Fived width

@ Handled by WTX

%. Handled by WTX Invoker
2 1s0n

= 0N

[]5haw the deprecated data format transformations

(") Select your custom data format transformation from the workspace

Description:

0n inbound, parses XML data into & business object. On outbound, serializes business object to XML data

\

Figure 61. Creating a data handler

b. In the Specify the Data Transformation Properties window, select an
Encoding value. Click Next.

c. In the Configure a New Data Transformation window, select the module. If
the correct module is not displayed, click New to create a new one.

Optional: Type a Folder name to specify a folder for the artifacts.
Leave the default data handler Name or type a new one.
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& Data Handler Configuration

- B

Configure a New Data Transformation

Create a data transformation configuration. L

»

Module or library:

MNamespace: |I1ttp:_."_."[nb0L|nd | Default

Folder: | | ’ Browse...

Mame: | DataHandlerConfiguration |

Description:

W
@) Finish ] [ Cancel

Figure 62. Creating a data handler

f. Click Finish.

7. In the Add/Edit properties window, click Finish.

Results

Business object properties and their data handlers are created.

What to do next

Specify interaction specification properties and generate artifacts for the module.

Setting deployment properties and generating the service

The export file is generated when the adapter creates artifacts for the module and

contains the operation for the top-level business object.

Before you begin

To generate artifacts for your module you must have already configured data

bindings and selected business objects.
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About this task
To generate artifacts for your module, follow this procedure.

Procedure
1. In the Specify the Name and Location window, select the Module.

#= New External Service

Specify the Name and Location i
Specify the name and location of the new service and its interface, U:lj

Properties for Service

Module: | Inbound w |

Use the default namespace

Folder: | | [Browse. = ]

Mame: >=U| InboundInterface |

Description: | |

@j Finish ] [ Cancel

Figure 63. Naming the artifact

2. Optional: Name the Folder to store the artifacts.

3. Type a Name for the interface. This name displays in the IBM Integration

Designer assembly diagram.
4. Optional: Type a Description.

5. Click Finish. The IBM Integration Designer assembly diagram opens and the

interface you created is displayed.
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9& Inbound - Assembly Diagram &3
{53 Palette
&S % 1
[-=-Favorites @ 7 InboundInterface

(= Components

% Untyped Component
}‘;‘j Human Task

Eﬂ Java

"B, Mediation Flow

S?_ Process

B Rule Group

QE, State Machine

E‘B‘ Import
Eiﬂ Export

References

Figure 64. Interface in IBM Integration Designer
The business object you created is also displayed in a different tab.
Results
The IBM Integration Designer generates the artifacts and an export. The inbound

artifacts that are created are visible in the IBM Integration Designer Project
Explorer under your module.

What to do next

Deploy the module for either testing or production.
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Chapter 5. Changing interaction specification properties

To change interaction specification properties for your adapter module after
generating the service, use the assembly editor in IBM Integration Designer.

Before you begin

You must have used the external service wizard to generate a service for the
adapter.

About this task

You might want to change interaction specification properties after you have
generated a service for the adapter. Interaction specification properties, which are
optional, are set at the method level, for a specific operation on a specific business
object. The values you specify appear as defaults in all parent business objects
generated by the external service wizard. You can change these properties before
you export the EAR file. You cannot change these properties after you deploy the
application.

To change the interaction specification properties, use the following procedure:

Procedure

1. From the Business Integration perspective of IBM Integration Designer, expand
the module name.

2. Expand Assembly Diagram and double-click the interface.

w

Click the interface in the assembly editor. The module properties are displayed.

4. Click the Properties tab. You can also right-click the interface in the assembly
diagram and click Show in Properties.

5. Under Binding, click Method bindings. The methods for the interface are
displayed, one for each combination of business object and operation.

6. Select the method whose interaction specification property you want to change.

7. Click Advanced and change the property in the Generic tab. Repeat this step
for each method whose interaction specification property you want to change.

Results

The interaction specification properties associated with your adapter module are
changed.

What to do next

Deploy the module.
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Chapter 6. Deploying the module

Deploy a module to place the files that make up your module and adapter into an
operational environment for production or testing. In IBM Integration Designer, the
integrated test environment features runtime support for IBM Business Process
Manager or WebSphere Enterprise Service Bus, or both, depending on the test
environment profiles that you selected during installation.

Deployment environments

There are test and production environments into which you can deploy modules
and adapters.

In IBM Integration Designer, you can deploy your modules to one or more servers
in the test environment. This is typically the most common practice for running
and testing business integration modules. However, you can also export modules
for server deployment on IBM Business Process Manager or WebSphere Enterprise
Service Bus as EAR files using the Process Administrative Console or
command-line tools.

Deploying the module for testing

In IBM Integration Designer, you can deploy a module that includes an embedded
adapter to the test environment and work with server tools that enable you to
perform such tasks as editing server configurations, starting, and stopping servers
and testing the module code for errors. The testing is generally performed on the
interface operations of your components, which enables you to determine whether
the components are correctly implemented and the references are correctly wired.

Generating and wiring a target component for testing inbound
processing

Before deploying to the test environment a module that includes an adapter for
inbound processing, you must first generate and wire a target component. This
target component serves as the destination to which the adapter sends events.

Before you begin
You must have generated an export module, using the external service wizard.

About this task

Generating and wiring a target component for inbound processing is required in a
testing environment only. It is not necessary when deploying the adapter in a
production environment.

The target component receives events. You wire the export to the target component
(connecting the two components) using the assembly editor in IBM Integration
Designer. The adapter uses the wire to pass event data (from the export to the
target component).

Procedure

1. Create the target component.
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a.

C.

From the Business Integration perspective of IBM Integration Designer,
expand Assembly Diagram and double-click the export component. If you
did not change the default value, the name of the export component is the
name of your adapter + InboundInterface.

An interface specifies the operations that can be called and the data that is
passed, such as input arguments, returned values, and exceptions. The
InboundInterface contains the operations required by the adapter to
support inbound processing and is created when you run the external
service wizard.

Create a new component by expanding Components, selecting Untyped
Component, and dragging the component to the Assembly Diagram.

The cursor changes to the placement icon.
Click the component to have it displayed in the Assembly Diagram.

2. Wire the components.

a.
b.

Click and drag the export component to the new component.
Save the assembly diagram. Click File > Save.

3. Generate an implementation for the new component.

a.

d.

Right-click on the new component and select Generate Implementation >
Java.

Select (default package) and click OK. This creates an endpoint for the
inbound module.

The Java implementation is displayed in a separate tab.

Optional: Add print statements to print the data object received at the
endpoint for each of the endpoint methods.

Click File > Save to save the changes.

What to do next

Continue deploying the module for testing.

Adding the module to the server

In IBM Integration Designer, you can add modules to one or more servers in the
test environment.

Before you begin

If the module you are testing uses an adapter to perform inbound processing,
generate and wire a farget component to which the adapter sends the events.

About this task

In order to test your module and its use of the adapter, you need to add the
module to the server.

Procedure

1. Conditional: If there are no servers in the Servers view, add and define a new
server by performing the following steps:

a.
b.
c.
d.

Place your cursor in the Servers view, right-click, and select New > Server.
From the Define a New Server window, select the server type.

Configure servers settings.

Click Finish to publish the server.
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2. Add the module to the server.

a. Switch to the servers view. In IBM Integration Designer, select Windows >
Show View > Servers.

a. Start the server. In the Servers tab in the lower-right pane of the IBM
Integration Designer screen, right-click the server, and then select Start.

3. When the server status is Started, right-click the server, and select Add and
Remove Projects.

4. In the Add and Remove Projects screen, select your project and click Add. The
project moves from the Available projects list to the Configured projects list.

5. Click Finish. This deploys the module on the server.

The Console tab in the lower-right pane displays a log while the module is
being added to the server.

What to do next

Test the functionality of your module and the adapter.

Testing the module for outbound processing using the test
client

Test the assembled module and adapter for outbound processing using the IBM
Integration Designer integration test client.

Before you begin

You need to add the module to the server first.

About this task

Testing a module is performed on the interface operations of your components,

which enables you to determine whether the components are correctly
implemented and the references are correctly wired.

Procedure
1. Select the module you want to test, right-click on it, and select Test > Test
Module.

2. For information about testing a module using the test client, see the Testing
modules and components topic in the IBM Integration Designer information
center.

What to do next

If you are satisfied with the results of testing your module and adapter, you can
deploy the module and adapter to the production environment.

Deploying the module for production

Deploying a module created with the external service wizard to IBM Business
Process Manager or WebSphere Enterprise Service Bus in a production
environment is a two-step process. First, you export the module in IBM Integration
Designer as an enterprise archive (EAR) file. Second, you deploy the EAR file
using the IBM Business Process Manager or WebSphere Enterprise Service Bus
Process Administrative Console.
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Installing the RAR file (for modules using stand-alone
adapters only)

If you chose not to embed the adapter with your module, but instead choose to
make the adapter available to all deployed applications in the server instance, you
need to install the adapter in the form of a RAR file to the application server. A
RAR file is a Java archive (JAR) file that is used to package a resource adapter for
the Java EE Connector Architecture (JCA).

Before you begin

You must set Deploy connector project to On server for use by multiple adapters
in the Specify the Service Generation and Deployment Properties window of the
external service wizard.

About this task

Installing the adapter in the form of a RAR file results in the adapter being
available to all Java EE application components running in the server run time.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Resources > Resource Adapters > Resource adapters.
5. In the Resource adapters page, click Install RAR.

. Admin Console X

Integrated Solutions Console Welcome Help Logout .-I-

| View: | All tasks A ESOUNOE SOSpLers

welcome Resource adapters rE

Guided Activities Resatreelsaprers

Servers Use this page to manage resource adapters, which provide
— the fundamental interface for connecting applications to an
E Applications Enterprise Information System (EIS). The WebSphere(R)

Relational Resource Adapter is embedded within the
product to provide access to relational databases. To
zccess another type of EIS, use this page to install 2
standalane resource adapter archive (RAR) file. You can
configure multiple resource adapters for each installed RAR

B Resources

Schedulers

Object pool managers

B 1ms file.
People directory providi E Scope: =All scopes
Extended messaging pr
webSphere Business In Scope specifies the level at which the resource
Adapters definition is visible. For detailed infermation on
what scope is and how it works, see the scope
E 1pBC

settings help
El Resource Adapters

Resource adapters All scopes

J2C connection facts
o | Preferences
J2C activation speci

J2C administered ob Install RAR | Mew| | Delsts

[ Asynchronous beans el
[H Cache instances 3 =

Figure 65. The Install RAR button on the Resource adapters page
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6. In the Install RAR file page, click Browse and navigate to the RAR file for
your adapter.

The RAR files are typically installed in the following path:
IID installation_directory/ResourceAdapters/adapter_name/adapter.rar

7. Click Next.

8. Optional: In the Resource adapters page, change the name of the adapter and
add a description.

9. Click OK.
10. Click Save in the Messages box at the top of the page.

What to do next

The next step is to export the module as an EAR file that you can deploy on the
server.

Exporting the module as an EAR file

Using IBM Integration Designer, export your module as an EAR file. By creating
an EAR file, you capture all of the contents of your module in a format that can be
easily deployed to IBM Business Process Manager or WebSphere Enterprise Service
Bus.

Before you begin

Before you can export a module as an EAR file, you must have created a module
to communicate with your service. The module should be displayed in the IBM
Integration Designer Business Integration perspective.

About this task

To export the module as an EAR file, perform the following procedure.

Procedure

1. Right-click the module and select Export.
2. In the Select window, expand Java EE.

3. Select EAR file and click Next.
4

. Optional: Select the correct EAR application. The EAR application is named
after your module, but with “App” added to the end of the name.

o

Browse for the folder on the local file system where the EAR file will be placed.

6. Optional: To export the source files, select the Export source files check box.
This option is provided in case you want to export the source files in addition
to the EAR file. Source files include files associated with Java components, data
maps, and so on.

7. Optional: To overwrite an existing file, click Overwrite existing file.
8. Click Finish.

Results

The contents of the module are exported as an EAR file.
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What to do next

Install the module in the Process Administrative Console. This deploys the module
to IBM Business Process Manager or WebSphere Enterprise Service Bus.

Installing the EAR file

Installing the EAR file is the last step of the deployment process. When you install
the EAR file on the server and run it, the adapter, which is embedded as part of
the EAR file, runs as part of the installed application.

Before you begin

You must have exported your module as an EAR file before you can install it on
IBM Business Process Manager or WebSphere Enterprise Service Bus.

About this task

To install the EAR file, perform the following procedure. For more information
about clustering adapter module applications, see the |http://www.ibm.com /|
lsoftware /webservers /appserv/was/library /|

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Click Applications > New Application > New Enterprise Application.

Welcome
Guided Activities
Servers
El applications

erprise
Applications

Install Hew
Application

SCA Modules

=

Resources

3|

Security

e |

Environment

e |

Integration Applications

e |

Systern administration

e

Monitaring and Tuning

=]

Troublezshaoting

=]

Service integration

3|

UoDI
Figure 66. Preparing for the application installation window

5. Click Browse to locate your EAR file and click Next. The EAR file name is the
name of the module followed by "App."
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6. Optional: If you are deploying to a clustered environment, complete the
following steps.

a. On the Step 2: Map modules to servers window, select the module and
click Next.

b. Select the name of the server cluster.
c. Click Apply.

7. Click Next. In the Summary page, verify the settings and click Finish.

8. Optional: If you are using an authentication alias, complete the following steps:
a. Expand Security and select Business Integration Security.

b. Select the authentication alias that you want to configure. You must have
administrator or operator rights to change the authentication alias
configurations.

c. Optional: If it is not already specified, type the User name.
d. If it is not already specified, type the Password.

e. Ifit is not already specified, type the password again in the Confirm
Password field.

f. Click OK.
Results
The project is now deployed and the Enterprise Applications window is displayed.
What to do next
If you want to set or reset any properties or you would like to cluster adapter

project applications, make those changes using the Process Administrative Console
before configuring troubleshooting tools.

Deploying the module in a clustered environment

In IBM Integration Designer, you can deploy the IBM WebSphere Adapter for
Email in a clustered environment.

To deploy the module in a clustered environment, use any of the following
approaches.

* Embedded module: The adapter is embedded in the application and specific to
it. The adapter cannot be shared between multiple applications.

* Node level module with embedded activation specification: The adapter is
deployed at the node level, with the activation specification created during
module creation. The adapter can be shared across multiple applications.

* Node level module with JNDI activation specification reference: The adapter is
deployed at the node level, and the application provides a JNDI reference to the
activation specification. You must create the reference at the cluster scope from
the Process Administrative Console, with the same JNDI name. The adapter can
be shared across multiple applications.

Deploying module embedded in the application

The adapter is deployed embedded in the application and specific to it. The
adapter cannot be shared between multiple applications.
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Before you begin

The following steps are a necessary prerequisite to configure and deploy the
module.

¢ IBM Integration Designer version 7.5.0.0 or above.

* A clustered topology deployment environment on the IBM Business Process

Manager or WebSphere Enterprise Service Bus available from IBM Integration
Designer.

* Create a clustered topology deployment environment, as shown in the following
Gold Topology configuration figure.

Deployment Environments

Deployment Environmeants

Use this page to manage deployment environments that are based on
environments,

Deployment environmeit patterns set up typical business integration e
Use custem deployment environments te fine tune a configuration for

EStEI't.| |Stnp| | New... | | Remove | I Import... | | Export...

Select | Deployment Environment Name 3 Status o
1 MyTopology *
Total 1

Figure 67. Deployment environment

* Deploy the adapter and the adapter applications (EAR files) in the AppTarget
(the target that hosts the SCA container).

erver clusters

Server clusters

Use this page to change the configuration settings for a cluster. A server cluster consists
member servers fails, requests will be routed to other members of the cluster. Learn mo
activity provides a list of task steps and more general information about the topic.

Preferences

[wew| | Delete | [Start| [Stop| | Ripplestart | [ Immediatestop |
=l
E'uelel:ti Name & Status ()
F MyTopology.AppTarget &
D MyTopology.Messaging &
i MyTopology.Support >3

Total 2

Figure 68. Deployment environment showing server clusters

About this task

To create an application with the embedded adapter, use the external service
wizard.
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Procedure

1.

In the Service Configuration Properties window, from the Deploy connector
project property list, select With module for use by single application.

2. Create the module as described in the [Business process management samples
[for WebSphere Adapters]

3. In the Dependencies option for the module, after the module is created, ensure
that the Deploy with module option is selected for the adapter.

4. If the server is not running, right-click your server in the Servers view and
select Start.

5. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

6. From the Deployment Manager Admin Console, click Install applications to
deploy the application.

7. On the Step 2: Map modules to servers window, select the module and click
Next. For the embedded adapter option, the adapter is deployed as part of the
application.

8. In the Enterprise Applications view, select the new application
<adapter_name>EmbeddedModuleApp. The new application is displayed after
the application is deployed at the deployment manager level.

9. Select the node and click Installed applications to view the deployed
application on each individual node.

Results

The resource adapter is embedded and deployed as part of the application.

Deploying module at node level with embedded activation
specification
The adapter is deployed at the node level, with the activation specification created
during module creation. The adapter can be shared across multiple applications.

Before you begin

The following steps are a necessary prerequisite to configure and deploy the
module.

* IBM Integration Designer version 7.5.0.0 or above.

* A clustered topology deployment environment on the IBM Business Process

Manager or WebSphere Enterprise Service Bus available from IBM Integration
Designer.

¢ Create a clustered topology deployment environment, as shown in the following

Gold Topology configuration figure.
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Deployment Environments

Deployment Environmeants

Use this page to manage deployment environments that are based on
environments,
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EHStart.| !Stop| leew... | | Remaove | | Import... 1T Export... |
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Figure 69. Deployment environment

* Deploy the adapter and the adapter applications (EAR files) in the AppTarget
(the target that hosts the SCA container).

erver clusters

Server clusters

Use this page to change the configuration settings for a cluster. A server cluster consists
member servers fails, requests will be routed to other members of the cluster. Learn mo
activity provides a list of task steps and more general information about the topic.

Preferences

[ew| | Delete | [start] :'_E't'a;|' Ripplestat | | ImmediateStop |

=2

i Select: Name & Status
‘ D MyTopology.AppTarget &

i D ._I"a;lj.r_'l-'opoloq'.r.h'lessaqinq &

l i MyTopology.Support >3

‘ Total 2

Figure 70. Deployment environment showing server clusters

About this task

To create an application with the node level adapter and activation specification
properties specified in the module itself, use the external service wizard.

Procedure

1. In the Service Configuration Properties window, from the Deploy connector
project property list, select On server for use by multiple applications.

2. From the Connection properties list, select Use properties below.

3. Create the module as described in the [Business process management samples|
[for WebSphere Adapters|

4. In the Dependencies option for the module, ensure that the Deploy with
module option is not selected for the adapter. Here, the adapter is not part of
the module, therefore you must deploy the adapter before deploying the
application.

5. If the server is not running, right-click your server in the Servers view and
select Start.

124 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide


http://publib.boulder.ibm.com/bpcsamp/index.html
http://publib.boulder.ibm.com/bpcsamp/index.html

10.

11.

12.
13.

14.

15.

16.

17.

18.

19.

20.

When the server status changes to Started, right-click the server and select
Administration > Run administrative console. Log on to the administrative
console.

To deploy the adapter at individual nodes, click Resources > Resource
Adapters > Resource adapters. In the clustered environment, you must install
the adapter in each node separately.

In the Resource adapters page, click Install RAR.

In the Install RAR file page, click Browse and navigate to the RAR file for
your adapter. Deploy the RAR on each node.

The RAR files are typically installed in the following path:

IID installation directory/ResourceAdapters/adapter name/adapter.rar

For deployment at node level, do not select any Scope because the scope is
always Node. Click Next.

Optional: In the Resource adapters page, change the name of the adapter and
add a description. Click OK.

Click Save in the Messages box at the top of the page.

For node level deployment, check if the adapter RAR is deployed at the node
level.

To deploy the adapter at the cluster level, click Resources > Resource
Adapters > Resource adapters.

In the Resource adapters window, set the Scope to Cluster, and then click
New.

Select the RAR deployed at the node level.

Check if the adapter RAR is now deployed at the cluster level. Deploy the
application after the adapter is deployed at the node level on the individual
nodes, and then at the cluster level.

From the Deployment Manager Admin Console, click Install applications to
deploy the application.

On the Step 2: Map modules to servers window, select the module and click
Next. The adapter is not part of the deployed application.

In the Admin Console, click Resources > Resource Adapters > IBM
WebSphere Adapter for Email > J2C activation specifications to view the
activation specification from the adapter deployed at the cluster level.

Results

The resource adapter is deployed at the node level, with the activation
specification.

Deploying module at node level with JNDI activation
specification
The adapter is deployed at the node level, and the application provides a JNDI
reference to the activation specification. You must create the activation specification

with the same JNDI name at the cluster scope from the Process Administrative
Console. The adapter can be shared across multiple applications

Before you begin

The following steps are a necessary prerequisite to configure and deploy the
module.

* IBM Integration Designer version 7.5.0.0 or above.
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* A clustered topology deployment environment on the IBM Business Process
Manager or WebSphere Enterprise Service Bus available from IBM Integration
Designer.

* Create a clustered topology deployment environment, as shown in the following
Gold Topology configuration figure.

Deployment Environments

Deployment Environmeants

Use this page to manage deployment environments that are based on
environments,

Deployment environmeit patterns set up typical business integration e
Use custem deployment environments te fine tune a configuration for

EHStart.| !Stup| leew... | | Remaove | | Import... 1T Export... |
SeFect| Deployment Environment Name £ Status o |
O ‘M.'T_UM g ‘
Total 1

Figure 71. Deployment environment

* Deploy the adapter and the adapter applications (EAR files) in the AppTarget
(the target that hosts the SCA container).

erver clusters

Server clusters

Use this page to change the configuration settings for a cluster. A server cluster consists
member servers fails, requests will be routed to other members of the cluster. Learn mo
activity provides a list of task steps and more general information about the topic.

Preferences

[Wew| | Delete | [Start| [Stop| | Ripplestat | | ImmediateStop |

Sele.l:ti Name & Status ()
‘ F MyTopology.AppTarget &
i D MyTopology.Messaging &
| i MyTopology.Support >3
| Total 2

Figure 72. Deployment environment showing server clusters

About this task

To create an application with the node level adapter and activation specification
properties specified in the module itself, use the external service wizard.

Procedure

1. In the Service Configuration Properties window, from the Deploy connector
project property list, select On server for use by multiple applications.

2. From the Connection properties list, select Use JNDI lookup name
configured on server.
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1.

12.

13.
14.

15.
16.

17.

18.

19.

20.

21.

22.

23.

In the JNDI lookup name property field, specify the JNDI name. Use this
same JNDI name when you create the activation specification from the Admin
Console.

Create the module as described in the [Business process management samples|
[for WebSphere Adapters|

In the Dependencies option for the module, ensure that the Deploy with
module option is not selected for the adapter.

If the server is not running, right-click your server in the Servers view and
select Start.

When the server status changes to Started, right-click the server and select
Administration > Run administrative console. Log on to the administrative
console.

To install the adapter at the node level, click Resources > Resource Adapters
> Resource adapters. In the clustered environment, you must install the
adapter in each node separately.

In the Resource adapters page, click Install RAR.

In the Install RAR file page, click Browse and navigate to the RAR file for
your adapter. Deploy the RAR on each node.

The RAR files are typically installed in the following path:
IID installation directory/ResourceAdapters/adapter _name/adapter.rar

For deployment at node level, do not select any Scope because the scope is
always Node. Click Next.

Optional: In the Resource adapters page, change the name of the adapter and
add a description. Click OK.

Click Save in the Messages box at the top of the page.

To install the RAR at the cluster level, click Resources > Resource Adapters >
Resource adapters

In the Resource adapters page, set the Scope to Cluster, and then click New.

Select the RAR deployed at the node level, and then check if the adapter RAR
is now deployed at the cluster level. Deploy the application after the adapter
is deployed at the node level on the individual nodes, and then at the cluster
level.

From the Deployment Manager Admin Console, click Install applications to
deploy the application.

In the Admin Console, click Resources > Resource Adapters > IBM
WebSphere Adapter for Email > J2C activation specifications > New to
create the activation specification from the adapter deployed at the cluster
level.

When installing the adapter, in the Name field, you must enter the same name
as defined in the RAR.

In the JNDI name field, you must enter the same name as given during the
module creation.

Click Resources > Resource Adapters > IBM WebSphere Adapter for Email
> J2C activation specifications to check if the JNDI reference on the adapter is
same as the one specified for the module.

Click Resources > Resource Adapters > IBM WebSphere Adapter for Email
> J2C activation specifications > Custom properties to set values for the
activation specification in the Admin Console.

From the Deployment Manager Admin console, click Install applications to
deploy the application after you deploy the RAR and create the activation
specification.
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24. On the Step 2: Map modules to servers page, select the module and click
Next. The adapter is not part of the deployed application.

Results

The resource adapter is deployed at the node level, with the JNDI activation
specification reference.
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Chapter 7. Administering the adapter module

When you are running the adapter in a stand-alone deployment, use the
administrative console of the server to start, stop, monitor, and troubleshoot the
adapter module. In an application that uses an embedded adapter, the adapter
module starts or stops when the application is started or stopped.

Configuring logging and tracing

Configure logging and tracing to suit your requirements. Enable logging for the
adapter to control the status of event processing. Change the adapter log and trace
file names to separate them from other log and trace files.

Configuring logging properties
Use the Process Administrative Console to enable logging and to set the output
properties for a log, including the location, level of detail, and output format of the
log.

About this task

Before the adapters can log monitored events, you must specify the service
component event points that you want to monitor, what level of detail you require
for each event, and format of the output used to publish the events to the logs.
Use the administrative console to perform the following tasks:

* Enable or disable a particular event log

* Specify the level of detail in a log

* Specify where log files are stored and how many log files are kept
* Specify the format for log output

If you set the output for log analyzer format, you can open trace output using
the Log Analyzer tool, which is an application included with your IBM Process
Server. This is useful if you are trying to correlate traces from two different
server processes, because it allows you to use the merge capability of the Log
Analyzer.

Note: For more information about monitoring on a IBM Process Server, including
service components and event points, see |http://publib.boulder.ibm.com /|
infocenter /dmndhelp /v7r5m1/topic/com.ibm.wbpm.admin.doc/topics/|
welcome_wps_mon.html|

You can change the log configuration statically or dynamically. Static configuration
takes effect when you start or restart the application server. Dynamic or run time
configuration changes apply immediately.

When a log is created, the detail level for that log is set from the configuration
data. If no configuration data is available for a particular log name, the level for
that log is obtained from the parent of the log. If no configuration data exists for
the parent log, the parent of that log is checked, and so on, up the tree, until a log
with a non-null level value is found. When you change the level of a log, the
change is propagated to the child logs, which recursively propagate the change to
their child log, as necessary.

© Copyright IBM Corp. 2006, 2012 129


http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5m1/topic/com.ibm.wbpm.admin.doc/topics/welcome_wps_mon.html
http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5m1/topic/com.ibm.wbpm.admin.doc/topics/welcome_wps_mon.html
http://publib.boulder.ibm.com/infocenter/dmndhelp/v7r5m1/topic/com.ibm.wbpm.admin.doc/topics/welcome_wps_mon.html

To enable logging and set the output properties for a log, use the following
procedure.

Procedure

1.

In the navigation pane of the administrative console, select Servers >
WebSphere application servers.

2. Click the name of the server that you want to work with.
3. Under Troubleshooting, click Logging and tracing.

4. Click Change log detail levels.

5. Specify when you want the change to take effect:

* For a static change to the configuration, click the Configuration tab.

* For a dynamic change to the configuration, click the Runtime tab.

6. Click the names of the packages whose logging level you want to modify. The
package names for WebSphere Adapters start with com.ibm.j2ca.*:

* For the adapter base component, select com.ibm.j2ca.base.*.

* For the adapter base component and all deployed adapters, select

com.ibm.j2ca.*.

* For the WebSphere Adapter for Email only, select the com.ibm.j2ca.email.*

package.
7. Select the logging level.

Logging Level Description

Fatal The task cannot continue or the component cannot function.

Severe The task cannot continue, but the component can still function.
This logging level also includes conditions that indicate an
impending fatal error, that is, situations that strongly suggest that
resources are on the verge of being depleted.

Warning A potential error has occurred or a severe error is impending.
This logging level also includes conditions that indicate a
progressive failure, for example, the potential leaking of
resources.

Audit A significant event has occurred that affects the server state or
resources.

Info The task is running. This logging level includes general
information outlining the overall progress of a task.

Config The status of a configuration is reported or a configuration
change has occurred.

Detail The subtask is running. This logging level includes general
information detailing the progress of a subtask.

8. Click Apply.
9. Click OK.
10. Optional: To have static configuration changes take effect, stop and then
restart the IBM Process Server.
Results

Log entries from this point forward contain the specified level of information for
the selected adapter components.
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Changing the log and trace file names

To keep the adapter log and trace information separate from other processes, use
the administrative console to change the file names. By default, log and trace
information for all processes and applications on a IBM Process Server is written to
the SystemOut.log and trace.log files.

Before you begin

You can change the log and trace file names at any time after the adapter module
has been deployed to an application server.

About this task

You can change the log and trace file names statically or dynamically. Static
changes take effect when you start or restart the application server. Dynamic or
run time changes apply immediately.

Log and trace files are in the install_root/profiles/profile_name/10gs/
server_name folder.

To set or change the log and trace file names, use the following procedure.

Procedure

1. In the navigation pane of the administrative console, select Applications
>Application Types>WebSphere enterprise applications.

2. In the Enterprise Applications list, click the name of the adapter application.
This is the name of the EAR file for the adapter, but without the ear file
extension. For example, if the EAR file is named Accounting_OutboundApp.ear,
then click Accounting_OutboundApp.

In the Configuration tab, select Modules>Manage Modules.

In the list of modules, click IBM WebSphere Adapter for Email.

In the Configuration tab, under Additional Properties, click Resource Adapter.
In the Configuration tab, under Additional Properties, click Custom properties.
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In the Custom Properties table, change the file names.

a. Click either logFilename to change the name of the log file or
traceFilename to change the name of the trace file.

b. In the Configuration tab, type the new name in the Value field. By default,
the log file is called SystemOut.log and the trace file is called trace.log.

c. Click Apply or OK. Your changes are saved on your local machine.

d. To save your changes to the master configuration on the server, use one of
the following procedures:

¢ Static change: Stop and restart the server. This method allows you to
make changes, but those changes do not take effect until you stop and
start the server.

* Dynamic change: Click the Save link in the Messages box above the
Custom properties table. Click Save again when prompted.
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Changing configuration properties for embedded adapters

To change the configuration properties after you deploy the adapter as part of a
module, you use the administrative console of the runtime environment. You can
update resource adapter properties (used for general adapter operation), managed
connection factory properties (used for outbound processing), and activation
specification properties (used for inbound processing). For information about
configuring logging properties and changing the log and trace file names, see
[“Configuring logging and tracing” on page 129)

Setting resource adapter properties for embedded adapters

To set resource adapter properties for your adapter after it has been deployed as
part of a module, use the administrative console. You select the name of the
property you want to configure and then change or set the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

Custom properties are default configuration properties shared by all IBM
WebSphere Adapters.

To configure properties using the administrative console, use the following
procedure:

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Select Applications > Application Types > WebSphere enterprise
application.

5. From the Enterprise Applications list, click the name of the adapter module
whose properties you want to change. The Configuration page is displayed.
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Figure 73. The Manage Modules selection in the Configuration tab

6. Under Modules, click Manage Modules.
Click IBM WebSphere Adapter for Email.
From the Additional Properties list, click Resource Adapter.
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On the next page, from the Additional Properties list, click Custom
properties.

10. For each property you want to change, perform the following steps.

Note: See ['Resource adapter properties” on page 186| for more information
about these properties.

a. Click the name of the property. The Configuration page for the selected
property is displayed.

b. Change the contents of the Value field or type a value, if the field is
empty.

c. Click OK.

11. In the Messages area, click Save.
Results

The resource adapter properties associated with your adapter module are changed.
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Setting managed (J2C) connection factory properties for
embedded adapters

To set managed connection factory properties for your adapter after it has been
deployed as part of a module, use the administrative console. You select the name
of the property you want to configure and then change or set the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

You use managed connection factory properties to configure the target mail server
instance.

Note: In the administrative console, the properties are referred to as "J2C
connection factory properties.”

To configure properties using the administrative console, use the following
procedure.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.
4. Select Applications > Application Types > WebSphere enterprise
application.

5. In the Enterprise Applications list, click the name of the adapter module
whose properties you want to change.
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Figure 74. The Manage Modules selection in the Configuration tab
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10.

11.

12.

13.

Under Modules, click Manage Modules.
Click IBM WebSphere Adapter for Email.
In the Additional Properties list, click Resource Adapter.

On the next page, from the Additional Properties list, click J2C connection
factories.

Click the name of the connection factory associated with your adapter
module.

In the Additional Properties list, click Custom properties.

Custom properties are those J2C connection factory properties that are unique
to IBM WebSphere Adapter for Email. Connection pool and advanced
connection factory properties are properties you configure if you are
developing your own adapter.

For each property you want to change, perform the following steps.

Note: See [‘Managed connection factory properties” on page 179|for more
information about these properties.

a. Click the name of the property.

b. Change the contents of the Value field or type a value, if the field is
empty.

c. Click OK.

In the Messages area, click Save.
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Results

The managed connection factory properties associated with your adapter module
are changed.

Setting activation specification properties for embedded
adapters

To set activation specification properties for your adapter after it has been
deployed as part of a module, use the administrative console. You select the name
of the message endpoint property you want to configure, and then change or set
the value.

Before you begin

Your adapter module must be deployed on IBM Business Process Manager or
WebSphere Enterprise Service Bus.

About this task

You use activation specification properties to configure the endpoint for inbound
processing.

To configure properties using the administrative console, use the following
procedure.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Select Applications > Application Types > WebSphere enterprise
application.

5. From the Enterprise Applications list, click the name of the adapter module
whose properties you want to change.
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Figure 75. The Manage Modules selection in the Configuration tab

6. Under Modules, click Manage Modules.
Click IBM WebSphere Adapter for Email.
From the Additional Properties list, click Resource Adapter.
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On the next page, from the Additional Properties list, click J2C activation
specifications.

10. Click the name of the activation specification associated with the adapter
module.

11. From the Additional Properties list, click J2C activation specification custom
properties.

12. For each property you want to change, perform the following steps.

Note: See [“Activation specification properties” on page 195|for more
information about these properties.

a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is
empty.
c. Click OK.
13. In the Messages area, click Save.

Results

The activation specification properties associated with your adapter module are
changed.
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Changing configuration properties for stand-alone adapters

To set configuration properties after you install a stand-alone adapter, use the
administrative console of the runtime environment. Provide the general
information about the adapter and then set the resource adapter properties (which
are used for general adapter operation). If the adapter is used for outbound
operations, create a connection factory and then set the properties for it. If the
adapter is used for inbound operations, create an activation specification and then
set the properties for it. For information about configuring logging properties and

chaniini the log and trace file names, see [“Configuring logging and tracing” on|
page 129.

Setting resource adapter properties for stand-alone adapters

To set resource adapter properties for your stand-alone adapter after it has been
installed on IBM Business Process Manager or WebSphere Enterprise Service Bus,
use the administrative console. You select the name of the property you want to
configure and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

Custom properties are default configuration properties shared by all IBM
WebSphere Adapters.

To configure properties using the administrative console, use the following
procedure:

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

Log on to the administrative console.

Click Resources > Resource Adapters > Resource adapters.

In the Resource adapters page, click IBM WebSphere Adapter for Email.
In the Additional Properties list, click Custom properties.
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For each property you want to change, perform the following steps.

Note: See[‘Resource adapter properties” on page 186 for more information
about these properties.

a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is empty.
c. Click OK.

8. In the Messages area, click Save.
Results

The resource adapter properties associated with your adapter are changed.
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Setting managed (J2C) connection factory properties for
stand-alone adapters

To set managed connection factory properties for your stand-alone adapter after it
has been installed on IBM Business Process Manager or WebSphere Enterprise
Service Bus, use the administrative console. You select the name of the property
you want to configure and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

You use managed connection factory properties to configure the target mail server
instance.

Note: In the administrative console, the properties are referred to as "J2C
connection factory properties."

To configure properties using the administrative console, use the following
procedure:

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

Log on to the administrative console.

Click Resources > Resource Adapters > Resource adapters.

In the Resource adapters page, click IBM WebSphere Adapter for Email.
In the Additional Properties list, click J2C connection factories.
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If you are going to use an existing connection factory, skip ahead to
[from the list of existing connection factories]

Note: If you have selected Specify connection properties when you use the
external service wizard to configure the adapter module, you do not need to
create a connection factory.

If you are creating a connection factory, perform the following steps:
a. Click New.

b. In the General Properties section of the Configuration tab, type a name
for the connection factory. For example, you can type AdapterCF.

c. Type a value for JNDI name. For example, you can type
com/eis/AdapterCF.

d. Optional: Select an authentication alias from the Component-managed
authentication alias list.

e. Click OK.
f. In the Messages area, click Save.
The newly created connection factory is displayed.
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Figure 76. User-defined connection factories for use with the resource adapter

8. In the list of connection factories, click the one you want to use.
9. In the Additional Properties list, click Custom properties.

Custom properties are those J2C connection factory properties that are unique
to WebSphere Adapter for Email. Connection pool and advanced connection
factory properties are properties you configure if you are developing your
own adapter.

10. For each property you want to change, perform the following steps.

Note: See [“Managed connection factory properties” on page 179| for more
information about these properties.

a. Click the name of the property.
b. Change the contents of the Value field or type a value, if the field is
empty.
c. Click OK.
11. After you have finished setting properties, click Apply.
12. In the Messages area, click Save.

Results

The managed connection factory properties associated with your adapter are set.

Setting activation specification properties for stand-alone
adapters

To set activation specification properties for your stand-alone adapter after it has
been installed on IBM Business Process Manager or WebSphere Enterprise Service
Bus, use the administrative console. You select the name of the message endpoint
property you want to configure, and then change or set the value.

Before you begin

Your adapter must be installed on IBM Business Process Manager or WebSphere
Enterprise Service Bus.

About this task

You use activation specification properties to configure the endpoint for inbound
processing.

To configure properties using the administrative console, use the following
procedure.
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Procedure

1.
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10.

If the server is not running, right-click your server in the Servers view and
select Start.

When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

Log on to the administrative console.

Click Resources > Resource Adapters > Resource adapters.

In the Resource adapters page, click IBM WebSphere Adapter for Email.

In the Additional Properties list, click J2C activation specifications.

If you are going to use an existing activation specification, skip ahead to

[from an existing list of activation specifications

Note: If you have selected Use predefined connection properties when you
use the external service wizard to configure the adapter module, you must
create an activation specification.

If you are creating an activation specification, perform the following steps:
a. Click New.

b. In the General Properties section of the Configuration tab, type a name
for the activation specification. For example, you can type AdapterAS.

c. Type a value for JNDI name. For example, you can type
com/eis/AdapterAS.

Optional: Select an authentication alias from the Authentication alias list.
Select a message listener type.

Click OK.

Click Save in the Messages box at the top of the page.
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The newly created activation specification is displayed.
In the list of activation specifications, click the one you want to use.

In the Additional Properties list, click J2C activation specification custom
properties.

For each property you want to set, perform the following steps.

Note: See [“Activation specification properties” on page 195|for more
information about these properties.

a. Click the name of the property.

b. Change the contents of the Value field or type a value, if the field is
empty.

c. Click OK.

11. After you have finished setting properties, click Apply.

12.

In the Messages area, click Save.

Results

The activation specification properties associated with your adapter are set.

Starting the application that uses the adapter

Use the administrative console of the server to start an application that uses the
adapter. By default, the application starts automatically when the server starts.
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About this task

Use this procedure to start the application, whether it is using an embedded or a
stand-alone adapter. For an application that uses an embedded adapter, the
adapter starts when the application starts. For an application that uses a
stand-alone adapter, the adapter starts when the application server starts.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Click Applications > Application Types > WebSphere enterprise applications.

Note: The administrative console is labeled “Integrated Solutions Console”.

5. Select the application that you want to start. The application name is the name
of the EAR file you installed, without the .EAR file extension.

6. Click Start.
Results

The status of the application changes to Started, and a message stating that the
application has started displays at the top of the administrative console.

Stopping the application that uses the adapter

Use the administrative console of the server to stop an application that uses the
adapter. By default, the application stops automatically when the server stops.

About this task

Use this procedure to stop the application, whether it is using an embedded or a
stand-alone adapter. For an application with an embedded adapter, the adapter
stops when the application stops. For an application that uses a stand-alone
adapter, the adapter stops when the application server stops.

Procedure

1. If the server is not running, right-click your server in the Servers view and
select Start.

2. When the server status changes to Started, right-click the server and select
Administration > Run administrative console.

3. Log on to the administrative console.

4. Click Applications > Application Types > WebSphere enterprise applications.

Note: The administrative console is labeled “Integrated Solutions Console”.

5. Select the application that you want to stop. The application name is the name
of the EAR file you installed, without the .EAR file extension.

6. Click Stop.
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Results

The status of the application changes to Stopped, and a message stating that the
application has stopped is displayed at the top of the administrative console.

Monitoring performance using Performance Monitoring Infrastructure

Performance Monitoring Infrastructure (PMI) is a feature of the administrative
console that allows you to dynamically monitor the performance of components in
the production environment, including IBM WebSphere Adapter for Email. PMI
collects adapter performance data, such as average response time and total number
of requests, from various components in the server and organizes the data into a
tree structure. You can view the data through the Tivoli® Performance Viewer, a
graphical monitoring tool that is integrated with the Process Administrative
Console in IBM Business Process Manager or WebSphere Enterprise Service Bus.

About this task

You can monitor the performance of your adapter by having PMI collect data at
the following points:

* At outbound processing to monitor outbound requests.

¢ At inbound event retrieval to monitor the retrieval of an event from the event
table.

* At inbound event delivery to monitor the delivery of an event to the endpoint
or endpoints.

Before you enable and configure PMI for your adapter, you must first set the level
of tracing detail and run some events from which to gather performance data.

To learn more about how PMI can help you monitor and improve the overall
performance of your adapter environment, search for PMI on the IBM Business
Process Manager or WebSphere Enterprise Service Bus website:

http:/ /www.ibm.com /software /webservers/appserv/was/library /|

Configuring Performance Monitoring Infrastructure

You can configure Performance Monitoring Infrastructure (PMI) to gather adapter
performance data, such as average response time and total number of requests.
After you configure PMI for your adapter, you can monitor the adapter
performance using Tivoli Performance viewer.

Before you begin

Before you can configure PMI for your adapter, you must first set the level of

tracing detail and run some events to gather the performance data.

1. To enable tracing and to receive event data, the trace level must be set to either
fine, finer, finest, or all. After *=info, add a colon and a string, for example:

*=info: WBILocationMonitor.CEI.ResourceAdapter.
*=finest: WBILocationMonitor.LOG.ResourceAdapter.*=finest:

For instructions on setting the trace level, see [‘Enabling tracing with the]
[Common Event Infrastructure” on page 146

2. Generate at least one outbound request or inbound event to produce
performance data that you can configure.
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Procedure
1. Enable PMI for your adapter.

a. In the administrative console, expand Monitoring and Tuning, and then
select Performance Monitoring Infrastructure (PMI).

From the list of servers, click the name of your server.

Select the Configuration tab, and then select the Enable Performance
Monitoring (PMI) check box.

d. Select Custom to selectively enable or disable statistics.

Performance Monitoring Infrastructure (PMI) > serverl

Configuration and Runtime Settings for Performance Monitoring Infrastructure (PMI)

Runtime Configuration

General Properties

Enable Perfarmance Monitoring Infrastructure (BMI)
D Use sequential counter updates

Currently monitored statistic set

O None

Mo statistics are enzabled

OBEIEiE

Provides basic monitoring (J2EE + Top statistics)

) Extended

Provides extended monitoring (Basic + WebSphere
components)

Qan

All statistics are enabled

@ Custom

Provides fine-grained control to selectively enable statistics

Figure 77. Enabling Performance Monitoring Infrastructure

e. Click Apply or OK.
f. Click Save. PMI is now enabled.
2. Configure PMI for your adapter.

a. In the administrative console, expand Monitoring and Tuning, and then
select Performance Monitoring Infrastructure (PMI).

b. From the list of servers, click the name of your server.
Select Custom.
d. Select the Runtime tab. The following figure shows the Runtime tab.
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Figure 78. Runtime tab used for configuring PMI

e. Click WBIStats.RootGroup. This is a PMI sub module for data collected in
the root group. This example uses the name WBIStats for the root group.

f. Click ResourceAdapter. This is a sub module for the data collected for the

JCA adapters.

g. Click the name of your adapter, and select the processes you want to

monitor.

h. In the right pane, select the check boxes for the statistics you want to
gather, and then click Enable.

Results

PMI is configured for your adapter.

What to do next

Now you can view the performance statistics for your adapter.

Viewing performance statistics

You can view adapter performance data through the graphical monitoring tool,
Tivoli Performance Viewer. Tivoli Performance Viewer is integrated with the

Process Administrative Console in IBM Business Process Manager or WebSphere
Enterprise Service Bus.

Before you begin

Configure Performance Monitoring Infrastructure for your adapter.

Procedure
1.

Performance Viewer, then select Current Activity.
2. In the list of servers, click the name of your server.
3.

In the administrative console, expand Monitoring and Tuning, expand

Under your server name, expand Performance Modules.
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4. Click WBIStatsRootGroup.
Click ResourceAdapter and the name of your adapter module.

5.

6. If there is more than one process, select the check boxes for the processes
whose statistics you want to view.

Results

The statistics are displayed in the right panel. You can click View Graph to view a
graph of the data, or View Table to see the statistics in a table format.

The following figure shows adapter performance statistics.
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Figure 79. Adapter performance statistics, using graph view

Enabling tracing with the Common Event Infrastructure

146

The adapter can use the Common Event Infrastructure (CEI), a component
embedded in the server, to report data about critical business events such as the
starting or stopping of a poll cycle. Event data can be written to a database or a

trace log file depending on configuration settings.

About this task

Use this procedure to report CEI entries in the trace log file by using the Common
Base Event Browser within the administrative console.
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Procedure

1.

6.

In the administrative console, click Troubleshooting.

2. Click Logs and Trace.
3.
4. In the Change Log Detail Levels box, click the name of the CEI database (for

From the list of servers, click the name of your server.

example, WBIEventMonitor.CEL.ResourceAdapter.”) or the trace log file (for
example, WBIEventMonitor.LOG.ResourceAdapter.*) to which you want the
adapter to write event data.

Select the level of detail about business events that you want the adapter to
write to the database or trace log file, and (optionally) adjust the granularity of
detail associated with messages and traces.

* No Logging. Turns off event logging.
¢ Messages Only. The adapter reports an event.
* All Messages and Traces. The adapter reports details about an event.

* Message and Trace Levels. Settings for controlling the degree of detail the
adapter reports about the business object payload associated with an event. If
you want to adjust the detail level, select one of the following options:

Fine. The adapter reports the event but none of the business object payload.

Finer. The adapter reports the event and the business object payload
description.

Finest. The adapter reports the event and the entire business object payload.

Note: The WebSphere Adapter for Email also provides the following logging
information.

- Logs all the SMTP, POP, and IMAP commands issued to the mail server
and their responses in the trace log file.

- Logs the adapter foundation class (AFC) version, Java Mail API version,
and third-party version artifacts in the trace file.

Click OK.

Results

Event logging is enabled. You can view CEI entries in the trace log file or by using
the Common Base Event Browser within the administrative console.
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Chapter 8. Troubleshooting and support

Common troubleshooting techniques and self-help information help you identify
and solve problems quickly. For information about configuring logging properties

and changing the log and trace file names, see [“Configuring logging and tracing”|
En Eaée 129,

Techniques for troubleshooting problems

Troubleshooting is a systematic approach to solving a problem. The goal is to
determine why something does not work as expected and how to resolve the
problem. Certain common techniques can help with the task of troubleshooting.

The first step in the troubleshooting process is to describe the problem completely.
Without a problem description, neither you or IBM® can know where to start to
find the cause of the problem. This step includes asking yourself basic questions,
such as:

* What are the symptoms of the problem?

* Where does the problem occur?

* When does the problem occur?

* Under which conditions does the problem occur?

¢ Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem,
and that is the best way to start down the path of problem resolution.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is "What is the

problem?" Which might seem like a straightforward question; however, you can

break it down into several more-focused questions that create a more descriptive

picture of the problem. These questions can include:

* Who, or what, is reporting the problem?

* What are the error codes and messages?

* How does the system fail? For example, is it a loop, hang, lock up, performance
degradation, or incorrect result?

* What is the business impact of the problem?

Where does the problem occur?

Determining where the problem originates is not always simple, but it is one of the
most important steps in resolving a problem. Many layers of technology can exist
between the reporting and failing components. Networks, disks, and drivers are
only a few components to be considered when you are investigating problems.

The following questions can help you to focus on where the problem occurs in

order to isolate the problem layer.

¢ Is the problem specific to one platform or operating system, or is it common for
multiple platforms or operating systems?

* Is the current environment and configuration supported?

Remember that if one layer reports the problem, the problem does not necessarily
originate in that layer. Part of identifying where a problem originates is
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understanding the environment in which it exists. Take some time to completely
describe the problem environment, including the operating system and version, all
corresponding software and versions, and hardware information. Confirm that you
are running within an environment that is a supported configuration; many
problems can be traced back to incompatible levels of software that are not
intended to run together or have not been fully tested together.

When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for those
cases that are one-time occurrences. You can most simply do this by working
backward: Start at the time an error was reported (as precisely as possible, even
down to the millisecond), and work backward through the available logs and
information. Typically, you need to look only as far as the first suspicious event
that you find in a diagnostic log; however, this is not always simple to do and
takes practice. Knowing when to stop looking is especially difficult when multiple
layers of technology are involved, and when each has its own diagnostic
information.

To develop a detailed timeline of events, answer the following questions:

* Does the problem happen only at a certain time of day or night?

* How often does the problem happen?

* What sequence of events leads up to the time that the problem is reported?

* Does the problem happen after an environment change, such as upgrading or
installing software or hardware?

Responding to these types of questions can provide you with a frame of reference
in which to investigate the problem.

Under which conditions does the problem occur?

Knowing what other systems and applications are running at the time that a
problem occurs is an important part of troubleshooting. These and other questions
about your environment can help you to identify the root cause of the problem:

* Does the problem always occur when the same task is being performed?

* Does a certain sequence of events need to occur for the problem to surface?

* Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in
which the problem occurs and correlate any dependencies. Remember that just
because multiple problems might have occurred around the same time, the
problems are not necessarily related.

Can the problem be reproduced?

From a troubleshooting standpoint, the "ideal" problem is one that can be
reproduced. Typically with problems that can be reproduced, you have a larger set
of tools or procedures at your disposal to help you investigate. Consequently,
problems that you can reproduce are often simpler to debug and solve. However,
problems that you can reproduce can have a disadvantage: If the problem is of
significant business impact, you do not want it to recur! If possible, re-create the
problem in a test or development environment, which typically offers you more
flexibility and control during your investigation.

Tip: Simplify the scenario to isolate the problem to a suspected component.
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The following questions can help you with reproducing the problem:

¢ Can the problem be re-created on a test machine?

* Are multiple users or applications encountering the same type of problem?

* Can the problem be re-created by running a single command, a set of
commands, a particular application, or a stand-alone application?

Adapter returns version conflict exception message
Adapter returns version conflict exception message

Problem

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation jar, and if a lower version of the
CWYBS_AdapterFoundation.jar is loaded during run time, the adapter returns the
ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for Email version 7.5.0.3, the following error message is
displayed "The version of CWYBS_AdapterFoundation.jar is not compatible with
IBM WebSphere Adapter for Email" as IBM WebSphere Adapter for Email loads
file:/C:/IBM/WebSphere/ProcServer7 / profiles / ProcSrv01/installedConnectors /
CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with version 7.0.0.3.
However, the base level of this jar required is version 7.5.0.3. To overcome this
conflict, you must migrate all adapters to the same version level.

Solution

Migrate all adapters to the same version level.

For further assistance, visit [http:/ /www.ibm.com /support /|
[docview.wss?uid=swg27006249]

Log and Trace Analyzer

The adapter creates log and trace files that can be viewed with the Log and Trace
Analyzer.

The Log and Trace Analyzer can filter log and trace files to isolate the messages
and trace information for the adapter. It can also highlight the messages of an
adapter and trace information in the log viewer.

The adapter's component ID for filtering and highlighting is a string composed of
the characters EMARA plus the value of the adapter ID property. For example, if the
adapter ID property is set to 001, the component ID is EMARAGO1.

If you run multiple instances of the same adapter, ensure that the first eight
characters of the adapter ID property are unique for each instance so that you can
correlate the log and trace information to a particular adapter instance. By making
the first seven characters of an adapter ID property unique, the component ID for
multiple instances of that adapter is also unique, allowing you to correlate the log
and trace information to a particular instance of an adapter. For example, when
you set the adapter ID property of two instances of WebSphere Adapter for Email
to 001 and 002. The component IDs for those instances, EMARAOO1 and EMARAQO2, are
short enough to remain unique, enabling you to distinguish them as separate
adapter instances. However, instances with longer adapter ID properties cannot be
distinguished from each other. If you set the adapter ID properties of two instances
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to Instance@l and Instance02, you will not be able to examine the log and trace
information for each adapter instance because the component ID for both instances
is truncated to EMARAInstanc.

For outbound processing, the adapter ID property is located in both the resource
adapter and managed connection factory property groups. If you update the
adapter ID property after using the external service wizard to configure the
adapter for outbound processing, be sure to set the resource adapter and managed
connection factory properties consistently. It prevents inconsistent marking of the
log and trace entries. For inbound processing, the adapter ID property is located
only in the resource adapter properties, so this consideration does not apply.

The data binding component, which converts between business objects and the
native data formats in email text and attachments, does not use the adapter
component ID when generating log and trace messages. Instead, it uses a string
that indicates which data binding generated the message. lists the
component ID used by each adapter-specific data binding for WebSphere Adapter
for Email. For custom data bindings, the data binding must set the component ID.

Table 7. Component IDs for adapter-specific data bindings

Data binding Component ID
EmailSimpleDataBinding EMARASEDB
EmailWrapperDataBinding EMARAEWDB
EmailFixedStructureDataBinding EMARAFSDB

For more information, see the [“Adapter ID (AdapterID)” on page 187 property.

First-failure data capture (FFDC) support

The adapter supports first-failure data capture (FFDC), which provides persistent
records of failures and significant software incidents that occur during run time in
IBM Business Process Manager or WebSphere Enterprise Service Bus.

The FFDC feature runs in the background and collects events and errors that occur
at run time. The feature provides a means for associating failures to one another,
allowing software to link the effects of a failure to their causes, and facilitate the
quick location of the root cause of a failure. The data that is captured can be used
to identify exception processing that occurred during the adapter run time.

When a problem occurs, the adapter writes exception messages and context data to
a log file, which is in the install_root/profiles/profile/logs/ffdc directory.

For more information about first-failure data capture (FFDC), see the IBM Business
Process Manager or WebSphere Enterprise Service Bus documentation.

Disabling end point applications of the passive adapter

Problem

In the active-passive configuration mode of the adapters, the endpoint application
of the passive adapter instance also listens to the events or messages even if the
enableHASupport property is set to True.
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Cause

By default, in WebSphere Application Server, the alwaysactivateA11MDBs property
in the JMS activation specification is set to True. This enables the endpoint
application of all the adapter (active or passive) instances to listen to the events.

Solution

To stop the endpoint application of the passive adapter instance from listening to
the events, you must set the alwaysactivateATIMDBs property value to False. The
JMS activation specification is associated with one or more MDBs and provides the
necessary configuration to receive events. If the alwaysActivateAT1MDBs property is
set to False, then the endpoint application of only the active adapter instance
receives the events.

Perform the following procedure, to set the alwaysActivateA11MDBs property to
False.

1. Log on to the Process Administrative Console.

2. Go to Resources> JMS > Activation specifications.

Click the activation specification corresponding to the application from the list.
Click Custom properties under Additional properties.

Click alwaysActivateAIIMDBs.

Change the value to False.

Click Apply and OK.

N o ok~

Result

The endpoint application of only the active adapter instance listens to the events.

Solutions to common problems

Some of the problems you might encounter while running WebSphere Adapter for
Email with your database are described along with solutions and workaround.
These problems and solutions are in addition to those documented as technotes on
the software support website.

For a complete list of technotes about WebSphere Adapters, see
http:/ /www.ibm.com /support/ search.wss?tc:SSMKUK&rs=695&rank=8|
&dc=DB520+D800+D900+DA900+DA800+DB560&d tm}

Adapter returns version conflict exception message
Problem

When you install multiple adapters with different versions of
CWYBS_AdapterFoundation jar, and if a lower version of the
CWYBS_AdapterFoundation jar is loaded during run time, the adapter returns the
ResourceAdapterInternalException error message, due to a version conflict. For
example, when you install Oracle E-Business Suite adapter version 7.0.0.3 and
WebSphere Adapter for Email version 7.5.0.3, the following error message is
displayed "The version of CWYBS_AdapterFoundation jar is not compatible with
IBM WebSphere Adapter for Email" as IBM WebSphere Adapter for Email loads
file:/C:/IBM/WebSphere /ProcServer?7 / profiles / ProcSrv01/installedConnectors /
CWYOE_OracleEBS.rar/CWYBS_AdapterFoundation.jar with version 7.0.0.3.

Chapter 8. Troubleshooting and support 153


http://www.ibm.com/support/search.wss?tc=SSMKUK&rs=695&rank=8&dc=DB520+D800+D900+DA900+DA800+DB560&dtm
http://www.ibm.com/support/search.wss?tc=SSMKUK&rs=695&rank=8&dc=DB520+D800+D900+DA900+DA800+DB560&dtm

However, the base level of this jar required is version 7.5.0.3. To overcome this
conflict, you must migrate all adapters to the same version level.

Solution

Migrate all adapters to the same version level.

For further assistance, visit [http: / /www.ibm.com /support/|
[docview.wss?uid=swg27006249]

Unable to start adapter through webservices
Problem

After configuring the adapter, you might note that:

1. the webservices client based on the WSDL is not getting generated properly in
IBM Integration Designer.

2. you may not be able to invoke the WSDL using certain webservices client, such
as RESTUI firefox plugin and soapUI tool.

Solution

Perform the following steps to enable the adapter module to load the ASI file.
Create a library project.

Change to the Enterprise Explorer view in IBM Integration Designer.

Locate the ASI file of the adapter in connector project -> connectorModule.
Copy the ASI file of the adapter and paste it in the library project.

Add the library project to the list of dependencies for the adapter module.

ook wn -

Clean project.

Support

This section provides information about how to troubleshoot a problem with your
IBM® software, including instructions for searching knowledge bases, downloading
fixes, and obtaining support.

Searching knowledge bases (Web search)

You can often find solutions to problems by searching IBM knowledge bases. You
can optimize your results by using available resources, support tools, and search
methods.

About this task

You can find useful information by searching the information center for Product X.
However, sometimes you need to look beyond the information center to answer
your questions or resolve problems.

To search knowledge bases for information that you need, use one or more of the
following approaches:

* Search for content by using the IBM® Support Assistant (ISA).

ISA is a no-charge software serviceability workbench that helps you answer
questions and resolve problems with IBM software products. You can find
instructions for downloading and installing ISA on the ISA
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* Find the content that you need by using the [I[BM Support Portall

The IBM Support Portal is a unified, centralized view of all technical support
tools and information for all IBM systems, software, and services. The IBM
Support Portal lets you access the IBM electronic support portfolio from one
place. You can tailor the pages to focus on the information and resources that
you need for problem prevention and faster problem resolution. Familiarize
yourself with the IBM Support Portal by viewing the demo videos

(https:/ /www.ibm.com/blogs/SPNA /entry/the_ibm_support_portal_videos)
about this tool. These videos introduce you to the IBM Support Portal, explore
troubleshooting and other resources, and demonstrate how you can tailor the
page by moving, adding, and deleting portlets.

* Search for content by using the IBM masthead search. You can use the IBM
masthead search by typing your search string into the Search field at the top of
any ibm.com® page.

* Search for content by using any external search engine, such as Google, Yahoo,
or Bing. If you use an external search engine, your results are more likely to
include information that is outside the ibm.com domain. However, sometimes
you can find useful problem-solving information about IBM products in
newsgroups, forums, and blogs that are not on ibm.com.

Tip: Include "IBM" and the name of the product in your search if you are looking
for information about an IBM product.

Getting Fixes

A product fix might be available to resolve your problem.
About this task
To get product fixes, perform the following steps.

Procedure

1. Determine which fix you need. Check the list of IBM WebSphere Adapter for
Email recommended fixes to confirm that your software is at the latest
maintenance level. Check the list of problems fixed in the IBM WebSphere
Adapter for Email fix readme documentation that is available for each listed fix
pack to see if IBM has already published an individual fix to resolve your
problem. To determine what fixes are available using IBM Support Assistant,
run a query on fix from the search page.

Individual fixes are published as often as necessary to resolve defects in IBM
Business Process Manager or WebSphere Enterprise Service Bus IBM
WebSphere Adapter for Email. In addition, two kinds of cumulative collections
of fixes, called fix packs and refresh packs, are published periodically for IBM
WebSphere Adapter for Email, in order to bring users up to the latest
maintenance level. You should install these update packages as early as
possible in order to prevent problems.

Note: A list of recommended, generally available (GA) fixes for the WebSphere
Java™ Connector Architecture (JCA) and WebSphere Business Integration
adapters are available If a Fix Pack is not available for an adapter, it
implies that the GA version is the recommended version and details about that
version of the adapter can be found in the Release notes.

2. Download the fix. Open the download document and follow the link in the
Download package section. When downloading the file, ensure the name of the
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maintenance file is not changed. This includes both intentional changes and
inadvertent changes caused by certain web browsers or download utilities.

3. Apply the fix. Follow the instructions in the Installation Instructions section of
the download document.

4. Optional: To receive weekly notification of fixes and updates, subscribe to My
Support e-mail updates.

Self-help resources

Use the resources of IBM software support to get the most current support
information, obtain technical documentation, download support tools and fixes,
and avoid problems with WebSphere Adapters. The self-help resources also help
you diagnose problems with the adapter and provide information about how to
contact IBM software support.

Support website

The WebSphere Adapters software support website at |http://www.ibm.com /|

lsupport/docview.wss?uid=swg27006249| provides links to many resources to help

you learn about, use, and troubleshoot WebSphere Adapters, including:

¢ Flashes (alerts about the product)

* Technical information including the product information center, manuals, IBM
Redbooks®, and whitepapers

* Educational offerings

» Technotes

Recommended fixes

A list of recommended fixes you must apply is available at the following location:
http:/ /www.ibm.com /support/docview.wss?fdoc=aimadp&rs=695|
&uid=swg27010397

Technotes

Technotes provide the most current documentation about WebSphere Adapter for

Email, including the following topics:

* Problems and their currently available solutions

* Answers to frequently asked questions

* How to information about installing, configuring, using, and troubleshooting the
adapter

* IBM Software Support Handbook

For a list of technotes for WebSphere Adapter for Email, see
01.ibm.com /support/docview.wss?uid=swg27024034}

For a list of technotes for all adapters, see |http://www.ibm.com/support/|
search.wss?tc=SSMKUK &rs=695&rank=8
&dc=DB520+D800+D900+DA900+DA800+DB560&d tm}
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Chapter 9. Reference information

To support you in your tasks, reference information includes details about business
objects that are generated by the external service wizard and information about
adapter properties, including those that support bidirectional transformation. It
also includes pointers to adapter messages and related product information.

Business object information

A business object is a structure that contains specific information about an email
being processed by an inbound or outbound module. Business objects contain
information about how the adapter processes the email content and attachments,
and also how the business objects are associated with an operation (such as
Create). Business object names are generated by the external service wizard and
are named according to their contents.

Business object structures

The adapter supports three different types of business object structures: simple
alert email, email business object, and a user-defined type business object. The
simple alert email structure sends text-only messages without attachments, the
email business object sends and receives all types of messages both for
transformed and non-transformed types, and the user-defined type sends and
receives your own fixed structure transformed type messages only.

All the business object structures include standard headers such as To and From in
the wrapper business object. For more information about the headers supported by
the adapter, see [“Header business object properties” on page 164]

Simple alert email business object structure

The simple alert email business object structure (SimpleAlertEmail) sends a single
string email message to the mail server. This structure is supported only during
the outbound communication. With the SimpleAlertEmail structure, the email
message does not undergo any formatting or transformation. The intended
recipient is a human and the body mime type is text/plain. As shown in the
following illustration, it is composed of a single business object.

[] simpleAlertEmail
[

To string
CcC string
BCC string

Subject string
Reply-To  string
Encoding  string
mailContent string

Figure 80. SimpleAlertEmail business object structure
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With this business object structure, the only required values are the From and To
fields. For more information about the values of the SimpleAlertEmail business
object structure, see the section on the SimpleAlertEmail business object structure
in the reference section of this documentation.

Email business object structure

The email business object structure is used both during inbound and outbound
communication. The adapter always creates an email business object for its specific
use. The email business object is a parent business object consisting of attributes
that directly relate to the fields in an email message. If you choose, it can also
contain child business objects for email mailContent business object and
attachments. The following illustration shows the email business object with two
child business objects: header and mailAttachments.

% (=] Email = [2J Header

[ [ =[] Mailattachment
From string headerMame string I |
To string headerValue string attachmentMame string
CC string appBOData anyType
BCC string
Subject string
Reply-To string
Date string
headerList Header []
Encoding string

mailCaontent string
mailattachments MailAttachment [ ]
fileReferences  string []

Figure 81. Email business object with mail attachment and header child objects

The header child business object shown in stores header information for
an email. The headerList attribute in the email wrapper object is an array of header
business objects. The headerList attribute might contain all the headers for an
email, each represented by a header business object. However, the standard
headers present in the email wrapper business object takes precedence over the
headers in the headerList attribute.

Note: Bcc and Resent-bce headers, cannot be retrieved from an inbound email, but
they can be set for outbound emails.

For each attachment on an inbound email, the adapter creates a separate mail
attachment business object. For every mail attachment business object the adapter
receives during outbound communications, the adapter creates a separate email
attachment. As noted in the illustration, the mail attachment business object
consists of an attachment name and the data in the attachment.

The data in an attachment can be of any type. Business objects such as Customer
or PurchaseOrder, which is defined in the business object editor before being
processed by the external service wizard and have a specific structure outlined by
you, are called structured content business objects. Similarly, you can specify a
structured business object for the mailContent attribute of the email wrapper
business object.
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Structured content business objects are decomposed by the data binding and their
content is recorded into individual logical fields within the business object
structure. Unstructured content business objects are provided by the adapter and
allow a user to send string (AsText) or bytes (AsBinary) through the adapter.
Unstructured content business objects are used for pass-through processing during
outbound communication.

Note: Because the adapter is expected to decompose each business object added to
the module, you must define a data binding mime type and a data handler during
the data binding configuration portion of the external service wizard. The adapter
does not automatically associate a data binding mime type and data handler type
with your business object because it has no way of knowing what type of
conversion is necessary for the import objects.

The following illustration shows a mail attachment business object with a customer
child object.

& MailAttachment = [Z] Customer
[ L |
attachmentiame string Mame  string
appBOData Customer Address string
Phone string

Figure 82. Mail attachment business object with structured content child object

Unstructured content business objects are used to store unstructured data, such as
rich text, PDF, or images (as binary content). They are not decomposed by the data
binding because their content is not placed into specific fields in the business
object. Instead, unstructured content is supplied as a single string or binary field in
the business object structure. The following illustration shows a mail attachment
business object with an unstructured content child object.

[C] MailAttachment = [£] UnstructuredContent
[ [ ]
attachmentiame string ContentType siring
appBOData UnstructuredContent: ChjectMame  string
% AsText string

AsBinary hexBinary

Figure 83. Mail attachment business object with unstructured content

Unstructured business objects have the following attributes:

Table 8. Unstructured business object attributes

Attribute name Value

Content type Type of content sent. For example, text/xml,
application/binary, or image/jpeg.

AsText Value to be sent as email text

AsBinary Value to be sent as binary data
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User-defined business object structure

Like the email business object structure, the user-defined business object structure
consists of attributes that directly relate to the fields in an email message and child
business objects for email attachments and headers. While the email business object
structure can contain child objects of any type, the user-defined business object
structure requires that you know the structure of all emails being sent or received
by the adapter in advance. For example, if all incoming and outgoing emails
contain mail content of customer type, attachmentl of account type, and
attachment2 of account type, as shown in [User-defined business object structure|
fwith child objects]

By selecting the user-defined data type in the external service wizard, you can
define your own fixed structure wrapper business object. This configuration
enables you to use ordinary mapping tools to consume and work with your
business objects without having to determine the business object type at run time.

The following illustration shows an example of a user-defined business object with
Order, Customer, and Account child business objects.

[C] FixedStructureEmail = [C] Header
[ ] [ ] = [C] Customer
From string headerMame string I i
To string headerValue string MName  string
cCc string Address string
BCC string Phone  string
Subject string
Reply-To string I
Date string I
headerlist  Header [] = () Order
Encoding  string l id pre | | = [5] Account |
maillContent Customer ;
type string

attachmentl Order

address string
Attachment2 Account

Figure 84. User-defined business object structure with child objects

If you select user-defined email business object in the external service wizard when
creating your inbound module, the adapter only processes events symmetric to the
user-defined email business object you define in the
EmailFixedStructureDataBinding data binding. If the adapter receives an event that
is not symmetric to the specified custom data type, it does not process the event.
Instead, the adapter throws an exception with the appropriate error message.

The adapter logs an error if an event:

* Contains a different type of mail or attachment content than the type defined in
the EmailFixedStructureDataBinding.

¢ Contains a different number of attachments than defined in the
EmailFixedStructureDataBinding.

¢ Is missing mail content or attachments.
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Supported operations

Each business object is associated with an operation, such as create. Operations
might be stored in a business graph, which is like an enhanced business object, if
you choose to use business graphs. Each operation tells the adapter what to do
with the business object. For outbound communication, there are three different
create operations used to create an email from the contents of a business object. For
inbound communication, only the emit email operation is supported.

Create email

In the external service wizard, you specify a name for the operation. This name
can be anything meaningful to you, such as SendEmail or SendEmailwithBO. The
operations listed here represent the three examples of types of outbound create
options that the adapter can start. The emit operation is always used for inbound
communication, as it is the only supported inbound operation.

The create email operation is used with the email business object. When started,
the create email operation creates an email message from the attributes in the email
business object.

Create address

The create address operation is used when the adapter creates an email from a
fixed structure business object that includes an address business object.

Create customer

The create customer operation is used when the adapter creates an email from a
fixed structure business object that includes a customer business object.

Emit email

For inbound communication, emit email is the only supported operation. When
started, this operation instructs the adapter to take information from an email and
convert it to representative business objects.

Naming conventions

When the external service wizard generates a business object, it provides a name
for the business object based on the business object schema file (XSD file) name.

When the external service wizard provides the business object name, it converts
the name of the object to mixed case, which means that it removes any separators,
such as spaces or underscores, and then capitalizes the first letter of each word.
For example, if the external service wizard uses a mail server object called
CUSTOMER_ADDRESS to generate a business object, it generates a business object
called CustomerAddress.

The generated business object name can indicate the structure of the business
object. Names are derived during the metadata import process and are the same as
the name given by the user to the pre-generated XSD files. Business objects names
have no semantic value to the adapter. It means that if you change the business
object name, the behavior of the business object remains the same.

Important: If you choose to rename a business object, use the refactoring
functionality in IBM Integration Designer to ensure that you update all the
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business object dependencies. For instructions on using refactoring to rename
business objects, refer to the following link: |http:/ /publib.boulder.ibm.com /|

infocenter /dmndhelp /v7r5m1/topic/com.ibm.wbpm.wid.bpel.doc/selector /|

topics/ trefacts.html]

Business graphs take the name of the business object followed by "BG". For
example, a business graph for a customer business object would be called
CustomerBG.

Note: Business graph generation is optional.

Email business object properties

During external service discovery, the adapter generates the email business object.
This parent business object includes all the header, encoding, and mail content
details that the adapter needs to process both inbound and outbound requests.

The following table lists the attributes of the email business object. For the simple
alert email business object structure, a number of header fields (such as To and
From) are part of the email wrapper business object. These header fields are not
part of the email wrapper business object with other business object structures
(such as the generic email data type). For this reason, all the header values
available in the simple alert email wrapper business object are not listed in this
topic. For a list and description for each of the properties available in the simple
alert email version of the wrapper business object, see [“Header business object]
foroperties” on page 164

Each property available with all versions of the email business object is described
completely in the sections that follow the table.

Note: In business object attributes, the use of the [] symbol denotes an array of
values.

Table 9. Email business object attributes

Business object attribute name Description
Contains outbound data encoding information when you

do not use data transformation.

File references

Contains the list of files that must be attached to an
outbound email.

Contains header details for all the headers listed in an
inbound email request.

[Mail attachments|

Stores the content for the attachments of an email.

Stores the content for the body of an email. This attribute
does not include email attachments.

Encoding

This attribute is set during outbound communications to indicate the type of
character encoding the adapter will use.

Table 10. Encoding details

Required

No

Default

No default value
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Table 10. Encoding details (continued)

Attribute type String
Usage Encoding is used for headers, mail content, and attachment business objects.
Example The following are the examples of the encoding attribute:

* ASCII for character encoding based on the English alphabet
* Bigb for character encoding based on traditional Chinese characters

» GB18030 for globalized characters in a business graph

Globalized No

Bidi supported No

File references

This attribute contains a list of files that must be attached to an outbound email.
This attribute is not used during inbound processing.

Table 11. File references details

Required No

Default No default value

Attribute type String []

Usage During outbound communication, the run time specifies absolute paths for the referenced files

listed in this field. The adapter reads these files, which are on the local system with the
adapter, and includes them as attachments to the outbound email.

Globalized Yes

Bidi supported No

Header List

This attribute is populated with the header details for all the headers listed in a
polled email request.

Table 12. Header list details

Required No

Default No default value

Attribute type Header[]

Usage Headers are the fields in an email, such as To, From, Cc, Bec, and Subject.
Globalized Yes

Bidi supported Yes

Mail attachments

This attribute stores the content details for an attachment in an inbound email
request.

Table 13. Mail attachments details

Required No

Default | No default value

Attribute type MailAttachment]]
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Table 13. Mail attachments details (continued)

Usage Stores the content details for an attachment in an inbound email request.
Globalized Yes
Bidi supported No

Mail content

During inbound communication, this attribute stores any content found in the
body of the email request. During outbound communication, this attribute contains
the data that becomes the body of the email being sent to the mail server. This
attribute does not include email attachments.

Table 14. Mail content details

Required Yes

Default No default value

Attribute type anyType

Usage Contains body content of an email.
Globalized Yes

Bidi supported No

Header business object properties

Header business object properties are used to store standard (RFC822) email
headers and headers customized by you. They are populated dynamically by the
adapter and comprise a name and value pair. Customized headers and their
related information are tracked by the adapter with the help of the headerList
entries in the email business object.

The adapter picks up the header name from the HeaderList property in the email
business object. Each header can have multiple values, but Bcc and Resent-bce
headers cannot be retrieved from an email. However, they can be sent on an email.

All headers are encoded by the adapter in the specified character set. Because To
and From header values are required, the adapter ends the outbound Create

operation, if the encoding of either of those header values fails. The JavaMail API
does not provide enough information to decipher the character set and encoding
information for the header content; hence header content might not be globalized

The following table provides example header business object name and value
pairs.

Table 15. Examples of header business object name and value pairs

Name

Value

HeaderName = to

HeaderValue = abc@xyz.com

HeaderName = cc

HeaderValue = def@xyz.com

HeaderName = HeaderValue = text/plain
mimetype
The following table lists the Standard email Headers supported by the adapter. A
more detailed description of each property is provided in the sections that follow
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the table. For more information about how to read the property detail tables in the
sections that follow, see [Guide to information about propertied

Table 16. Standard email Headers supported by the adapter

Property name

Description

Bce

The blind carbon copy addresses for the email

The email addresses for secondary recipients of the email

|
|C0mments|

Specifies whether text comments can be added to the message body

[Date| The date the email was created

[Encrypted| Specifies whether the body of a message was encrypted by the sender

[From]| The address that the email was sent from

[In_reply to| Subject line of previous correspondence that the email message is responding to
|Kevw0rds| Keywords or phrases contained in the email separated by commas

[Message identifier

The unique identifier (local-part address unit) referring to the particular version of a particular
message

[References| Other pieces of email correspondence referenced by this email

[Reply to] Addresses to which the responses to the email is sent

[Resent - bed] Blind carbon copy addresses for the email

[Resent - cd Email addresses for secondary or informational recipients of the email

[Resent - date]

The date the email was forwarded

[Resent - from|

The address that the email was resent from

Resent - messagd
identifier]

The unique identifier (local-part address unit) that refers explicitly to a particular version of a
particular message

[Resent - reply to|

Addresses to which the responses to the email is sent

[Resent - sender|

Authenticated identity of the agent (person, system, or process) sending the email message

[Resent - to| Addresses of the primary recipients of the email
[Sender| Authenticated identity of the agent (person, system, or process) sending the email message
[Subject| Summary of what the email is about

Addresses of the primary recipients of the email

Blind carbon copy (Bcc)

This property specifies blind carbon copy addresses for the email. The addresses
listed in this field are not included in copies of the message sent to the primary
and secondary recipients.

Table 17. Blind carbon copy details

Required No

Default No default value

Property type String

Usage This header is only supported for outbound communication.
Some systems choose to include the text of the Bcc field only in the copy of the author,
while some systems include these addresses to all those recipients listed in the Bcc field.

Globalized Yes

Bidi supported Yes
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Carbon copy (Cc)

This property specifies the email addresses of secondary recipients of the email.

Table 18. Carbon copy details

Required

No

Default

No default value

Property type

String

Usage Specifies email addresses of secondary recipients of the email. All recipients listed in this field
are visible to anyone receiving the email.
Globalized Yes
Bidi supported Yes
Comments

This property allows the addition of text comments to the message body without
disturbing the message body content.

Table 19. Comments details

Required

No

Default

No default value

Property type

String

Usage Allows the addition of text comments to the message body without disturbing the message
body content.
Bidi supported No
Date

The date set by the mail server of the sender during inbound processing. The date
the email is created during outbound processing.

Table 20. Date details

Required No
Default No default value
Property type String
Usage The date set by the mail server of the sender during inbound processing. The date the email is
created during outbound processing.
Globalized Yes
Bidi supported Yes
Encrypted

This property indicates whether the body of a message was encrypted by the
sender. If set to True, the message was encrypted.

Table 21. Encrypted details

Required

No

Default

No default value
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Table 21. Encrypted details (continued)

Property type

String

Usage

Setting the encrypted header value to True does not enable encryption. This property only
notes whether the message has been encrypted for informational purposes.

Bidi supported

No

From

This property specifies the address that the email was sent from.

Table 22. From details

Required

Yes

Default

No default value

Property type

String

Usage Specifies the address that the email was sent from.
Globalized Yes
Bidi supported Yes

In reply to

The contents of this field identify which piece of previous correspondence is being
answered with a new email message.

Table 23. In reply to details

Required

No

Default

No default value

Property type

String

Usage Identifies which piece of previous correspondence is being answered with a new email
message.
Bidi supported No
Keywords

This property specifies keywords or phrases contained in the email, which are
separated by commas.

Table 24. Keywords details

Required No

Default No default value

Property type String

Usage Keywords specified using this field are used during selective polling.

Bidi supported

No

Message ldentifier (Message ID)

This property specifies the unique identifier (local-part address unit) that refers
explicitly to a particular version of a particular message.
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Table 25. Message ID details

Required No

Default No default value

Property type String

Usage Each revision of an email message is assigned a new message ID. The uniqueness of the

message ID is guaranteed by the host system that generates it. It is machine readable and does
not include any meaningful syntax for users.

Bidi supported

No

References

The contents of this field identify other pieces of email correspondence referenced
by the email.

Table 26. References details

Required No
Default No default value
Property type String
Usage Identifies other pieces of email correspondence referenced by the email.
Bidi supported No
Reply to

This property specifies the addresses where responses to the email are to be sent.

Table 27. Reply to details

Required No

Default No default value

Property type String

Usage Specifies the addresses to which the response emails are to be sent.

Bidi supported

No

Resent - blind carbon copy (Resent-bcc)

This property specifies the blind carbon copy addresses for the email.

Table 28. Resent-blind carbon copy details

Required

No

Default

No default value

Property type

String

Usage

This value is only supported during outbound communication. The addresses listed in this
field are not included in copies of the message sent to the primary and secondary recipients.
Some systems choose to include the text of the Bec field only in the copy of the author, while
some systems include these addresses to all those recipients listed in the Bec field.

Bidi supported

No
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Resent - carbon copy (Resent-cc)

This property specifies the email addresses for secondary recipients of the email.

Table 29. Resent-carbon copy details

Required

No

Default

No default value

Property type

String

Usage

Specifies the email addresses for secondary recipients of the email.

Bidi supported

No

Resent - date

This property specifies the date that the email was forwarded.

Table 30. Resent - date details

Required

No

Default

No default value

Property type

String

Usage

Specifies the date that the email was forwarded.

Bidi supported

No

Resent - from

This property specifies the address that the email was resent from.

Table 31. Resent - from details

Required No

Default No default value

Property type String

Usage Specifies the address that the email was resent from.

Bidi supported

No

Resent message identifier (Resent-message-ID)

This property specifies the unique identifier (local-part address unit) that refers
explicitly to a particular version of a particular message.

Table 32. Resent-message-ID details

Required No

Default No default value

Property type String

Usage Each revised email message is assigned a new message ID. The uniqueness of the message 1D

is guaranteed by the host system that generates it. It is machine readable and does not include
any meaningful syntax for users.

Bidi supported

No
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Resent - reply to

This property specifies the addresses where responses to the email are to be sent.

Table 33. Resent reply to details

Required

No

Default

No default value

Property type

String

Usage

Specifies the addresses where responses to the email are to be sent.

Bidi supported

No

Resent - sender

This property specifies the authenticated identity of the agent (person, system, or
process) that is sending the email message.

Table 34. Resent sender details

Required No
Default No default value
Property type String
Usage Specifies the authenticated identity of the agent (person, system, or process) that is sending the
email message.
Bidi supported No
Resent - to

This field contains the addresses for the primary recipients of the email.

Table 35. Resent - to details

Required No
Default No default value
Property type String
Usage Contains the addresses for the primary recipients of the email.
Bidi supported No
Sender

This property specifies the authenticated identity of the agent the (person, system,
or process) that is sending the email message.

Table 36. Sender details

Required

No

Default

No default value

Property type

String

Usage

Specifies the authenticated identity of the agent the (person, system, or process) that is sending
the email message.

Bidi supported

No
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Subject

This property contains a summary of what the email is about.

Table 37. Subject details

Required

No

Default

No default value

Property type

String

Usage Contains a summary of what the email is about.
Globalized Yes
Bidi supported Yes

To

Table 38. To details

This field contains the addresses for the primary recipients of the email.

Required No

Default No default value

Property type String

Usage Contains the addresses for the primary recipients of the email.
Globalized Yes

Bidi supported Yes

Mail attachment business object properties

Each email attachment is stored in its own Mail Attachment object. Mail
Attachment business objects consist of an attachment name and data worth of one
email attachment.

During inbound processing, the attachments are parsed and the contents sent out
as business objects. By default, each attachment is parsed into one MailAttachment
business object. However, you can select to emit the entire email as a single email
business object by setting the activation specification property Emit individual
business objects from a multipart email to false in the external service wizard.

During outbound processing, IBM Business Process Manager or WebSphere
Enterprise Service Bus sets the data within the MailAttachment business object.
The data in this business object then becomes an email attachment when the email
message is created by the adapter.

Note: MailAttachment objects can store email attachments of any user-defined type
(such as Customer or PurchaseOrder).

The following table describes the attribute values for the mail attachment business
object. A more detailed description of each property is provided in the sections that
follow the table. For more information about how to read the property detail tables
in the sections that follow, see |Guide to information about propertied
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Table 39. MailAattachment business object attribute values

Attribute name

Purpose

“ Attachment]

name”

The name of the email attachment

(AppBOData)”

Data contained in the email attachment.

Attachment name

This attribute value specifies the name of the file attached to the email.

Table 40. Attachment name attribute characteristics

Required

Yes

Default

No default value

Attribute type

String

Usage The fully qualified path of the email attachment
Globalized Yes
Bidi supported No

Application business object data (AppBOData)

This attribute comprises the data in the file attached to the email.

Table 41. Application business object data attribute characteristics

Required

Yes

Default

No default value

Attribute type

anyType

Usage The anyType attribute type can hold hexBinary content or a child business-object.
For hexBinary type, the data binding deciphers the data and converts it to an unstructured
content business object.

Globalized Yes

Bidi supported No

Email outbound response business object properties

To support business faults, the WebSphere Adapter for Email must be configured
to receive the outbound responses from the mail server. The response from the
mail server contains recipient IDs to which the email is successfully delivered, the
recipient IDs to which the email is not delivered, the delivery status, and the
message ID of the email. The adapter then builds a response business object from
the response received from the mail server.

Note: You can configure the time period for which the adapter waits to receive a
response from the mail server by setting the ["Response set timeout]
[(ResponseSetTimeout)” on page 185| property.
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The following table describes the attribute values for the email outbound response

business object. A more detailed description of each property is provided in the
sections that follow the table. For more information about how to read the

property detail tables in the sections that follow, see|Guide to information about|

Note: In the business object attributes description, the use of the [] symbol denotes

an array of values.

Table 42. Email outbound response business object attributes

Business object attribute name Description

[DeliveredTo| Contains the recipient addresses to which the email is
delivered

[UndeliveredTo| Contains the recipient addresses to which the email is
not delivered

[“Status” on page 174 Contains information about the delivery status of the
email

|“MessageID” on page 174| Contains the message ID of the email

DeliveredTo

This attribute contains information about delivered recipient addresses.

Table 43. Delivered email attribute details

Required

No

Default

No default value

Attribute type

String []

Usage This attribute contains the list of all the email addresses to which the email is successfully
delivered.
Globalized Yes
Bidi supported Yes
UndeliveredTo

This attribute contains information about undelivered recipient addresses.

Table 44. Undelivered email attribute details

Required No
Default Null
Attribute type String []

Usage This attribute contains list of all the email addresses to which the email is not delivered and
displays null if the email is delivered to all addresses.

Globalized Yes

Bidi supported Yes
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Status

This attribute stores the delivery status of the email.

Table 45. Status attribute details

Required

No

Default

No default value

Possible Values

MESSAGE DELIVERED SUCCESSFULLY
MESSAGE NOT DELIVERED

Attribute type

String

Usage This attribute shows the delivery status of the email. The adapter shows the status as either
message delivered successfully or message not delivered.
Globalized Yes
Bidi supported No
MessagelD

This attribute stores the message ID of the email.

Table 46. MessagelD attribute details

Required

No

Default

No default value

Attribute type

String

Usage During outbound operation, this attribute stores the message ID of email. The adapter then
returns the message ID in the response business object.

Globalized Yes

Bidi supported No

Business faults

174

The adapter supports business faults, which are exceptions that are anticipated and
declared in the outbound service description, or import. Business faults occur at
predictable points in a business process, and are caused by a business rule
violation or a constraint violation.

Although IBM Business Process Manager and WebSphere Enterprise Service Bus
support other types of faults, the adapter generates only business faults, which are
called faults in this documentation. Not all exceptions become faults. Faults are
generated for errors that are actionable, that is, errors that can have a recovery
action the ones that does not require the termination of the application. For
example, the adapter generates a fault when it receives a business object for
outbound processing that does not contain the required data or when the adapter
encounters certain errors during outbound processing.

Fault business objects

The external service wizard creates a business object for each fault that the adapter
can generate. In addition, the wizard creates a WBIFault superset business object,
which has information common to all faults, such as the message, errorCode, and
primaryKeySet attributes as shown in [Figure 85 on page 175
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= [Z] WBIFault
[ |
[e] message string

[e] errarCode string
[€] primaryKeySet PrimaryKeyPairType []

Figure 85. The structure of the WBIFault business object

WebSphere Adapter for Email enables faults for you. Manual configuration of
faults is not required. The adapter provides the following fault business objects
that the wizard creates:
* EmailSendFault
When processing any create operation, the adapter generates this fault when
sending an email if an exception occurs that is not related to connection to the
mail server.
¢ MissingDataFault
If the business object that is passed to the outbound operation does not have all

the required attributes, the adapter returns this fault. This fault can occur for the
Create, Delete, Update, Retrieve, ApplyChanges and Exists operations.

Event store structure

Each time an email is read by the adapter during inbound communication, the
adapter updates the status of the event in an event store. The status of each event
is continually updated by the adapter for recovery purposes until the events are
delivered to a configured export on the run time.

When event persistence is optionally configured, the adapter implements the event
store in an Email-specific relational table called EmailEventTable. This table is tied
to event recovery operations. When event persistence is not configured, the adapter
determines which events need to be recovered based on the emails present in the
staging directory. The event recovery feature is activated when the adapter
terminates abruptly. Upon termination, events that are still being processed, or
processed but not completely posted to the service, still require completion. The
adapter reads the event store to determine which events still need to be processed
and then facilitates their completion. The event persistence framework takes care of
delivering the event only once to the target service.

Each inbound module has a unique connection and is associated with one event
store. Multiple modules pointing to the same event store is not supported

The following table illustrates the structure of the WebSphere Adapter for Email
event store.

Table 47. Event table structure

Column name Property type Description

EVNTID Varchar (255) The event ID associated with the polled
inbound event. The ID is taken from the
message ID of the polled email.
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Table 47. Event table structure (continued)

Column name Property type

Description

EVNTSTAT Integer

The status of the event as it moves
through the system. Valid values are
NEW(0), FETCHED(3), PROCESSED(1) and
FAILED(-1).

An event is logged in the event store as
NEW(0), when the adapter discovers a new
email on the mail server that meets the
specified search criteria noted in the
activation specification properties.

When the adapter starts fetching an event
from the mail server to the local system in
RFC822 format, it is logged in the event
table as FETCHED(3) with the value Null
XID. For an event, FETCHED(3) with some
XID value (not NULL), the XID is created
with transaction in progress and ready to
be delivered (in this situation, event can be
recovered).

Event status values:

* NEW(0): The event is ready to be
processed.

* FETCHED(3): The event is picked up for
processing.

* PROCESSED(1): The event is processed
and delivered successfully.

* FAILED(-1): The event is not processed
due to one or more problems.

XID Varchar (255)

It is used by the adapter for assured event
delivery and recovery.

BQTOTAL Integer

Not used by the adapter.

BQPROC Integer

Not used by the adapter.

EVNTDATA Varchar (255)

Stores the name of the folder on the mail
server where the email event was polled.

Outbound configuration properties

176

IBM WebSphere Adapter for Email has several categories of outbound connection
configuration properties, which you set with the external service wizard while
generating or creating objects and services. You can change the resource adapter
and managed connection factory properties after you deploy the module to IBM
Business Process Manager or WebSphere Enterprise Service Bus using IBM
Integration Designer or the Process Administrative Console, but connection
properties for the external service wizard cannot be changed after deployment.

Guide to information about properties

The properties used to configure WebSphere Adapter for Email are described in
detail in tables included in each of the configuration properties topics, such as
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Resource adapter properties, Managed connection factory properties, and so on. To
help you use these tables, information about each row you might see is explained
here.

The following table explains the meaning of each row that might be displayed in
the table for a configuration property.

Row

Explanation

Required

A required field (property) must have a value in order for the adapter to work.
Sometimes the external service wizard provides a default value for required
properties.

Removing a default value from a required field on the external service wizard
will not change that default value. When a required field contains no value at all,
the external service wizard processes the field using its assigned default value,
and that default value is displayed on the Process Administrative Console.

Possible values are Yes and No.

Sometimes a property is required only when another property has a specific
value. When this is the case, the table notes this dependency. For example,

* Yes, when the EventQueryType property is set to Dynamic
* Yes, for Oracle databases

Possible values

Lists and describes the possible values that you can select for the property.

Default

The predefined value that is set by the external service wizard. When the
property is required, you must either accept the default value or specify one
yourself. If a property has no default value, the table states No default value.

The word None is an acceptable default value, and does not mean that there is
no default value.

Unit of measure

Specifies how the property is measured, for example in kilobytes or seconds.

Property type Describes the property type. Valid property types include:
e Boolean
e String
* Integer

Usage Describes usage conditions or restrictions that might apply to the property. For
instance, here is how a restriction would be documented:
For Rational® Application Developer for WebSphere Software version 6.40 or
earlier, the password:
* Must be uppercase
* Must be 8 characters in length
For versions of Rational Application Developer for WebSphere Software later
than 6.40, the password:
* Is not case-sensitive
* Can be up to 40 characters in length.
This section lists other properties that affect this property or the properties that
are affected by this property and describes the nature of the conditional
relationship.

Example Provides sample property values, for example:

"If Language is set to JA (Japanese), code page number is set to 8000".
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Row

Explanation

Globalized

If a property is globalized, it has national language support, meaning that you
can set the value in your national language.

Valid values are Yes and No.

Bidi supported

Indicates whether the property is supported in bidirectional (bidi) processing.
Bidirectional processing refers to the task of processing data that contains both
right-to-left (Hebrew or Arabic, for example) and left-to-right (a URL or file
path, for example) semantic content within the same file.

Valid values are Yes and No.

Connection properties for the external service wizard

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

The following table lists the connection properties for the external service wizard.
These properties can only be configured using the external service wizard and
cannot be changed after deployment. A more detailed description of each property
is provided in the sections that follow the table. For information about how to read
the property details tables in the following sections, see|Guide to information|
labout properties|

Table 48. Connection properties for the external service wizard

In the wizard

Description

Adapter style

Service type associated with the module.

[Business object type location| Absolute path for the folder on the local drive where business objects

generated by the external service wizard are stored.

[Function selector]

The name of the function selector configuration during inbound
communication.

Operation name
L

Operation defined in the external service wizard.

Adapter style

This property specifies the service type associated with the module.

Table 49. Service type details

Required Yes
Default Outbound
Property type List of values
Possible values Outbound
Inbound
Usage Specifies the service type associated with the adapter module
Globalized No
Bidi supported No
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Business object type location

This property specifies the absolute path of the folder on the local drive where
business objects generated by the external service wizard are stored.

Table 50. Business object type location details

Required

No

Default

No default value

Property type

String

Usage Specifies the absolute path of the folder on the local drive where business objects generated by
the external service wizard are stored

Globalized No

Bidi supported No

Function selector

This property specifies the name of the function selector implementation when the
service type is inbound.

Table 51. Function selector details

Required When the service type is set to inbound, this property is required.

When the service type is set to outbound, this property is not valid.
Default For inbound processing, the default is EmailFunctionSelector.

For outbound processing, this field is not editable and there is no default.
Property type String
Usage There is no equivalent property for outbound communication.
Globalized No
Bidi supported (Not available)

Operation name

This property specifies the name you give to the operation used with this module.

Table 52. Operation name property details

Required Yes
Default No default value
Property type String
Usage This value is user-defined and something that is meaningful to you.
Example SendEmail
SendCustomerBO
Globalized No
Bidi supported (Not available)

Managed connection factory properties

Managed connection factory properties are used by the adapter at run time to
create an outbound connection instance with the mail server.
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The following table lists and describes the managed connection factory properties
for outbound communication. You set managed connection factory properties using
the external service wizard and can change them using the IBM Integration
Designer Assembly Editor before deployment. After deployment, you can change
these values using the IBM Business Process Manager or WebSphere Enterprise
Service Bus Process Administrative Console.

A more detailed description of each property is provided in the sections that
follow the table. For information about how to read the property details tables in
the sections that follow, see [Guide to information about properties,

Note: The external service wizard refers to these properties as managed connection
factory properties, and the IBM Business Process Manager or WebSphere Enterprise
Service Bus Process Administrative Console refers to them as (J2C) connection
factory properties.

Table 53. Managed connection factory properties

In the Process Administrative

In the wizard Console Description

[Adapter ID AdapterID Identifies the adapter instance for PMI events and for logging
and tracing.

“Alternate email ID in case of alternateEmailldInCaseOf Specifies the alternate email address for receiving bounced

delivery failure” on page 183 DeliveryFailures mails.

Bidi format string] BIDIContextEIS The bidi format for string type business data exchanged
between the mail server and the adapter.

|“Retry interval if connection fails|| connectionRetryInterval Specifies the time interval between the attempts to reconnect

|(in milliseconds) entities” or| to the mail server if the connection fails.

||Eage 182'

[IDisguise user data as "XXX" in| | HideConfidentialTrace Specifies whether to disguise potentially sensitive information

|10g and trace files| by writing X strings instead of user data in the log and trace
files.

HostName The IP address of the host where the mail server is running.

|”Maximum retries on cormection| ConnectionRetryLimit Specifies the maximum number of times the adapter tries to

[failure (connectionRetryLimit)”]| reestablish an outbound connection to the EIS.

lon page 183]

Password| Password The password for the user name associated with the mail
server.

Im Port The SMTP port where the mail server is listening.

Protocol The protocol used for outbound communication with the
mail server.

[Response set timeout| Responsetimeout Specifies the time period for which the adapter waits to
receive a response from the mail server.

Secure connection enableSSL Specifies whether secure socket layers are enabled for
outbound communication.

[Select when antivirus or firewall] | closeConnection Specifies whether the adapter closes the managed connection

|software is running with the mail server after each request.

UserName The user name for the mail server used to send outbound
emails.

Adapter ID (AdapteriD)

This property identifies a specific deployment or instance of the adapter.

Table 54. Adapter ID details

Required

Yes
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Table 54. Adapter ID details (continued)

Default

001

Property type

String

Usage

This property identifies the adapter instance in the log and trace files, and also helps
identify the adapter instance while monitoring adapters. The adapter ID is used with an
adapter-specific identifier, EMARA, to form the component name used by the Log and Trace
Analyzer tool. For example, if the adapter ID property is set to 001, the component ID is
EMARAOO1.

If you run multiple instances of the same adapter, ensure that the first eight characters of
the adapter ID property are unique for each instance so that you can correlate the log and
trace information to a particular adapter instance. By making the first seven characters of
an adapter ID property unique, the component ID for multiple instances of that adapter is
also unique, allowing you to correlate the log and trace information to a particular instance
of an adapter.

For example, when you set the adapter ID property of two instances of WebSphere Adapter
for Email to 001 and 002. The component IDs for those instances, EMARAGO1 and EMARAGOZ,
are short enough to remain unique, enabling you to distinguish them as separate adapter
instances. However, instances with longer adapter ID properties cannot be distinguished
from each other. If you set the adapter ID properties of two instances to Instance0l and
Instance02, you will not be able to examine the log and trace information for each adapter
instance because the component ID for both instances is truncated to EMARAInstanc.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized

Yes

Bidi supported

No

Bidi format string (BIDIContextEIS)

This property indicates the bidi format for string type business data exchanged
between the mail server and the adapter.

Table 55. Bidi format string details

Required

No

Possible values

IBM Business Process Manager and WebSphere Enterprise Service Bus use ILYNN (implicit,
left-to-right, on, off, nominal). These five attributes comprise the format used by Windows.

Default

No default value

Property type

String

Usage A five-character string that identifies the bidirectional format used by the mail server.
If the mail server that sends or receives data from the server uses a different format than
ILYNN, the adapter converts the format before introducing the data to the server. For the
conversion to occur, you use the external service wizard to set attribute values that represent
the bidirectional format used by the mail server. This is done when you configure the module
for the first time.

Example ILYNN
VRYNN
VLYNN
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Table 55. Bidi format string details (continued)

Globalized No

Bidi supported No

Retry interval if connection fails (in milliseconds) entities

This property specifies the time interval between attempts to reconnect to the mail
server if the connection fails.

Table 56. Retry interval if connection fails (milliseconds) property characteristics

Required No

Possible values Integers equal to and greater than 0

Default 60000

Unit of measure Milliseconds

Property type Integer

Usage This property is applicable only if the value of the property “Maximum retries on connection

failure” is set to greater than 0.

When the adapter encounters an error while establishing a connection to the mail server, this
property specifies the time interval the adapter waits between attempts to reestablish a

connection.
Globalized No
Bidi supported No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 57. Disguise user data as "XXX" in log and trace files details

Required No
Possible values True
False
Default False
Property type Boolean
Usage If you set this property to True, the adapter replaces user data with a string of X's when

writing to log and trace files.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized No

Bidi supported No
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Alternate email ID in case of delivery failure

This property is used to specify an alternate email address to send a bounced
email notification, in case of delivery failure due to an incorrect To address in an
email message.

Table 58. Alternate email ID property details

Required

No

Default

No default value

Property type

String

Usage

When an incorrect To address is specified in the email, a bounced email notification is sent to the alternate
email address specified in the managed factory connection properties. This configuration ensures a backup
address to receive notifications for mail delivery failures.

Note: The alternate email address can be different from the From address.

Globalized

No

Bidi supported

No

Host name (HostName)

This property specifies the IP address of the host where the mail server is running.

Table 59. Host name details

Required No

Default Tocalhost

Property type String

Usage Specifies the IP address of the host where the mail server is running
Globalized No

Bidi supported No

Maximum retries on connection failure (connectionRetryLimit)

This property specifies the number of times the adapter attempts to reestablish a
connection to the EIS, when the adapter encounters an error related to the
outbound connection.

Table 60. Maximum retries in case of system connection failure details

Required No

Possible values Integer equal to and greater than zero
Default 0

Property type Integer
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Table 60. Maximum retries in case of system connection failure details (continued)

Usage When the adapter encounters an error related to the outbound
connection, it attempts to reestablish a physical connection (when
physical connection is not established) for the number of times
specified for this property with a time delay specified in the property
“Retry interval if connection fails (in milliseconds) entities” on pagel
182,

If the value is set to 0, the adapter does not validate the connection to
the EIS and it executes the outbound operation. If the EIS connection
is invalid, the outbound operation fails. The adapter does not attempt
to reconnect to the EIS.

If the value is set to greater than 0, then during each request the
adapter validates if the connection to the EIS is active.

* If the connection is valid, the operation is completed.

* If connection is invalid, the adapter terminates the current managed
connection and a new managed connection is created (new physical
connection). If the adapter is successful in reestablishing the
connection to the EIS, the outbound operation is completed
otherwise the adapter generates the ResourceException after trying
to reconnect for the specified number of times.

Globalized No

Bidi supported No

Password (Password)

This property specifies the password for the user name associated with the mail
server.

Table 61. Password details

Required

No

Default

No default value

Property type

String

Usage

Authenticates the outbound SMTP session with the mail server. IBM Business Process Manager or
WebSphere Enterprise Service Bus Process Administrative Console does not encrypt the Password property
the first time.

Globalized

No

Bidi supported

Yes

Port (Port)

This property specifies the SMTP port where the mail server is listening.

Table 62. Port details

Required No
Default 25
Property type Integer

Usage

If the Secure connection (SSL) property is set to True, this property must be updated.

Globalized

No

Bidi supported

No
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Protocol (Protocol)

This property specifies the protocol to be used for outbound communication with
the mail server.

Table 63. Protocol details

Required No
Default SMTP
Property type String

Usage SMTP is the only supported value for this property.
Globalized Yes
Bidi supported No

Table 64. Response

Response set timeout (ResponseSetTimeout)

This property specifies the length of time the adapter waits for receiving a
response from the mail server.

set timeout details

Required No

Possible values Any positive integer
Default 0

Unit of measure Milliseconds
Property type Integer

Usage You can configure the outbound response time for number of specified milliseconds that the adapter waits
for a response from the mail server. After the specified time period, the adapter stops waiting for a
response from the mail server.

Note: If the value is 0, the adapter continues to wait until it gets a response from the mail server.

Example A value of 5 specifies that the adapter waits for 5 milliseconds to get a response from the mail server.

Globalized No

Bidi supported

No

Secure connection (SSL) (enableSSL)

This property specifies whether secure socket layers are enabled for outbound
communication.

Table 65. Enable secure socket layers details

Required No

Default False

Property type Boolean

Usage If set to True, the port property must be set to 465.
Globalized No

Bidi supported No
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Select when antivirus or firewall software is running
(SecureConnection)

Selecting this option closes the managed connection with the mail server after each
outbound request. It is used when antivirus or firewall security software is running
on the system where the adapter is deployed or the system that hosts the mail
server.

Table 66. Select when antivirus or firewall software is running details

Required No

Default True

Property type Boolean

Possible values True
False

Usage This property is provided because some antivirus programs consider the managed connection between the
adapter and the mail server malicious. This results in the mail sent by the adapter to the mail server being
blocked by an antivirus program or firewall.
If set to True, the adapter closes the managed connection after each outbound request, ensuring that
antivirus and firewall software do not block emails from the adapter.
If set to False, the adapter does not close the managed connection after each outbound request. This setting
might cause antivirus and firewall software to block emails from the adapter.

Globalized No

Bidi supported No

User name (UserName)

This property specifies the user name for the mail server to be used with the
outbound SMTP session.

Table 67. User name details

Required No

Default No default value

Property type String

Usage The mail server must be running on the host noted in this property.
Globalized Yes

Bidi supported Yes

Resource adapter properties

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the Process Administrative Console.

The following table lists and describes the resource adapter properties. A more
detailed description of each property is provided in property details tables that
follow the table. For information about how to read the property details tables in
the sections that follow, see |Guide to information about properties.
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Table 68. Resource adapter properties

In the Process

In the wizard Administrative Console Description

[Adapter 1D AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.

Disguise user data as "XXX'| | HideConfidentialTrace Specifies whether to disguise potentially sensitive

in log and trace fileg

information by writing X strings instead of user data in
the log and trace files.

(Not available)

[Enable HA support| Do not change this property.

Adapter ID (AdapteriD)

This property identifies a specific deployment or instance of the adapter.

Table 69. Adapter ID details

Required

Yes

Default

001

Property type

String

Usage

This property identifies the adapter instance in the log and trace files, and also helps
identify the adapter instance while monitoring adapters. The adapter ID is used with an
adapter-specific identifier, EMARA, to form the component name used by the Log and Trace
Analyzer tool. For example, if the adapter ID property is set to 001, the component ID is
EMARAOO1.

If you run multiple instances of the same adapter, ensure that the first eight characters of
the adapter ID property are unique for each instance so that you can correlate the log and
trace information to a particular adapter instance. By making the first seven characters of
an adapter ID property unique, the component ID for multiple instances of that adapter is
also unique, allowing you to correlate the log and trace information to a particular instance
of an adapter.

For example, when you set the adapter ID property of two instances of WebSphere Adapter
for Email to 001 and 002. The component IDs for those instances, EMARAOO1 and EMARAGOZ,
are short enough to remain unique, enabling you to distinguish them as separate adapter
instances. However, instances with longer adapter ID properties cannot be distinguished
from each other. If you set the adapter ID properties of two instances to Instance0l and
Instance02, you will not be able to examine the log and trace information for each adapter
instance because the component ID for both instances is truncated to EMARAInstanc.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized

Yes

Bidi supported

No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.
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Table 70. Disguise user data as "XXX" in log and trace files details

Required

No

Possible values

True
False

Default

False

Property type

Boolean

Usage

If you set this property to True, the adapter replaces user data with a string of X's when
writing to log and trace files.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized

No

Bidi supported

No

Enable high availability support (enableHASupport)

Do not change this property. It must be set to true.

Interaction specification properties

Interaction specification properties specify business object details for a given data
type selected in the external service wizard. When interaction specification values
such as To or From addresses are set in the wizard, these values are automatically
populated in the business objects created in association with the module.

The following table lists the Interaction specification properties. A complete
description of each property is provided in the sections that follow the table.

Table 71. Interaction specification properties

In the wizard

Description

Specifies blind carbon copy addresses for the email.

arbon copy

Specifies email addresses of secondary recipients of the email.

The date set by the mail server of the sender during inbound processing.
The date the email is created during outbound processing.

ncoding]

The type of character encoding to use

Specifies the address that the email was sent from.

assword

Specifies the password for the user name associated with the mail server.

eply to

Specifies the addresses to which the response emails are to be sent.

ubjec

Contains a summary of what the email is about.

Contains the addresses for the primary recipients of the email.
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Specifies the user name for the mail server to be used for the outbound
SMTP session.
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Blind carbon copy (Bcc)

This property specifies blind carbon copy addresses for the email. The addresses
listed in this field are not included in copies of the message sent to the primary
and secondary recipients.

Table 72. Blind carbon copy details

Required

No

Default

No default value

Property type String
Usage This header is only supported for outbound communication.
Some systems choose to include the text of the Bcc field only in the copy of the author,
while some systems include these addresses to all those recipients listed in the Bec field.
Globalized Yes

Bidi supported

Yes

Carbon copy (Cc)

This property specifies the email addresses of secondary recipients of the email.

Table 73. Carbon copy details

Required No
Default No default value
Property type String
Usage Specifies email addresses of secondary recipients of the email. All recipients listed in this field
are visible to anyone receiving the email.
Globalized Yes
Bidi supported Yes
Date

The date set by the mail server of the sender during inbound processing. The date
the email is created during outbound processing.

Table 74. Date details

Required No
Default No default value
Property type String
Usage The date set by the mail server of the sender during inbound processing. The date the email is
created during outbound processing.
Globalized Yes
Bidi supported Yes
Encoding

This attribute is set during outbound communications to indicate the type of
character encoding the adapter will use.
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Table 75. Encoding details

Required

No

Default

No default value

Attribute type String
Usage Encoding is used for headers, mail content, and attachment business objects.
Example The following are the examples of the encoding attribute:

* ASCII for character encoding based on the English alphabet

* Bigb for character encoding based on traditional Chinese characters

» GB18030 for globalized characters in a business graph
Globalized No
Bidi supported No

From

This property specifies the address that the email was sent from.

Table 76. From details

Required

Yes

Default

No default value

Property type

String

Usage Specifies the address that the email was sent from.
Globalized Yes
Bidi supported Yes

Password (Password)

This property specifies the password for the user name associated with the mail
server.

Table 77. Password details

Required

Yes

Default

No default value

Property type

String

Usage Authenticates the inbound POP3 or IMAP session with the mail server.
Globalized Yes
Bidi supported Yes

Reply to

This property specifies the addresses where responses to the email are to be sent.

Table 78. Reply to details

Required No

Default No default value

Property type String

Usage Specifies the addresses to which the response emails are to be sent.
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Table 78. Reply to details (continued)

Bidi supported

|N0

Subject

This property contains a summary of what the email is about.

Table 79. Subject details

Required No
Default No default value
Property type String
Usage Contains a summary of what the email is about.
Globalized Yes
Bidi supported Yes
To

Table 80. To details

This field contains the addresses for the primary recipients of the email.

Required No

Default No default value

Property type String

Usage Contains the addresses for the primary recipients of the email.
Globalized Yes

Bidi supported Yes

User name (UserName)

This property specifies the user name for the mail server to be used for the
outbound SMTP session.

Table 81. User name details

Required Yes

Default No default value

Property type String

Usage This property specifies the user name for the mail server to be used for the outbound SMTP
session.

Globalized Yes

Bidi supported Yes

Inbound configuration properties

WebSphere Adapter for Email has several categories of inbound connection
configuration properties, which you set with the external service wizard while
generating or creating objects and services. You can change the resource adapter
and activation specification properties after you deploy the module using IBM
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Integration Designer or the Process Administrative Console, but connection
properties for the external service wizard cannot be changed after deployment.

Guide to information about properties

The properties used to configure WebSphere Adapter for Email are described in
detail in tables included in each of the configuration properties topics, such as
Resource adapter properties, Managed connection factory properties, and so on. To
help you use these tables, information about each row you might see is explained
here.

The following table explains the meaning of each row that might be displayed in
the table for a configuration property.

Row

Explanation

Required

A required field (property) must have a value in order for the adapter to work.
Sometimes the external service wizard provides a default value for required
properties.

Removing a default value from a required field on the external service wizard
will not change that default value. When a required field contains no value at all,
the external service wizard processes the field using its assigned default value,
and that default value is displayed on the Process Administrative Console.

Possible values are Yes and No.

Sometimes a property is required only when another property has a specific
value. When this is the case, the table notes this dependency. For example,

* Yes, when the EventQueryType property is set to Dynamic
* Yes, for Oracle databases

Possible values

Lists and describes the possible values that you can select for the property.

Default

The predefined value that is set by the external service wizard. When the
property is required, you must either accept the default value or specify one
yourself. If a property has no default value, the table states No default value.

The word None is an acceptable default value, and does not mean that there is
no default value.

Unit of measure

Specifies how the property is measured, for example in kilobytes or seconds.

Property type

Describes the property type. Valid property types include:
* Boolean
* String

* Integer
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Row

Explanation

Usage

Describes usage conditions or restrictions that might apply to the property. For
instance, here is how a restriction would be documented:

For Rational Application Developer for WebSphere Software version 6.40 or
earlier, the password:

* Must be uppercase

* Must be 8 characters in length

For versions of Rational Application Developer for WebSphere Software later
than 6.40, the password:

* Is not case-sensitive

* Can be up to 40 characters in length.

This section lists other properties that affect this property or the properties that
are affected by this property and describes the nature of the conditional
relationship.

Example

Provides sample property values, for example:

"If Language is set to JA (Japanese), code page number is set to 8000".

Globalized

If a property is globalized, it has national language support, meaning that you
can set the value in your national language.

Valid values are Yes and No.

Bidi supported

Indicates whether the property is supported in bidirectional (bidi) processing.
Bidirectional processing refers to the task of processing data that contains both
right-to-left (Hebrew or Arabic, for example) and left-to-right (a URL or file
path, for example) semantic content within the same file.

Valid values are Yes and No.

Connection properties for the external service wizard

Enterprise service discovery selection properties are used to build a service
description and to save the built-in artifacts. These properties are configured in the
external service wizard.

The following table lists the connection properties for the external service wizard.
These properties can only be configured using the external service wizard and
cannot be changed after deployment. A more detailed description of each property
is provided in the sections that follow the table. For information about how to read
the property details tables in the following sections, see |Guide to information|

bout propertie
prop

Table 82. Connection properties for the external service wizard

In the wizard

Description

|Adapter style|

Service type associated with the module.

[Business object type location|

Absolute path for the folder on the local drive where business objects
generated by the external service wizard are stored.

|[Function selector]

The name of the function selector configuration during inbound
communication.

|OEerati0n name|
L

Operation defined in the external service wizard.
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Adapter style

This property specifies the service type associated with the module.

Table 83. Service type details

Required Yes
Default Outbound
Property type List of values
Possible values Outbound
Inbound
Usage Specifies the service type associated with the adapter module
Globalized No
Bidi supported No

Business object type location

This property specifies the absolute path of the folder on the local drive where
business objects generated by the external service wizard are stored.

Table 84. Business object type location details

Required No

Default No default value

Property type String

Usage Specifies the absolute path of the folder on the local drive where business objects generated by
the external service wizard are stored

Globalized No

Bidi supported No

Function selector

This property specifies the name of the function selector implementation when the
service type is inbound.

Table 85. Function selector details

Required When the service type is set to inbound, this property is required.

When the service type is set to outbound, this property is not valid.

Default For inbound processing, the default is EmailFunctionSelector.

For outbound processing, this field is not editable and there is no default.

Property type String
Usage There is no equivalent property for outbound communication.
Globalized No

Bidi supported (Not available)
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Operation name

This property specifies the name you give to the operation used with this module.

Table 86. Operation name property details

Required

Yes

Default

No default value

Property type

String

Usage This value is user-defined and something that is meaningful to you.
Example SendEmail

SendCustomerBO
Globalized No

Bidi supported

(Not available)

Activation specification properties

Activation specification properties are properties that hold the inbound event
processing configuration information for an export.

The following table lists the activation specification properties for inbound
communication. You set the activation specification properties using the external
service wizard and can change them before deployment using the IBM Integration
Designer Assembly Editor. After deployment, you can change these values using
the IBM Business Process Manager or WebSphere Enterprise Service Bus Process

Administrative Console.

A more detailed description of each property is provided in the sections that
follow the table. For information about how to read the property detail tables in
the sections that follow, see [Guide to information about properties.

Table 87. Activation specification properties

In the wizard

In the Process

Administrative Console

Description

|Archive file naming pattern|

ArchiveFileNamingPattern

A comma delimited pattern of header names used to
name archived files being stored in the archive folder.

[Archive folder|

ArchiveFolder

The file folder on the local system where successfully
processed emails are archived as files.

|Auto create event table]

EP_CreateTable

Specifies whether the adapter should create a database
table for the event store if one does not exist

[Bidi format string|

BIDIContextEIS

Indicates the bidi format for string type business data
exchanged between the mail server and the adapter

[Database schema namé|

EP_SchemaName

The schema name for the database used by the
adapter's event persistence feature

SSL

[Delivery typel DeliveryType Determines the order in which events are delivered by
the adapter to the export.

Emit individual business| EmitIndividualBOs Specifies whether the adapter creates individual

objects from a multipart| business objects for each part of a multipart email.

emaill

[Enable transport security] enableSSL Specifies whether a Secure Sockets Layer (SSL)

connection is enabled.
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Table 87. Activation specification properties (continued)

In the wizard

In the Process
Administrative Console

Description

Ensure once-only event|

deliverxl

AssuredOnceDelivery

Specifies whether the adapter provides assured once
delivery of events.

[Event recovery data source]
(JNDI) name

EP_DataSource_]NDIName

The JNDI name of the data source used by the event
persistence class to acquire the JDBC database
connection

[Event recovery table name]

EP_TableName

The name of the event store used by the adapter

[Retry limit for failed events|

FailedEventRetryLimit

The number of times the adapter attempts to redeliver
an event before marking the event as failed.

|Eeriod§|

|Failed events folder FailedEventsFolder The absolute path to the file folder on the local system
where unsuccessfully processed email events are
archived in file format.

HostName The IP address of the host where the mail server is
running.

[Interval between polling PollPeriod The length of time that the adapter waits between

polling periods.

[Match all search criteria

MatchAllSearchCriteria

The search criteria to filter which events are polled
from the mail server.

[Match some search criterial

MatchSomeSearchCriteria

The search criteria to filter which events are polled
from the mail server.

[Maximum events in polling| PollQuantity The number of events the adapter delivers to the

[period] export during each poll period.

[Maximum connections| MaximumConnections The maximum number of connections that the adapter
can use for inbound event delivery.

[IMinimum connections| MinimumConnections The minimum number of connections that the adapter
can use for inbound event delivery.

Maximum number of retries| |RetryLimit The number of times the adapter tries to reestablish an

in case of system connection| inbound connection after an error.

failur

Password The password associated with the mail server user

name.

Password used to connect to|
event data source]

EP_Password

The password used by the adapter's event persistence
feature. It is used to acquire the JDBC database
connection from the data source configured in the
server.

Poll folder

Poll folder

The name of the mail folder or mail folders the
adapter polls for inbound requests (emails).

Port The POP3 or IMAP port where the mail server is
listening.
Protocol The protocol adapter uses for inbound communication

with the mail server.

Retry EIS connection on|
startu

]

RetryConnectionOnStartup

Controls whether the adapter retries the connection to
the mail server if it cannot connect at startup.

Time between retries in case| |RetrylInterval The length of time that the adapter waits between

of system connection failure] attempts to reestablish connection after an error during
(milliseconds)| inbound operations.

IStaging directory| InProgressFolder The folder on the file system where the emails polled

from the mail server are first written in file format.

196 1BM WebSphere Adapters:

IBM WebSphere Adapter for Email User Guide



Table 87. Activation specification properties (continued)

In the wizard

In the Process

Administrative Console Description

Stop polling on erro
p polling

StopPollingOnError Specifies whether the adapter stops polling for events

when it encounters an error during polling.

(Not available)

“UseFiveLevelBO” on page| |Specifies whether business graphs and wrappers are

209 generated for child business objects of the email parent
business object.
|User name| UserName The user name for the mail server.

[User name used to connect

EP_UserName The user name used by the adapter's assured-once

[to event data source]

delivery feature.

Archive file naming pattern (ArchiveFile)

This property is used to specify a comma delimited pattern of header names used
to name archived files being stored in the archive folder.

Table 88. Archive file naming pattern details

Required No

Default The message-ID of the email event. This information is retrieved from the email header.

Property type String

Usage This property is to be used with the [“Archive folder (ArchiveFolder)”| property.

Example If the header values From, Date are specified, the adapter picks the From address and Date
from the email headers and combines them with the message ID to form the file name (From
name + Date + Message ID).

Globalized Yes

Bidi supported No

Archive folder (ArchiveFolder)

This property specifies the file folder on the local system where successfully
processed emails are archived in RFC822 file format.

Table 89. Archive folder details

Required

No

Default

No default value

Property type

String

Usage This folder must be manually created on the same system as the adapter before the adapter is
run. If no archive folder is specified, the adapter does not successfully archive the emails. They
are deleted from the In progress folder.

You can use a WebSphere Application Server environment variable to represent the archive
folder. Specify the name of the environment variable in braces, preceded by a $ symbol. For
example: ${ARCHIVE_FOLDER}. See the topic on creating an environment variable in this
documentation.

Globalized Yes

Bidi supported Yes
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Auto create event table property (EP_CreateTable)

This property specifies whether the adapter should create an event store if it
detects one does not exist.

Table 90. Automatically create event table details

Required No
Possible values True
False
Default True
Property type Boolean

Usage If set to True, the adapter creates an event store if it detects that one does not exist.
If set to False, the adapter does not create an event store even if one does not exist. Make sure
that an event store exists if you want to ensure the delivery of events.

Globalized No

Bidi supported No

Bidi format string (BIDIContextEIS)

This property indicates the bidi format for string type business data exchanged
between the mail server and the adapter.

Table 91. Bidi format string details

Required

No

Possible values

IBM Business Process Manager and WebSphere Enterprise Service Bus use ILYNN (implicit,
left-to-right, on, off, nominal). These five attributes comprise the format used by Windows.

Default No default value

Property type String

Usage A five-character string that identifies the bidirectional format used by the mail server.
If the mail server that sends or receives data from the server uses a different format than
ILYNN, the adapter converts the format before introducing the data to the server. For the
conversion to occur, you use the external service wizard to set attribute values that represent
the bidirectional format used by the mail server. This is done when you configure the module
for the first time.

Example TILYNN
VRYNN
VLYNN

Globalized No

Bidi supported No

Database schema name (EP_SchemaName)

This property specifies the schema name for the database used by the adapter's
assured-once delivery feature.

Table 92. Database schema name details

Required

No

Default

No default value
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Table 92. Database schema name details (continued)

Property type String

Usage Specifies the schema name for the database used by the adapter's assured-once delivery feature.
This value is not case-sensitive.

Globalized Yes

Bidi supported Yes

Delivery type (DeliveryType)

This property specifies the order in which events are delivered by the adapter to
the export.

Table 93. Delivery type details

Required No
Possible values ORDERED
UNORDERED
Default ORDERED
Property type String
Usage The following values are supported:
* ORDERED: The adapter delivers events to the export one at a time.
* UNORDERED: The adapter delivers all events to the export at once.
Globalized No
Bidi supported No

Emit individual business objects from a multipart email
(EmitindividualBOs)

This property specifies whether the adapter creates individual business objects for
each part of a multipart email.

Table 94. Emit individual business objects from a multipart email details

Required No
Default False
Property type Boolean

Usage The split for individual business object is completed by the adapter and each of the business
objects is emitted as generic email (emitEmail). Each part of a multipart email is considered an
individual business object and emitted using the email wrapper object, where content of each
part is set in the mail content attribute.

Globalized (Not available)

Bidi supported No

Enable transport security (SecureConnectionProperty)

This property specifies if the Secure Sockets Layer (SSL) connection is enabled for
the POP3 or IMAP protocol chosen in the Protocol property.

Table 95. Enable transport security details

Required

No
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Table 95. Enable transport security details (continued)

Default

False

Property type

Boolean

Usage If set to True, the port value needs to be set to one of the following values:
For the POP3 protocol, 995
For the IMAP protocol, 993

Globalized No

Bidi supported No

Ensure once-only event delivery (AssuredOnceDelivery)

This property specifies whether to provide ensure once-only event delivery for
inbound events.

Table 96. Ensure once-only event delivery details

Required Yes
Possible values True
False
Default True
Property type Boolean

Usage

When this property is set to True, the adapter provides assured once event
delivery. This means that each event is delivered once and only once. A value of
False does not provide assured once event delivery, but provides better
performance.

When this property is set to True, the adapter attempts to store transaction
(XID) information in the event store. If it is set to False, the adapter does not
attempt to store the information.

This property is used only if the export component is transactional. If it is not,
no transaction can be used, regardless of the value of this property.

Globalized

No

Bidi supported

No

Event recovery data source (JNDI) name property
(EP_DataSource_JNDIName)

This property specifies the JNDI name of the data source that will be used by the
event persistence class to acquire the JDBC database connection.

Table 97. Event recovery data source (JNDI) name details

Required Yes, if the AssuredOnceDelivery property is set to True

Default No default value

Property type String

Usage This value is case-sensitive.
The external service wizard does not create the data source on IBM Business Process Manager
or WebSphere Enterprise Service Bus. Make sure that the data source is defined on the server
before deploying the adapter.

Globalized Yes

200 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide




Table 97. Event recovery data source (JNDI) name details (continued)

Bidi supported | Yes

Event recovery table name property (EP_TableName)

This property specifies the name of the event store that will be used by the adapter
for event persistence.

Table 98. Event recovery table name details

Required Yes, if the AssuredOnceDelivery property is set to True

Default EmailEventTable

Property type String

Usage The value specified for this property must be unique for each adapter instance and cannot be
used by another instance. This value is not case-sensitive.

Globalized Yes

Bidi supported Yes

Retry limit for failed events (FailedEventRetryLimit)

This property specifies the number of times that the adapter attempts to redeliver
an event before marking the event as failed.

Table 99. Retry limit for failed events details

Required No
Possible values Integers
Default 5
Property type Integer
Usage Use this property to control how many times the adapter tries to send an event
before marking it as failed. It accepts the following values:
Default
If this property is not set, the adapter tries five additional times before
marking the event as failed.
0 The adapter tries to deliver the event an infinite number of times.
When the property is set to 0, the event remains in the event store and
the event is never marked as failed.
>0 For integers greater than zero, the adapter retries the specified number
of times before marking the event as failed.
<0 For negative integers, the adapter does not retry failed events.
Globalized No
Bidi supported No

Failed events folder (FailedEventsFolder)

This property specifies the file folder on the local system where unsuccessfully
processed email events are archived in file format.

Table 100. Failed events folder details

Required No
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Table 100. Failed events folder details (continued)

Default

No default value

Property type

String

Usage This folder must be manually created on the same system as the adapter before the adapter is
run. If you do not specify a failed events folder, the adapter does not archive any unsuccessful
email event.

You can use a WebSphere Application Server environment variable to represent the failed
events folder. Specify the name of the environment variable in braces, preceded by a $ symbol.
For example: ${FAILEDEVENTS_FOLDER}. See the topic on creating an environment variable in this
documentation.

Globalized Yes

Bidi supported No

Host name (HostName)

This property specifies the IP address of the host where the mail server is running.

Table 101. Host name details

Required No
Default Tocalhost
Property type String

Usage Specifies the IP address of the host where the mail server is running
Globalized No
Bidi supported Yes

Interval between polling periods (PollPeriod)

This property specifies the length of time that the adapter waits between polling
periods.

Table 102. Interval between polling periods details

Required Yes

Possible values Integers greater than or equal to 0.

Default 2000

Unit of measure Milliseconds

Property type Integer

Usage The poll period is established at a fixed rate, which means that if running the
poll cycle is delayed for any reason (for example, if a prior poll cycle takes
longer than expected to complete) the next poll cycle occurs immediately to
make up for the lost time caused by the delay.

Globalized No

Bidi supported No
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Match all search criteria (MatchAlICriteria)

This property specifies search criteria that the adapter uses to filter which events
are polled from designated poll folders on the mail server. Events that meet the
ANDed conditions are polled.
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Table 103. Match all search criteria details

Required

No

Possible values

You can use any of the following header values when specifying search criteria:
* content=

* subject=

* to=

* cc=

* from=

* sender=

* date=

Default

No default value. It means that you have not selected any filtering options.

Property type

String

Usage

Specify AND conditions by separating them with a comma (,). This limits the event search to
only mail events in the poll folder that meet the ANDed specific search criteria.

Specify NOT conditions by separating them with an exclamation mark (!). This limits the event
search to only mail events in the poll folder that do not include the search options NOTed.

If both Match all search criteria and Match some criteria properties are set, the adapter uses
the AND operation between the fields. This means that the outputs of the first set of conditions
are subjected to the second set of conditions. For example, if sender=xyz@abc.com,
to=pqr@abc.com is set for Match all search criteria property and subject=test,
from!=Tmn@abc.com is set for Match some search criteria property, the adapter searches for
events with a sender value of xyz@abc.com and a to value of pqr@abc.com that might also
have a subject value of test and which does not have a from value of Imn@abc.com.

Example

sender=xyz@abc.com, to=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and a to value of to=pqr@abc.com.

sender=xyz@abc.com,to!=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and does not have a to value of pqr@abc.com.

Globalized

No

Bidi supported

No

Match some search criteria (MatchSomeCriteria)

This property specifies the search criteria the adapter uses to filter which events
are polled from the designated poll folders on the mail server. Events that meet the
ORed conditions are polled.

Table 104. Match some search criteria details

Required

No

Possible values

You can use any of the following header values when specifying search criteria:
* content=

* subject=

* to=

* cc=

* from=

* sender=

* date=

Default

Default is blank. It means that you have not selected any filtering options.

Property type

String
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Table 104. Match some search criteria details (continued)

Usage Specify OR conditions by separating them with a comma (,). This limits the event search to
mail events in the poll folder that meet the ORed search criteria.

Specify NOT conditions by separating them with an exclamation mark (!). This limits the event
search to only mail events in the poll folder that do not include the search options NOTed.

If both Match all search criteria and Match some criteria properties are set, the adapter uses
the AND operation between the fields. This means that the outputs of the first set of conditions
are subjected to the second set of conditions. For example, if sender=xyz@abc.com,
to=pqr@abc.com is set for Match all search criteria property and subject=test,
from!=Tmn@abc.com is set for Match some search criteria property, the adapter searches for
events with a sender value of xyz@abc.com and a to value of pqr@abc.com that might also
have a subject value of test and which does not have a from value of Imn@abc.com.

Example sender=xyz@abc.com, to=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and a to value of to=pqr@abc.com.

sender=xyz@abc.com, to!=pqr@abc.com picks up any events with a sender value that matches
sender=xyz@abc.com and does not have a to value of pqr@abc.com.

Globalized No

Bidi supported No

Maximum connections (MaximumConnections)

This property specifies the maximum number of connections that the adapter can
use for inbound event delivery.

Table 105. Maximum connections details

Required No

Default 1

Property type Integer

Usage Only positive values are valid. Any value less than 1 is treated as 1 by the
adapter.

Globalized No

Bidi supported No

Minimum connections (MinimumConnections)

This property specifies the minimum number of connections that the adapter can
use for inbound event delivery.

Table 106. Minimum connections details

Required No

Default 1

Property type Integer

Usage Only positive values are valid. Any value less than 1 is treated as 1 by the
adapter.

Globalized No

Bidi supported No
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Maximum events in polling period (PollQuantity)

This property specifies the number of events that the adapter delivers to the export
during each poll period.

Table 107. Maximum events in polling period details

Required Yes
Default 10
Property type Integer

Usage The value must be greater than 0. If this value is increased, more events are
processed per polling period and the adapter may perform less efficiently. If this
value is decreased, fewer events are processed per polling period and the
adapter's performance might improve slightly.

Globalized No

Bidi supported No

Maximum number of retries in case of system connection failure
(RetryLimit)

This property specifies the number of times the adapter tries to reestablish an
inbound connection.

Table 108. Maximum number of retries in case of system connection failure

Required No

Possible values 0 and positive integers

Default 0

Property type Integer

Usage This property controls how many times the adapter retries the connection if the
adapter cannot connect to the mail server to perform inbound processing. A
value of 0 indicates an infinite number of retries.
To control whether the adapter retries if it cannot connect to the mail server
when it is first started, use the RetryConnectionOnStartup property.

Globalized No

Bidi supported

No

Table 109. Password details

Password (Password)

This property specifies the password for the user name associated with the mail

server.

Required Yes

Default No default value

Property type String

Usage Authenticates the inbound POP3 or IMAP session with the mail server. IBM Business Process
Manager or WebSphere Enterprise Service Bus Process Administrative Console does not encrypt
the Password property the first time.

Globalized Yes

Bidi supported Yes
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Password used to connect to event data source property
(EP_Password)

This property specifies the password used by the adapter's assured-once delivery
feature.

Table 110. Password used to connect to event data source details

Required Yes, if the AssuredOnceDelivery property is set to True

Default No default value

Property type String

Usage Specify the password that the adapter uses to connect to the event store. This value is
case-sensitive.

Globalized Yes

Bidi supported Yes

Poll folder (PollFolder)

This property specifies the name of the mail folder or mail folders the adapter
polls for inbound requests (emails).

Table 111. Poll folder details

Required No for POP3 protocol
Yes for IMAP protocol

Default For the POP3 protocol, the default is Inbox
For the IMAP protocol, there is no default value.

Property type String

Usage For the POP3 protocol, the adapter cannot poll multiple mail server folders. It automatically
defaults to Inbox because Inbox is the only supported value with POP3.
If the Protocol property is set to POP3, this property defaults to Inbox. No other value for POP3
is supported.
If the Protocol property is set to IMAP, you can define one or more mail folder names. To poll
multiple mail server folders, folder names are delimited with commas.

Globalized Yes

Bidi supported No

Port (Port)

This property specifies the POP3 or IMAP port where the mail server is listening.

Table 112. Port details

Required

No

Default

110 when the protocol is set to POP3
143 when the protocol is set to IMAP

Property type

Integer

206 1BM WebSphere Adapters: IBM WebSphere Adapter for Email User Guide




Table 112. Port details (continued)

Usage If the Secure connection (SSL) property is set to True, this property must be updated.
For the POP3 protocol, it must be set to 995.
For the IMAP protocol, it must be set to 993.

Globalized No

Bidi supported No

Protocol (Protocol)

The property specifies the protocol used for inbound communication with the mail

server.

Table 113. Protocol details

Required No

Possible values IMAP
POP3

Default POP3

Property type String

Usage If set to IMAP, the adapter uses the IMAP email protocol for inbound communication.
If set to POP3, the adapter uses the POP3 email protocol for inbound communication.

Globalized No

Bidi supported No

Retry EIS connection on startup (RetryConnectionOnStartup)

This property controls whether the adapter attempts to connect again to the mail
server if it cannot connect at startup.

Table 114. Retry EIS connection on startup details

Required No
Possible values True
False
Default False
Property type Boolean
Usage This property indicates whether the adapter should retry the connection to the

mail server if the connection cannot be made when the adapter is started:

Set the property to False when you want immediate feedback about whether
the adapter can establish a connection to the mail server, for example, when
you are building and testing the application that receives events from the
adapter. If the adapter cannot connect, the adapter writes log and trace
information and stops. The administrative console shows the application
status as Stopped. After you resolve the connection problem, start the adapter
manually.

Set the property to True if you do not need immediate feedback about the
connection. If the adapter cannot connect during startup, it writes log and
trace information, and then attempts to reconnect, using the RetryInterval
property to determine how frequently to retry and the value of the
RetryLimit property to retry multiple times until that value is reached. The
administrative console shows the application status as Started.
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Table 114. Retry EIS connection on startup details (continued)

Globalized

No

Bidi supported

No

Time between retries in case of system connection failure
(Retrylinterval)

When the adapter encounters an error related to the inbound connection, this
property specifies the length of time the adapter waits before trying to reestablish a
connection.

Table 115. Retry interval details

Required Yes

Default 2000

Unit of measure Milliseconds
Property type Integer

Usage

Only positive values are valid. When the adapter encounters an error related to
the inbound connection, this property specifies the length of time the adapter
waits before trying to establish a new connection.

Globalized

No

Bidi supported

No

Staging directory (InProgressFolder)

This property specifies the folder on the file system where the emails polled from
the mail server are first written in file format.

Table 116. Staging directory details

Required Yes

Default No default value

Property type String

Usage This folder must be created on the same system where the adapter is running before the
adapter is started. After being written to the file system in file format, each file is named based
on the Message-ID of its corresponding email event. These details are retrieved from the email
header value.
You can use a WebSphere Application Server environment variable to represent the In progress
folder. Specify the name of the environment variable in braces, preceded by a $ symbol. For
example: ${INPROGRESS_FOLDER}. See the topic on creating an environment variable in this
documentation.

Globalized Yes

Bidi supported Yes

Stop the adapter when an error is encountered while polling
(StopPollingOnError)

This property specifies whether the adapter will stop polling for events when it
encounters an error during polling.
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Table 117. Stop the adapter when an error is encountered while polling details

Required No
Possible values True
False
Default False
Property type Boolean
Usage If this property is set to True, the adapter stops polling when it encounters an
error.
If this property is set to False, the adapter logs an exception when it encounters
an error during polling and continues polling.
Globalized No
Bidi supported No
UseFiveLevelBO

This property specifies whether business graphs and wrappers are generated for
child business objects of the email parent business object.

Table 118. Use five level business object details

Required No

Default True

Property type Boolean

Usage This property is for compatibility with earlier versions with version 6.0.2 business objects and
does not appear in the external service wizard. In version 6.0.2, the default for this property
was True.

Globalized (Not available)

Bidi supported

No

User name (UserName)

This property specifies the user name for the mail server to be used for the
inbound POP3 or IMAP session.

Table 119. User name details

Required

Yes

Default

No default value

Property type

String

Usage

The mail server must be running on the host specified in the host property.

Globalized

Yes

Bidi supported

Yes

User name used to connect to event data source property
(EP_UserName)

This property specifies the user name used by the adapter's event assured-once
delivery feature.
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Table 120. User name used to connect to event data source details

Required Yes, if you want assured-once delivery

Default No default value

Property type String

Usage Specify the user name that the adapter uses to connect to the event store.
Globalized Yes

Bidi supported Yes

Resource adapter properties

A resource adapter contains properties such as the adapter ID and logging and
tracing options specific to the adapter. You can set the logging and tracing
properties using the external service wizard during adapter configuration. You can
set or change any of the properties using the Process Administrative Console.

The following table lists and describes the resource adapter properties. A more
detailed description of each property is provided in property details tables that
follow the table. For information about how to read the property details tables in
the sections that follow, see |Guide to information about propertied.

Table 121. Resource adapter properties

In the Process

In the wizard Administrative Console Description

AdapterID Identifies the adapter instance for PMI events and for
logging and tracing.

Disguise user data as "XXX'| | HideConfidentialTrace Specifies whether to disguise potentially sensitive

in log and trace fileg information by writing X strings instead of user data in

the log and trace files.

(Not available) [Enable HA support] Do not change this property.

Adapter ID (AdapteriD)

This property identifies a specific deployment or instance of the adapter.

Table 122. Adapter ID details

Required Yes
Default 001
Property type String
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Table 122. Adapter ID details (continued)

Usage

This property identifies the adapter instance in the log and trace files, and also helps
identify the adapter instance while monitoring adapters. The adapter ID is used with an
adapter-specific identifier, EMARA, to form the component name used by the Log and Trace
Analyzer tool. For example, if the adapter ID property is set to 001, the component ID is
EMARAGO1.

If you run multiple instances of the same adapter, ensure that the first eight characters of
the adapter ID property are unique for each instance so that you can correlate the log and
trace information to a particular adapter instance. By making the first seven characters of
an adapter ID property unique, the component ID for multiple instances of that adapter is
also unique, allowing you to correlate the log and trace information to a particular instance
of an adapter.

For example, when you set the adapter ID property of two instances of WebSphere Adapter
for Email to 001 and 002. The component IDs for those instances, EMARAOO1 and EMARAGOZ,
are short enough to remain unique, enabling you to distinguish them as separate adapter
instances. However, instances with longer adapter ID properties cannot be distinguished
from each other. If you set the adapter ID properties of two instances to Instance0l and
Instance02, you will not be able to examine the log and trace information for each adapter
instance because the component ID for both instances is truncated to EMARAInstanc.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized

Yes

Bidi supported

No

Disguise user data as "XXX" in log and trace files
(HideConfidentialTrace)

This property specifies whether to replace user data in log and trace files with a
string of X's to prevent unauthorized disclosure of potentially sensitive data.

Table 123. Disguise user data as "XXX" in log and trace files details

Required

No

Possible values

True
False

Default

False

Property type

Boolean

Usage

If you set this property to True, the adapter replaces user data with a string of X's when
writing to log and trace files.

For inbound processing, the value of this property is set at the resource adapter level. For
outbound processing, the value can be set both at the resource adapter level and the
managed connection factory level. After you use the external service wizard to configure
the adapter for outbound processing, you can set the resource adapter and managed
connection factory properties independently. If you use the IBM Integration Designer
assembly editor or the administrative console to reset these properties, ensure that you set
them consistently, to prevent inconsistent marking of the log and trace entries.

Globalized

No
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Table 123. Disguise user data as "XXX" in log and trace files details (continued)

Bidi supported | No

Enable high availability support (enableHASupport)

Do not change this property. It must be set to true.

Globalization

WebSphere Adapter for Email is a globalized application that can be used in
multiple linguistic and cultural environments. Based on character set support and
the locale of the host server, the adapter delivers message text in the appropriate
language. The adapter supports bidirectional script data transformation between
integration components.

Globalization and bidirectional data transformation

The adapter is globalized to support single- and multi-byte character sets and
deliver message text in the specified language. The adapter also performs
bidirectional script data transformation, which refers to the task of processing data
that contains both right-to-left (Hebrew or Arabic, for example) and left-to-right (a
URL or file path, for example) semantic content within the same file.

Globalization

Globalized software applications are designed and developed for use within
multiple linguistic and cultural environments rather than a single environment.
WebSphere Adapters, IBM Integration Designer, IBM Business Process Manager or
WebSphere Enterprise Service Bus are written in Java. The Java runtime
environment within the Java virtual machine (JVM) represents data in the Unicode
character code set. Unicode contains encodings for characters in most known
character code sets (both single- and multi-byte). Therefore, when data is
transferred between these integration system components, there is no need for
character conversion.

WebSphere Adapter for Email converts data in mail content and attachments to a
byte stream, which can in turn be converted to a string. During this process, the
encoding is maintained by using Unicode encoding. For example,

e XML documents are used for integration and maintain their encoding within the
document. The XML DataHandler is globalized so the data remains intact.

¢ The adapter converts a stream of data to bytes, which in turn is converted to a
string. During this process, the encoding is maintained by using UTF-8
encoding.

To log error and informational messages in the appropriate language and for the
appropriate country or region, the adapter uses the locale of the system on which
it is running. The adapter supports all the group 1 languages and Thai.

Bidirectional script data transformation

Languages such as Arabic and Hebrew are written from right to left, yet they
contain embedded segments of text that are written left to right, resulting in
bidirectional script. When software applications handle bidirectional script data,
standards are used to display and process it. Bidirectional script data
transformation applies only to string type data. IBM Business Process Manager or
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WebSphere Enterprise Service Bus use the Windows standard format, but
applications or file systems that exchange data with the server might use a
different format. The adapter transforms bidirectional script data passed between
the two systems so that it is accurately processed and displayed on both sides of a
transaction. It transforms the script data by using a set of properties that defines
the format of script data, as well as properties that identify content or metadata to
which transformation applies.

Note: Popular wrapper business object header values such as from, to, Cc, Bcc,
reply-to, subject, and date are bidi-enabled. The name portions of email addresses
are also bidi-enabled.

Bidirectional script data formats

IBM Business Process Manager or WebSphere Enterprise Service Bus use the
bidirectional format of ILYNN (implicit, left-to-right, on, off, nominal). These five
attributes comprise the format used by Windows. If an application or file system
that sends or receives data from the server uses a different format, the adapter
converts the format before introducing the data to the server. For the conversion to
occur, you use the external service wizard to set attribute values that represent the
bidirectional format used by the sending application or file system. This
configuration setting is done when you deploy the module for the first time.

The bidirectional format consists of five attributes. When you set bidirectional
properties, you assign values for each of these attributes. The attributes and
settings are listed in the following table.

Table 124. Bidirectional format attributes

Contextual shaping

Letter position |Purpose Values Description Default setting
1 Order schema I Implicit (Logical) I
\% Visual
2 Direction L Left-to-Right L
R Right-to-Left
C Contextual Left-to-Right
D Contextual Right-to-Left
3 Symmetric Swapping Y Symmetric swapping is on Y
N Symmetric swapping is off
4 Text Shaping S Text is shaped N
N Text is not shaped (Nominal)
I Initial shaping
M Middle shaping
F Final shaping
B Isolated shaping
5 Numeric Shaping H National (Hindi) N
C
N

Numbers are not shaped (Nominal)

Bidirectional properties that identify data for transformation
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To identify business data that is subject to transformation, set the bidi format string
property. Do this configuration by specifying values for each of the five
bidirectional format attributes (listed in the preceding table) for the property.

To identify event persistence data subject to transformation, set the BiDiFormatEP
property. Do this configuration by specifying values for each of the five
bidirectional format attributes (listed in the preceding table) for the property. The
BiDiFormatEP property can be set for the activation specification.

To identify application-specific data for transformation, annotate the BiDiContext
property within a business object. Do this configuration by using the business
object editor within IBM Integration Designer to add the properties as
application-specific elements of the business object.

Bidirectional transformation in business objects

For outbound processing, you can modify the business objects to enable the
bidirectional transformation of the headers in the WebSphere Adapter for Email
business object and the data in content-specific business objects.

You must add an annotation to the complex type of the business object to specify
the bidirectional formatting attributes in the following files:

* For the generic business object, change the email.xsd file.

* For the user-defined business object, change the custom wrapper (for example,
the CustomWrapper.xsd file).

* For the SimpleAlertEmail business object, change the SimpleAlertEmail.xsd file.

* For all the custom data type business objects such as the WbiAddress.xsd file,
use WbiPhone.xsd.

The following sections include annotations that can serve as examples.
Bidirectional formatting attributes of the business object

The following annotation, which contains the bidirectional context information,
applies to all the headers in the email business objects. The
EmailWrapperDataBinding uses the bidirectional information in the element
BiDiContext to transform the header values.

<complexType name="Email">
<annotation>
<appinfo
source="http://www.ibm.com/xmlins/prod/websphere/j2ca/
datatransformation/databindingmapping">
<dtm:DataBindingMapping
xsi:type="dtm:DataBindingMapping"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:dtm="http://www.ibm.com/xmlns/prod/websphere/j2ca/
datatransformation/databindingmapping">
<BiDiContext>
<orientation>rtl</orientation>
<textShape>nominal</textShape>
<orderingScheme>visual</orderingScheme>
<symmetricSwapping>true</symmetricSwapping>
<numeralShapes>nominal</numeralShapes>
</BiDiContext>
</dtm:DataBindingMapping>
</appinfo>
</annotation>
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Bidirectional formatting attributes of the wrapper

You can add an annotation to the wrapper business object that is the user-defined
type. The annotation in the wrapper business objects such as the generic (email)
and the user-defined type (CustomerWrapper) is used to do bidirectional
transformation of wrapper attributes (header values). The content-specific business
objects that are used inside the wrapper business objects are not transformed using
annotation in the wrapper business objects. To transform content-specific business
objects, you must edit the respective business object definition to add the
annotation shown in the previous example for bidirectional formatting attributes of
the business object.

The following annotation is an example for the wrapper:

<complexType name="Customer">
<annotation>
<appinfo
source="http://www.ibm.com/xmins/prod/websphere/j2ca/
datatransformation/databindingmapping">
<dtm:DataBindingMapping
xsi:type="dtm:DataBindingMapping"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmIns:dtm="http://www.ibm.com/xmlIns/prod/websphere/j2ca/
datatransformation/databindingmapping">
<BiDiContext>
<orientation>rti</orientation>
<textShape>nominal</textShape>
<orderingScheme>visual</orderingScheme>
<symmetricSwapping>true</symmetricSwapping>
<numeralShapes>nominal</numeralShapes>
</BiDiContext>
</dtm:DataBindingMapping>
</appinfo>
/annotation>

Properties enabled for bidirectional data transformation

Bidirectional (bidi) data transformation properties control the format of
bidirectional script data exchanged between an application or file system and
integration tools and runtime environments. After these properties are set,
bidirectional script data is correctly processed and displayed in IBM Integration
Designer and IBM Business Process Manager or WebSphere Enterprise Service Bus.

At design time all properties enabled for bidirectional transformation can be
configured using the external service wizard and all business object bidi properties
can be configured using the Business Object Editor tool in the IBM Integration
Designer. At deployment time, all managed connection factory and activation
specification bidi properties can be configured using the IBM Business Process
Manager or WebSphere Enterprise Service Bus Process Administrative Console.

Bidirectional properties are divided into three types:

* EIS bidirectional format - Specifies the bidirectional format for string type
business data exchanged between the mail server and the adapter.

* Metadata bidirectional format - Specifies the bidirectional format for metadata
and configuration data of string type used by the adapter to establish and
maintain communication with the mail server. This format includes both
configuration properties such as User name and application-specific information
stored in business object definitions (XSD files) and business object attributes.

* Event persistence bidirectional format - Specifies the bidirectional format for
event persistence properties.
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The following table shows property types characterized by bidi format.

Table 125. Bidi formats

Level of property

Bidirectional enabled

Property name as it

Property name as it
appears in the Process

definition property name appears in the wizard Administrative Console
Managed connection MCF-related properties BiDi format string BiDiContextEIS

factory (MCF) properties

Activation specification AS-related properties EIS BiDi Format BiDiContextEIS

(AS) properties

Activation specification All event persistence Event Persistence BiDi BiDiFormatEP
properties properties Format

Business object (BO) BO-related properties EIS BiDi Format BiDiContextEIS
Business object BO-related properties Metadata BiDi Format BiDiContextMetadata
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All the bidi supported configuration properties for both inbound and outbound
communication are shown in the following tables.

Note: Only properties of string type are enabled for bidirectional transformation.
Integer properties, such as port and host, the host name property, and Boolean
type properties cannot be enabled for bidirectional transformation.

Managed connection factory properties

The following managed connection properties control the bidirectional
transformation during outbound communications.

¢ User name

e Password

Note: The Protocol managed connection factory property is not enabled for
bidirectional transformation because it maintains a constant value for the SMTP
protocol.

Activation specification properties

The following activation specification properties control the bidirectional
transformation during inbound communications.

* Archive file naming pattern

* Archive folder

* Database

* Database schema name

* User name used to connect to event data source
* Event recovery data source (JNDI) name
* Event recovery table name

» Failed events folder

* Password

* Poll folder

 Staging directory

* User name
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Note: Substring searches for globalized characters are not supported by the Java
Mail API, so MatchAllCriteria and MatchSomeCriteria properties are not enabled
for bidirectional transformation.

Adapter messages

View the messages issued by WebSphere Adapter for Email at the following
location.

Link to messages: |http:/ /publib.boulder.ibm.com /infocenter/ dmndhelp/v7r5m1/ |
topic/com.ibm.wbpm.ref.doc/adapt_messages.html|

The displayed Web page shows a list of message prefixes. Click a message prefix to
see all the messages with that prefix:

* Messages with the prefix CWYEM are issued by WebSphere Adapter for Email

* Messages with the prefix CWYBS are issued by the adapter foundation classes,
which are used by all the adapters

Related information

The following information centers, IBM Redbooks, and web pages contain related
information for WebSphere Adapter for Email.

Information resources

* The WebSphere Business Process Management information resources web page
includes links to articles, Redbooks, documentation, and educational offerings to
help you learn about WebSphere Adapters: jhttp://www-01.ibm.com/software/|
[integration /integration-designer /|

* The WebSphere Adapters library page includes links to all versions of the
documentation: [http: / /www.ibm.com /software /integration /wbiadapters /|
[library /infocenter /

Information about related products

* IBM Business Process Manager, Version 8.0.1, information center, which includes
IBM Business Process Manager, and IBM Integration Designer information:
[http:/ /pic.dhe.ibm.com /infocenter /dmndhelp /v8r0m1/index.jsp}

* IBM Business Process Manager, Version 8.0, information center, which includes
IBM Business Process Manager, and IBM Integration Designer information:
[http:/ /pic.dhe.ibm.com /infocenter /dmndhelp /v8rOmx/index.jsp}

developerWorks® resources
+ |WebSphere Adapter Toolkit|
* |WebSphere business integration zone|

Video samples

To help you use WebSphere Adapters, sample videos are available to detail some
of the scenarios.

You can find several WebSphere Adapters video demonstrations at this FTP

location [ftp:/ /ftp.software.ibm.com /software/websphere/integration/ wsa /|
library /videos /|

To view these video samples:
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Download the zip file of the required sample from the FTP location.
Extract the downloaded zip file to your system.

From the extracted folder, double-click the HTML file.

The video sample opens in your default Web browser.

Note: Some of the video samples has a built-in audio narration. If you do not
want to listen to the audio, you can lower its tab to the minimum, and slide the
tab to an audio level, whenever you want the audio back.

The following sample videos for IBM Integration Designer are currently available
at this location: [ftp: / /ftp.software.ibm.com /software/websphere /integration /wsa /|

library /videos /TID|

Applying Adapter fix for IBM Integration Designer toolkit
Applying Adapter fix for IBM Process Server at embedded level
Applying Adapter fix for IBM Process Server at node level
Checking version in IBM Integration Designer toolkit

Checking version in IBM Process Server after enabling traces

The following sample videos for WebSphere Adapters version 7.5.0 are currently
available at this location: [ftp:/ /ftp.software.ibm.com/software /websphere /|

fintegration/wsa/library /videos /750|

AFC: Scheduling Calendar based polling
AFC: Overcoming an AFC version conflict situation

The sample videos for WebSphere Adapters Version 7.0 are currently available at
this location: [ftp:/ / ftp.software.ibm.com /software /websphere/integration/wsa/|

llibrary /videos/700|
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department 2Z4A/SOM1
294 Route 100

Somers, NY 10589-0100
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: (c) (your company name) (year). Portions of
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this code are derived from IBM Corp. Sample Programs. (c) Copyright IBM Corp.
_enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program's tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning:

Do not use this diagnosis, modification, and tuning information as a programming
interface because it is subject to change.

Trademarks and service marks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corporation in the United States, other countries,
or both. These and other IBM trademarked terms are marked on their first
occurrence in this information with the appropriate symbol (° or ™), indicating US
registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law
trademarks in other countries. A complete and current list of IBM trademarks is
available on the Web at http://www.ibm.com/legal/copytrade.shtml

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Java and all Java based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be trademarks or service marks of
others.

This product includes software developed by the Eclipse Project
(http:/ / www.eclipse.org).
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